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Documentation Legal Notice
This Documentation, including any embedded help systems and electronically distributed 
materials, (hereinafter referred to as the “Documentation”) is for your informational purposes only 
and is subject to change or withdrawal by Bohemia Interactive Simulations (BISim) at any time. 
This Documentation and its contents are proprietary information of BISim, also protected by 
copyright, and may not be copied, transferred, reproduced, disclosed, modified or duplicated, in 
whole or in part, without the prior written consent of BISim.

If you are a licensed user of the software product(s) addressed in the Documentation, you may 
print or otherwise make available a reasonable number of copies of the Documentation for internal 
use by you and your employees in connection with that software, provided that all BISim copyright 
notices and legends are affixed to each reproduced copy.

The right to print or otherwise make available copies of the Documentation is limited to the period 
during which the applicable license for such software remains in full force and effect. Should the 
license terminate for any reason, it is your responsibility to certify in writing to BISim  that all copies 
and partial copies of the Documentation have been returned to BISim or destroyed.

BISim has made every reasonable effort to ensure the accuracy of all the information contained in 
the Documentation. However, product specifications are subject to change without notice, and 
BISim makes no representations or warranties regarding the accuracy, completeness, or suitability 
of information contained in the Documentation. To the maximum extent permitted by law, BISim 
disclaims any and all liability for any loss, damage (direct or indirect) or other consequence which 
may arise from the use of or reliance upon any information contained in the Documentation.

The use of any software product referenced in the Documentation is governed by the applicable 
license agreement and such license agreement is not modified in any way by the terms of this 
notice.

Copyright © 2023 - Bohemia Interactive Simulations. All rights reserved. All trademarks, trade 
names, service marks, and logos referenced herein belong to their respective companies.
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Customer Support
The Bohemia Interactive Simulations Support page can be found at:

 l http://www.bisimulations.com/support

For any type of assistance with Bohemia Interactive Simulations products, use the following 
support email and we will respond to your query with urgency.

 l support@bisimulations.com

Our website contains a range of media and handouts relating to Bohemia Interactive Simulations 
products:

 l http://www.bisimulations.com/

The BISim Wiki is the primary resource on VBS4 scripting:

https://sqf.bisimulations.com/display/SQF/VBS+Scripting+Reference

 

PhysX

VBS4 uses the PhysX physics engine. For more information on PhysX visit the Nvidia site.

https://gameworksdocs.nvidia.com/simulation.html
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1. VBS4 - Whole-Earth Battlespace
VBS4 is an easy-to-use, whole-earth virtual and constructive simulation. In addition to supporting 
all VBS3 training use-cases, VBS4 can support new higher echelon use cases up to battalion level.

Compared to VBS3, VBS4 delivers efficiencies and ease-of-use improvements, reducing the need 
for simulation-specific knowledge in terrain and scenario generation. VBS4 is designed for non-
engineers, with new tools for terrain development and mission planning that are usable by anyone. 
VBS4 also comes pre-loaded with a global database which gives instant access to high detail, 
simulated terrain anywhere on planet Earth.

  WARNING 
VBS4 22.2 included significant backwards incompatible changes to Vegetation and 
Building Texture paths.

If you are upgrading from a version older than 22.2, review Vegetation and Texture 
Repathing in the VBS4 Release Notes, and apply the necessary changes to your Insets and 
Battlespaces before using VBS4.

Image-1: VBS4, showcasing high-fidelity graphics and real-time deformable terrain.
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VBS4 includes a military-specific rendering engine, procedurally enhanced terrain ingestion 
pipeline and an entirely new workflow including two new scenario design modes - VBS Plan and 
VBS Geo. VBS Plan and VBS Geo dramatically increase the speed of scenario creation and terrain 
creation / modification. The powerful and flexible VBS Editor (with Offline Prepare and Real-Time 
Execute modes) continues in VBS4 (for continuity with VBS3 and because it offers deeper scenario 
editing). By using VBS4, your virtual training capability will be enhanced by:

 l Scalability

Unlike VBS3, VBS4 supports up to two thousand high-fidelity constructive (AI) civilian and 
military entities in the same Battlespace (assuming you are using VBS4 Simulation Clients and 
a VBS4 Dedicated Server).

 l Terrain Agility

Execute scenarios anywhere in the world within a high-fidelity, procedurally generated whole-
world database out of the box. Enhance the existing Whole-Earth base terrain with the new and 
intuitive VBS Geo or generate new high-fidelity insets rapidly which, using traditional methods 
(including terrain development in VBS3), would require terrain experts.  VBS3 terrains can be 
imported into VBS4, and are seamlessly meshed into VBS4’s procedurally enhanced global 
dataset.

Image-2: VBS4 offers an unprecedented level of realism and detail in a procedural Whole-
Earth dataset
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 l Improved Classroom Efficiency

The revolutionary VBS Plan mode in VBS4 enables non-engineers to rapidly generate complex 
scenarios (and engineers / experts to do so much faster). VBS4 starts up in under 15 seconds 
(3x times faster than VBS3) and, with VBS World Server, data is managed and stored centrally, 
massively reducing the administrative burden of large classroom set-ups. VBS Plan, VBS Geo, 
and the overall improved design of user interfaces in VBS4 offer users easy access to the vast 
capability of VBS4. VBS4 frees up instructor time by greatly increasing the speed that training 
content can be generated.

 l Greater Immersion

Industry-leading graphical fidelity with a new environmental lighting model, dense global 
vegetation with multiple canopies, infinite draw distances, advanced atmospherics, and 
physically based shaders, produce a truly realistic, cluttered and immersive training experience 
for increased trainee buy-in.

 l Superior Extended Reality (XR) Support

Pre-built connections to XR industry standard APIs and pre-tested for use with almost all VR 
and MR devices available, VBS4 and VBS Blue IG enable numerous XR use cases to quickly 
and cost efficiently realize next generation training systems and concepts. VBS Blue IG is a 
companion product to VBS4 and is described in the  VBS Blue IG Manual.

VBS4 is also a highly capable simulation host that can integrate with VBS Blue IG or any other 
compliant image generator. VBS4 can drive multiple IG channels as a high-fidelity simulation host 
to tap into the comprehensive capabilities for simulator use.

Connecting VBS4 to VBS Blue IG is straightforward and a range of display types are supported, 
from multi-channel domes to VR head-mounted displays. VBS4 can be run as a headless host not 
only with VBS Blue IG but with any compliant image generator. See VBS Host Overview (on 
page 140) for more information.

For further information on the full capabilities of VBS4 as a simulation host and how it may be 
applied to a specific integrator use case, please contact sales@bisimulations.com.

1.1 Train Anywhere on the Earth
A significant new feature in VBS4 is the introduction of the VBS World Server  hosting the Whole-
Earth Terrain. The Whole-Earth Terrain uses a Global Dataset to create an accurate virtual Earth to 
support training at any location on the globe.

VBS World Server  is included with VBS4, and provides Whole-Earth building and road data from 
OpenStreetMap (OSM), accurate heights and forest coverage, and correct biomes for every region 
on Earth used to procedurally enhance the base data.

The Whole-Earth capability dramatically reduces terrain development time and the terrain server 
capability  saves administration overhead by centralizing terrain data.

© 2023 - Bohemia Interactive Simulations - All Rights Reserved - 11 -
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VBS World Server hosts the Whole-Earth Terrain and serves it to all connected Clients during a 
Scenario Execution (on page 89). VBS World Server is optional, and both VBS4 and VBS Blue IG 
support local terrain data storage in addition to VBS World Server.

1.2 Next Generation VBS Control AI
Bohemia Interactive Simulations aims to reduce human intervention in simulation exercises 
through the use of a deterministic and doctrinal VBS Control AI that is fully integrated with VBS4 
and the new mission planning component, VBS Plan.

In VBS4 both Game AI and Control AI are available by default, while Control AI is the AI type used 
by VBS Plan.

Control AI uses Control AI Waypoints (see  the VBS4 Editor Manual), and has advantages over 
Game AI in the following capabilities:

Capabilities AI Sub-Type Additional Aspects

Convoy Training, Driver Training, 
Enemy Ambush, OPFOR Tactics, or 
any vehicle focused capabilities.
For more information on convoy 
capabilities, see Convoys (on 
page 161).

Convoy AI (see  the 
VBS4 Editor 
Manual)

The Control AI convoy has the following 
additional aspects:

 l The convoy has behavior that can be 
paused / continued.

 l The convoy has a leader, which is 
dynamically selectable and can be 
replaced.

 l The convoy dynamically determines the 
order of convoy succession, based on the 
convoy vehicle placement.

 l The convoy can drive both on and off the 
road.

 l The convoy reactions to enemy contact 
or fire can be set.

Enemy Ambush, OPFOR Tactics.
For more information on these 
capabilities, see Enemy Ambush 
(on page 173).

AI on Rails (see the 
VBS4 Editor 
Manual)

 l Fine-tune enemy placement to prepare an 
ambush.

 l Use Triggers to create dynamic 
situations.

 l Branch Control AI Waypoints to achieve 
different outcomes on each Scenario run.

Dry Support Bridge (DSB) Training.
For more information about 
DSB laying capabilities, see HX45M 
Bridge Laying (Land 155) (on 
page 257).

Bridge Laying 
Convoy AI (see the 
VBS4 Editor 
Manual)

 l Place DSBs of varying lengths at the 
required places on the terrain.
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Capabilities AI Sub-Type Additional Aspects

Large-scale battles with a primary 
focus on fighting and maneuvers.

VBS Plan (see VBS 
Plan Overview in 
the VBS Plan 
Manual) 

 l Place large amounts of military entities 
easily, using VBS Plan.

 l Have the entities maneuver and attack 
the enemy on their way.

 l Place tanks or mechanized platoons.

Military infantry and vehicle fighting 
and maneuvers.

Military AI (see the 
VBS4 Editor 
Manual)

 l Have infantry and vehicle AI perform 
general-purpose military orders.

Civilian pattern of life. Civilian AI(see the 
VBS4 Editor 
Manual)

 l Create a civilian pattern of life that 
consists of pedestrians and vehicles.

 l Create various activities for pedestrians.

Animal-herd behaviors. Animal AI(see the 
VBS4 Editor 
Manual)

 l Add animal-herd movement.

For more information about VBS Control AI, see VBS Control AI Overview (on page 135).

1.3 Everything from VBS3 and More!
VBS4 includes all VBS3 capabilities and supports all VBS3 use cases.*

 l VBS3 OME and RTE are included with VBS4 - renamed simply to VBS Editor.

 l Industry standard format static and moving 3D models can be imported into VBS4 using 
Model Exchanger.

For more information, see Model Exchanger in the VBS Developer Reference.

 l VBS3 terrains and missions can be imported into VBS4.

 l VBS Simulation SDK plug-ins from VBS3 work in VBS4.

 l The VBS scripting language SQF is available in VBS4.

  FEATURE NOTICE 
* The vast majority of VBS3 capabilities are included in VBS4 and the remaining 
capabilities are intended to be included in future releases or replaced by alternate new 
functionality.

For more information, see Differences from VBS3 (on page 22).
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1.4 Powerful Tools to Customize VBS4
The VBS Simulation SDK includes a library of APIs and source code allowing developers to 
customize virtually every aspect of VBS4 and produce custom applications. The APIs form a 
modular, C plug-in architecture that enable developers to integrate third-party technologies 
effectively and efficiently.

For more information, see VBS Simulation SDK (on page 155) and the VBS Simulation SDK 
Manuals.
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2. The VBS4 Workflow
VBS4 introduces a fresh, new main-menu user interface and user experience by presenting users 
immediately with a view of the globe, offering the list of available Battlespaces and the ability to 
create new ones anywhere on the planet.

For more information, see VBS4 UI Overview (on page 33).

Image-3: The VBS4 User Interface

A Battlespace consists of terrain edits and a scenario (which can incorporate one or more plans). 
With VBS World Server, Battlespaces can be stored centrally and made accessible to all connected 
VBS4 Clients. The comprehensive VBS4 After Action Review (AAR) provides recording and 
playback capability of networking (multiplayer) missions. In VBS4, the AAR user interface has been 
updated to be easier to use, and AARs are also stored with their respective Battlespaces.

For more information, see Battlespace Management (on page 57).

A toolbar along the top of the screen provides ready access to points of interest, options, 
documentation,  and a notification system.

For more information, see VBS4 Toolbar (on page 35).

A new and optimized workflow has been implemented to enable easy and efficient creation and 
execution of virtual training content.  The initial (optional) Plan phase is typically conducted in real-
world systems, such as the Mission Command Information System (MCIS) meaning planners train 
as they fight.
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Users conduct the Prepare - Execute - Assess phases within VBS4 (optionally importing the plan 
from MCIS into VBS Plan as a starting point).

  FEATURE NOTICE 
The MCIS Import feature is not available by default in VBS Plan in the VBS4 baseline 
releases. For more information, contact sales@bisimulations.com.

The Prepare phase of the VBS4 workflow allows the user to quick-switch between VBS Geo, VBS 
Plan, and VBS Editor modes.  This means scenarios are rapidly created by building and editing the 
terrain and the scenario, iterating between the three modes as needed. Terrain and scenario 
editing can be conducted in either 2D or 3D.

Image-4: The VBS4 workflow
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2.1 VBS Geo – WYSIWYG Terrain Editing
VBS Geo is an easy-to-use What You See Is What You Get (WYSIWYG) terrain editor fully integrated 
within VBS4. VBS Geo allows users to intuitively and rapidly modify, extend, and replace 
environmental features of the whole-Earth database without leaving the VBS4 application.

This empowers users with the ability to enhance the out-of-the-box terrain using VBS Geo to meet 
the specific requirements of the intended scenario and training delivery without the need for 
additional specialist Geographic Information Systems (GIS) applications or knowledge. For 
example, the user can quickly move a road, or add a building or a fence, and VBS4 does the rest.

VBS4 AI entities follow the new road, stop at pedestrian crossings, and avoid any new buildings or 
fences, and so on. The tool enables both small-scale edits (for example, creating a trench-line for a 
defensive position) to large-scale city-building (for example, importing vector data describing 
roads and buildings for an entire city). By comparison, the VBS3 terrain editing tool (Visitor 4) and 
most other terrain building tools are complex to use and require extensive training to use 
effectively.

Terrain editing in VBS Geo is at least 10x faster than Visitor 4 (The VBS3 terrain editing tool), and 
VBS Geo can be used by a technically-minded soldier, sailor, or airman - no need for training 
courses and a specialist engineer.

Image-5: Road editing in VBS Geo

VBS Geo allows training instructors who are non-terrain experts to iteratively and rapidly:
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 l Add / remove roads and choose road width and surface type (for example, asphalt or dirt, and 
so on).

 l Place, rotate, and scale any of the tens of thousands of environmental 3D models in the VBS4 
database in addition to any third-party models.

 l Add geographically appropriate vegetation from hundreds of species of plants, bushes, and 
trees with automatic, realistic, and natural distributions.

 l Manually adjust elevation data, either flattening areas, raising the terrain, lowering the terrain, 
adding berms or trenches with centimeter-level control.

 l Import common geo-referenced data types such as GeoTiff or DEM.

 l Alter the procedurally defined (generated in real-time), out-of-the-box surfaces with an array of 
brushes or polygon fill tools.

For more information, see VBS Geo Overview in the VBS Geo Manual.

2.2 VBS Plan – Rapid Mission Planning and Execution
VBS Plan is a new mission planning tool that allows any user to quickly sketch out and execute a 
tactical plan without prior simulation or scenario generation knowledge. Like VBS Geo, VBS Plan is 
built directly into VBS4 and is immediately accessible from the Prepare user interface.

VBS Plan provides a revolutionary scenario generation approach whereby the user places military 
tactical markings (for example; phase lines, advance, defend, attack, and so on) and unit symbols 
(for example, MIL-2525C) at a constructive level, and then VBS4 automatically creates the 
individual virtual entities and assigns behaviors.

VBS Plan is a very rapid, intuitive way to access the massive model library and VBS Control AI 
behaviors, delivered as part of the VBS4 capability package, and to form the assets into a 
synchronized military plan. This approach massively reduces scenario development time and need 
for detailed software expertise, freeing up instructors to focus on developing scenarios which 
maximize learning.

Once the user adjusts the timeline (coordination and synchronization) of certain predefined 
actions / phase lines / advances, and so on, the plan can be immediately executed in VBS4.

Developing the synchronized Company level scenario (shown below) was 35x faster using VBS 
Plan in VBS4 compared to building the same scenario in VBS3. Any technically aware instructor 
can build a scenario - with no need for extensive VBS Editor-specific knowledge.
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Image-6: Developing a plan in 3D in VBS Plan

Scalability improvements in VBS4 now support VBS Plan engagements of 2,000+ entities. 
Combining the capabilities of VBS Plan with the enhanced scalability of VBS4, large-scale 
combined arms / joint engagements can now be trained within VBS4.

The VBS4 scalability enhancements are demonstrated in a video at 
https://youtu.be/ADR5Dk0G2aY.

  NOTE 
The videos may not be up to date with the features they demonstrate, the latest state of 
which is described in this manual.

The easy-to-use VBS Plan mode effectively brings together the massive model library of VBS, the 
pre-developed VBS Control behaviors, and the full power of the new global terrain and scalability 
capabilities of VBS4 to converge constructive and virtual training capability into a single, easy-to-
use product.

For more information, see VBS Plan Overview in the VBS Plan Manual.
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2.3 Using the VBS4 Workflow
The VBS4 Manuals are built around the workflow, to enable different user roles to focus on their 
specific phase:

 l Deploy

Install VBS4 as a Client application, setup and start the VBS World Server, and then start VBS4 
as an Administrator or Trainee in order to perform your specific role.

To install VBS4 and VBS World Server, see the VBS4 Deployment Guide.

To manage your VBS4 deployment as an administrator, see the following topics:

 o VBS World Server Overview in the VBS World Server Manual

 o Administrator Overview in the VBS4 Administrator Manual

 l Prepare

 o Create Battlespaces to organize your training Scenarios.

For more information, see Battlespace Management (on page 57).

 o Edit terrains and collaborate with other users to build terrains with an easy-to-use 
interface.

For more information, see VBS Geo Overview in the VBS Geo Manual.

 o Facilitate commander training with the easy-to-use VBS4 mission planning tool.

For more information, see VBS Plan UI Overview in the VBS Plan Manual.

 o Create complex scenarios with the powerful 3D VBS Editor.

For more information, see VBS Editor Overview in the VBS4 Editor Manual.

The Prepare phase of the workflow is described in more detail in Scenario Preparation (on 
page 85).
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 l Execute

 o Allow Instructors to manage and change any aspect of the scenario.

For more information, see VBS4 Instructor Overview in the VBS4 Instructor Manual.

 o Enable commanders to plan missions at run-time and issue orders.

For more information, see VBS Plan Overview in the VBS Plan Manual.

 o Give trainees control of a character from first-person perspective.

For more information, see VBS4 Trainee Overview in the VBS4 Trainee Manual.

 o Provide full-featured radio simulation for communication practice.

For more information, see VBS Radio Overview (on page 141).

The Execute phase of the workflow is described in more detail in Scenario Execution (on 
page 89).

 l Assess

 o Replay scenarios in 2D and 3D from any perspective, anywhere on the virtual Earth.

 o Review performance measures that are saved automatically during AAR capture.

 o Stream AAR recordings to client (Trainee) computers, see AAR Streaming in the VBS4 
AAR Manual.

The Assess phase of the workflow is described in more detail in Scenario Assessment (on 
page 101).

 o Through open APIs, leverage AAR data for use in third-party training management tools. 

To help you get started with VBS4, follow the detailed instructions provided in the Quick Start 
Guide Overview in the VBS4 Quick Start Guide.
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3. Differences from VBS3
VBS4 is a significant evolution of the Virtual Battlespace that includes major changes in the 
underlying engine technology, fundamental changes to the User Interface, and major new 
functionality, while also including the vast majority of the functions of VBS3.

The key improvements of VBS4 compared to VBS3 are ease of use, performance due to the new 
VBS Blue engine and simulation optimizations, and its Whole-Earth terrain representation. The new 
main menu workflow, and VBS Plan and VBS Geo, has been designed for non-engineers.

The aim is to unlock the power of VBS4 for every tech-aware soldier, sailor, and airman. From a 
customer perspective, this means faster generation of training scenarios (more Bloodless Battles), 
enhanced VBS3 use cases (better training) and new VBS4-only use cases (more types of training).

The following table compares VBS3 to VBS4:

  VBS3 VBS4 Improvement

Typical Startup 45 seconds 15 seconds >3x faster

Terrain Resolution Gridded terrain with a 
maximum resolution of 

approximately 5m

Continuous terrain level 
of detail down to mm-

scale

1,000x more 
detailed

Terrain Editing Visitor 4, an external tool VBS Geo, a built-in tool >10x faster and 
non-engineer 

accessible

Building a Company 
Level Plan

VBS3 Offline Mission Editor VBS Plan >35x faster and 
non-engineer 

accessible

Frame Rate on 
Recommended Hardware

45 FPS 60 FPS >30% faster

Whole-Earth Rendering 
with Realistic Object 
Densities

No Yes Realistic global 
terrain out-of-the-

box

Draw Distance 10-20km (PC dependent) Unlimited No draw limits

The following table describes the key functional differences between VBS3 and VBS4:
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  VBS3 VBS4 VBS4 Benefit

Simulation Flat-Earth rendering and 
simulation.

Whole-Earth rendering with 
Flat-Earth simulation. 
However, this is not 
noticeable to users.

Train anywhere on the Earth.

Engine Real Virtuality rendering 
engine from the Arma 
series of computer 
games.

VBS Blue, a completely new 
and updated rendering 
engine, with significant 
lighting and shading 
improvements.

The new rendering engine 
renders photo-realistic visuals 
and supports Physically 
Based Rendering (PBR).

Content 
Development

Well-defined process to 
import and configure 
new 3D content.

The 3D import pipeline is 
optimized, supporting auto-
generation of LODs, and 
adding content directly 
from common modeling 
tools such as 3DMax, 
Maya, and Blender.

The process of importing new 
3D content is quicker in VBS4, 
saving time and money.

Terrain 
Representation

Flat earth, relatively 
small, limited view 
distances, and always 
required a terrain to be 
developed by users and 
/ or third parties to 
conduct training.

A Whole-Earth database is 
provided out-of-the- box 
with realistic view 
distances and realistic 
vegetation cover. Can 
easily be edited and 
improved upon using VBS 
Geo.

A massive improvement, 
providing a Whole-Earth 
database that looks accurate 
and is more than suitable to 
support the vast majority of 
typical VBS use cases.

Terrain Editing The VBS3 RTE supports 
basic object placement 
and terrain 
manipulation within a 
scenario.
Visitor 4 is the included 
terrain tool, but it is 
difficult to use and 
requires the terrain to 
be packed and loaded 
into VBS3 to view the 
terrain edits.

VBS Geo is included with 
VBS4. It is a full-featured 
WYSIWYG terrain editor, 
which creates instantly 
ready-for-training terrains 
with no waiting for packing.

Faster terrain editing, with no 
VBS knowledge required to 
effectively use the tool. Much 
of the world is already built 
out, further reducing terrain 
development costs!
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  VBS3 VBS4 VBS4 Benefit

Mission Editing Offline Mission Editor 
(OME) and Real Time 
Editor (RTE) are 
included but suitable 
for advanced users 
only.

Full-featured mission 
planning tool (VBS Plan for 
easy, rapid plan building).
VBS Editor is also available 
for advanced users.

Commanders / Instructors 
can more easily use VBS4 to 
create and execute a plan. 
Advanced users (admins) 
benefit from reduced scenario 
development time.

Performance 45 FPS maximum 
frame rate is typical.

60 FPS frame rate is 
typical, with realistic view 
distances and building / 
vegetation density. 
Reduced load times. Takes 
full advantage of multi-core 
processors.

High frame rates are critical 
for immersive training, which 
is even more important in a 
VR environment. Higher frame 
rates also reduces / mitigates 
the impact of simulation 
sickness.

After Action 
Review

Includes 2D and 3D 
AAR replay, but terrain 
must exist locally to run 
the AAR.

Easier to use, and Whole-
Earth terrain is always 
included.

AARs are directly accessible 
from the main menu, and are 
categorized by Battlespace. 
Faster to access and with less 
admin overhead.

The sections below provide more information about the functional differences between VBS3 and 
VBS4:

 l VBS4 Client and VBS World Server (on the next page)

 l Terrain Storage and Editing (on page 26)

 l Rendering (on page 28)

 l VBS4 User Interface (on page 28)

 l Disabled VBS3 Functionality (on page 28)

 l VBS3 Terrains and Missions (on page 29)

 l Third-Party Products and Integrations (on page 29)
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3.1 VBS4 Client and VBS World Server
VBS4 is a Client-Server application, supporting an Online use case, where VBS4 Clients can 
connect to a separate VBS World Server that streams the Whole-Earth Terrain and also acts as a 
central repository of Battlespaces.

  NOTE 
To support the flexible use of your hardware, VBS4 supports an Offline use case, where a  
VBS World Server is not required.

This change results in significant differences compared to VBS3:

 l VBS4 deployment consists of VBS4 Client and Dedicated Server installations and the separate 
deployment of a VBS World Server.

For more information, see Deploying VBS4 in the VBS4 Administrator Manual.

 l A Scenario Execution is typically hosted on a separate Dedicated Server or on a VBS4 Admin 
Client and not hosted by the VBS World Server.

For more information, see Scenario Execution (on page 89).

 l All VBS4 Clients and Dedicated Servers select whether to use the Online use case, connected 
to a VBS World Server, or the Offline use case, without that connection, when they start.

For more information, see Starting VBS4 in the VBS4 Administrator Manual.
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3.2 Terrain Storage and Editing
VBS Blue is the powerful, flexible, and military-oriented rendering engine and data-ingestion 
pipeline behind VBS4, developed in-house by Bohemia Interactive Simulations. VBS Blue is built 
with military simulation use cases in mind including global scale, mm-level accuracy, and flexible, 
procedurally-enhanced terrain representation.

Image-7: VBS4 renders realistic terrain, from space down to blades of grass

The new engine results in significant differences compared to VBS3:

 l Whole-Earth Terrain

The Whole-Earth Terrain replaces the separate individual terrains used in VBS3. The 
VBS World Server hosts the Whole-Earth Terrain, loads specific terrain edits, and serves that 
terrain to all connected VBS4 Clients during Scenario Execution. VBS4 can also host Whole-
Earth terrain data locally, to run stand-alone (no VBS World Server required).

 l VBS Geo

VBS Geo provides a new terrain editing capability that replaces the VBS3 terrain editor, Visitor 
4. Terrain edits are made as part of the Scenario Preparation process.

These terrain edits are saved as a Geo Project, associated with the Battlespace containing the 
Scenario, that is loaded by VBS4 during Scenario Execution.

As a result of these changes, the following VBS3 functionality is not available in VBS4:
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 l Terrain Modification Tool

The Terrain Modification Tool is not available in VBS Editor in VBS4. Use the Elevation Tool in 
VBS Geo instead.

See Editing Terrain Elevation in the VBS Geo Manual.

 l Flood Modification Tool 

The Flood Modification Tool is not available in VBS Editor in VBS4. Use the Water Tool in VBS 
Geo instead.

See Placing and Editing Water in the VBS Geo Manual.

 l Biotope Loader

The Biotope Loader is not available in VBS Editor in VBS4. Use the Surface Tool in VBS Geo 
instead.

See Editing Terrain Surfaces in the VBS Geo Manual.

 l Promotion / Removal of Visitor Placed Objects

VBS4 does not directly support maps created with Visitor.

Use the Terrain Converter Tool to convert your VBS3 terrains into detailed terrain areas in the 
Whole-Earth Terrain.

See  in the VBS World Server Manual.

  WARNING 
While berms are functional in VBS4, Editor Objects with underground cutting (such as 
trenches) are not.

 l To create berms, see Earthworks (Berms) in the VBS4 Editor Manual, or use VBS Geo.

 l To create trenches, use VBS Geo.

VBS Geo berms and trenches cannot be modified by earth-moving vehicles.

For more information on using VBS Geo to create berms and trenches, see Placing and 
Editing Models and Elevation Line Editing in the VBS Geo Manual.
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3.3 Rendering
VBS Blue is cutting-edge technology, capable of rendering unlimited view distances with weather, 
particle effects, day / night, regional and seasonal vegetation, along with many other real-world 
natural features. VBS Blue has been designed from the outset to efficiently render complex, 
cluttered, and congested scenes at high frame rates for space, land, air, and sea domain 
simulations and adding procedural detail to basic terrain data on-the-fly.

This change results in the following differences compared to VBS3:

 l VBS4 uses an entirely different set of Video Options.

For more information, see Video Settings in the VBS4 Administrator Manual.

 l The following VBS3 video capture functionality is not available in VBS4:

 o Live Stream Broadcast

 o Record Video Tool

 o Recording Video using GBOSS Security Camera

Bohemia Interactive Simulations recommends using free and readily available recording tools, 
such as Nvidia ShadowPlay, to replace this functionality.

3.4 VBS4 User Interface
VBS4 uses a radically different approach to the front end user interface focused on the Whole-
Earth Terrain and Battlespaces instead of the Main Menu approach in VBS3.

The Whole-Earth Terrain enables you to rapidly focus on specific locations on the Earth and quickly 
Prepare a Scenario that meets your training needs.

For more information, see VBS4 UI Overview (on page 33).

3.5 Disabled VBS3 Functionality
The development of VBS4 is an ongoing process intended to support as many VBS3 features as 
possible. However, significant changes in the underlying technology of VBS4 mean that some 
existing VBS3 features do not work as intended and require additional development.

The following features are disabled in this release:

 l Chemlights

 l Heat Haze Effect

 l Surface Radar
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  FEATURE NOTICE 
Bohemia Interactive Simulations intends to enable the majority of these features or provide 
equivalent replacement features in future releases of VBS4.

3.6 VBS3 Terrains and Missions
The Whole-Earth Terrain replaces the terrains used in VBS3. You can convert terrains created for 
VBS3 using the Terrain Conversion tool.

For more information, see  in the VBS World Server Manual.

By default, VBS3 missions cannot be edited or executed in VBS4. However, you can convert VBS3 
missions to VBS4 scenarios, using the Mission Converter tool.

For more information, see Mission Converter in the VBS4 Editor Manual.

VBS3 Training Scenarios are replaced by a Training Battlespace in VBS4.

For more information, see  in the VBS4 Trainee Manual.

3.7 Third-Party Products and Integrations
VBS4 does not support VBSFusion or the Application Scripting Interface (ASI). Plugins and 
products developed using VBSFusion and the ASI, such as VBSFires, are not supported in VBS4.

To develop plugins, products, and functionality for VBS4 use VBS Simulation SDK.

For more information, see VBS Simulation SDK (on page 155) or contact Support at 
support@bisimulations.com.
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4. Deploying VBS4
VBS4 is available for download from VBS License Manager and consists of multiple product 
installers and packages:

 l VBS World Server installer

 l VBS4 Client / Dedicated Server installer

 l A set of mandatory core download packages

 l A set of optional download packages.

  WARNING 
VBS4 and VBS World Server installations must be the same major version (e.g., 21.1.x) to 
ensure full compatibility.

For most use cases, a VBS4 deployment consists of the products shown in the following diagram.

1 Network 
Switch

The recommended setup for VBS4 deployments is for all clients and servers to 
share the same network.

2 VBS4 Admin 
Clients

The Admin Client is a VBS4 Client installation started with Administrator privileges 
for the following primary purposes:

 l Prepare - Design Scenarios by creating a Battlespace containing terrain edits, a 
tactical plan, and a mission.

 l Execute - Start and manage a Scenario as the Instructor.
 l Assess - Run After Action Review to playback a Scenario Execution.
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3 VBS4 
Trainee 
Clients

Each Trainee Client is a VBS4 Client installation started with default user privileges 
in order to participate in Scenario Executions.

4 VBS4 
Dedicated 
Server

The Dedicated Server is a VBS4 Client installation started as a server to host the 
Scenario.

5 VBS World 
Server

For Online use cases the VBS World Server acts in two significant capacities:
 l Streaming the base Whole-Earth Terrain to connected VBS4 Clients.
 l Acts as the central repository of Battlespaces.

  TIP 
Bohemia Interactive Simulations recommend a faster network connection 
between the VBS World Server and the network switch. For more 
information, see System Requirements in the VBS4 Deployment Guide.

  NOTE 
VBS4 supports Offline use cases where VBS World Server is not required.

To download and install VBS4 for most use cases, follow this process using the VBS4 
Deployment Guide:

 1. Review VBS4 Deployment Options to assess the deployment requirements that meet your 
training needs.

 2. Review the System Requirements.

 3. Download VBS4 from VBS License Manager.

 4. Install VBS World Server, see Installing VBS World Server.

 5. Install as many Dedicated Servers and VBS4 Clients as required for your training needs, see 
Installing VBS4.

Your VBS4 deployment is installed.

  WARNING 
Additional World Data packages are available on VBS License Manager that are not 
installed by default.

Download and deploy them using the Updater Tool. For more information, see Installing 
World Data in the VBS World Server Manual.

To support patch updates and later download of optional packages, VBS4 includes update utilities 
for VBS World Server and VBS4 Clients.

See the following topics in the VBS4 Administrator Manual.
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 l Installing a VBS World Server Patch

 l Updating VBS4

After successful deployment, you are ready to start VBS4:

 1. If it is not already running, start VBS World Server:

Run \WS_Installation\vws_start.exe

 2. Start the Dedicated Server and VBS4 Clients:

See Starting VBS4 in the VBS4 Administrator Manual.
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5. VBS4 UI Overview
After starting  VBS4 as an Administrator, the user interface starts in Battlespaces Mode, providing 
the primary access point to Prepare, Execute as a Host, and Assess Scenarios. Scenario Execution 
using a Dedicated Server is started from Training Mode.

The VBS4 UI starts in Battlespaces Mode and displays the following main UI elements:

1 VBS4 Toolbar The  VBS4 Toolbar (on page 35) provides access to a set of global and context-
specific functions.

  NOTE 
The VBS4 Toolbar is available in all modes, but its content is mode 
specific.

2 Battlespaces 
List

Use the Battlespaces List to create and manage Battlespaces, and then to 
access the VBS4 functions required to Prepare, Execute as a Host, and Assess 
your Scenarios.
For more information, see Battlespace Management (on page 57).

3 Whole-Earth 
Terrain

Navigate the VBS4 rendering of the entire Earth using the Whole-Earth Terrain 
(on page 48).
 

Trainees start VBS4 in the Training UI which Administrators can also access by clicking Training in 
the VBS4 Toolbar:
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 l Use the Multiplayer Connect to Server button to access a Dedicated Server and start or join 
Multiplayer Training.

For more information, see Dedicated Server Scenario Execution (on page 89) and Joining a 
Multi-Player Scenario in the VBS4 Trainee Manual.

 l Use the Singleplayer Battlespace list to start a solo training scenario.

For more information, see Single Player Training in the VBS4 Trainee Manual.

For information about the VBS4 User Interface in other modes, see the following topics:

Prepare

 l VBS Geo User Interface in the VBS Geo Manual

 l VBS Plan UI Overview in the VBS Plan Manual

 l Mission Designer Interface in the VBS4 Editor Manual

Execute

 l Instructor Interface in the VBS4 Instructor Manual

 l Joining a Scenario in the VBS4 Trainee Manual

Assess

 l AAR Playback and the User Interface in the VBS4 AAR Manual
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5.1 VBS4 Toolbar
The VBS4 Toolbar is available in all modes, and provides access to a set of global and context 
specific functions.

From left to right, the Toolbar contains the following context sensitive items:

 l VBS4 Main Menu (on the next page)

 l Mode Indicator

 l The Battlespace name displays in Prepare, Preview, Execute, and Assess modes.

 l Administrators can switch between Battlespaces and Training mode.

 l In Prepare, Preview, Execute, and Assess modes, Tool Selection (on page 37) is available.

 l In Battlespaces and Training modes, the Global Navigation Toolbar (on page 37) is available to 
Administrators.

 l In Assess Mode, AAR Streaming Controls (on page 39) are available to Instructors.

 l Connectivity (on page 40) icons display the status of the connections to VBS World Server and 
enable Administrator access to the VWS Dashboard.

 l Camera Controls (on page 42)

 l In Prepare Mode, Preview (on page 44) is available.

 l VBS4 Settings (on page 45)

 l Documentation (on page 46)

 l Notifications (on page 47)
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5.1.1 VBS4 Main Menu
Click the Main Menu icon to open the context sensitive Main Menu.

In Battlespaces and Training Mode, the Main Menu provides access to the following options:

 l Upload Offline Battlespaces

Synchronize your local Battlespaces with the Battlespace on VBS World Server.

For more information, see Synchronize Battlespaces (on page 68).

  NOTE 
This option is only available in Online modes, connected to VBS World Server.

 l Exit

Click to close the VBS4 Client.

  NOTE 
The Client window closes in a few seconds, but VBS4 processes may take as long as a 
minute to fully close in the background.

The Main Menu is contextual and the functions available depend on the current  Mode and active  
Tool.
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For more information about the Main Menu options in other modes, see the following topics:

 l VBS4 Main Menu for VBS Geo in the VBS Geo Manual

 l VBS4 Main Menu for Mission Planning in the VBS Plan Manual

 l VBS4 Main Menu for Mission Design in the VBS4 Editor Manual

 l VBS4 Main Menu for Scenario Execution in the VBS4 Instructor Manual

 l VBS4 Main Menu for Training in the VBS4 Trainee Manual

 l VBS4 Main Menu for the AAR in the VBS4 AAR Manual

5.1.2 Tool Selection
In Prepare and Execute Modes, use the Tool Selection bar to switch between the VBS4 Tools.

 l When Preparing or Executing a Scenario, click the Tool name to switch seamlessly between 
VBS Geo, VBS Plan, and VBS Editor.

  NOTE 
VBS Geo is only available in Prepare Mode.

For information about using these tools, see the following topics:

 l VBS Geo Overview in the VBS Geo Manual

 l VBS Plan Overview in the VBS Plan Manual

 l VBS Editor Overview in the VBS4 Editor Manual

5.1.3 Global Navigation Toolbar
The Global Navigation Toolbar is located on the main VBS4 Toolbar.

In Battlespaces mode, use the Search Bar to locate places in the Whole-Earth Terrain, using place 
names, or comma-separated latitude and longitude co-ordinates, for example 33°20′32″N, 
69°12′50″E.
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Search uses location data from the following sources:

 l A connected VBS World Server.

 l Google Location Search (used when not connected to VBS World Server, requires internet 
access).

Type in the place name, and select from the dynamic search results, which are displayed in a drop-
down list. The results are displayed by type, in the following order:

 l Battlespaces

 l POIs

 l Google Maps locations

The Whole-Earth Terrain reorients, centered on the selected location.

Click the Eye Icon to toggle marker visibility for POI / Battlespace Markers.

For more information, see Whole-Earth Terrain (on page 48).

Click the POI Icon to open / close the Points of Interest panel, showing specific bookmarked 
locations.

For more information, see Using POIs (on page 51).
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  NOTE 
When the POI Panel is displayed, the POI Markers are displayed instead of the Battlespace 
Markers on the Whole-Earth Terrain.

Click the Reset Camera to North Icon to reorient the camera in the Whole-Earth Terrain, so that 
North is at the top.

5.1.4 AAR Streaming Controls
In Assess Mode, click the following icons to stream recorded AARs to clients on the same 
network.

Icon Description

Click to stream an AAR recording to clients.

Click to enable voice communication to clients utilizing VBS Radio.

For more information, see AAR Streaming in the VBS4 AAR Manual.
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5.1.5 Connectivity
The World Server Status icon (globe) indicates whether you are connected to the VBS World 
Server, or in Offline Mode.

 l Connected to the VBS World Server (Online Mode), green check mark.

VBS4 has the following VBS World Server connectivity problem indicators:

If connection to the VBS World Server is lost, 
the VWS Disconnected popup appears:

If the Geo / File Server service is not running 
the World Server Status icon displays a red 
cross.

 l In Offline Mode, the World Server Status displays a gray disconnected icon.

Hover your cursor over World Server Status icon to check the status of the VBS World Server that 
the VBS4 Client is connected to, and to access the VWS Dashboard for a connected VBS World 
Server.
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Administrators can access the VWS Dashboard for the connected VBS World Server by clicking 
Open Dashboard.

For more information, see The VBS World Server User Interface in the VBS World Server Manual.
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5.1.6 Camera Controls
The following camera types are available:

 l Orbit and Classic Camera (below)

The current camera position can be saved using Camera State (on the next page) hotkeys.

 l Spectator Camera (on the next page)

Orbit and Classic Camera

For Orbit and Classic Camera, click the Keyboard Icon to open the Controls Panel displaying the 
applicable  camera controls for your current Mode.

  

The Orbit Camera applies to the Whole-Earth Terrain and is an option in VBS Geo. For more 
information, see the following topics:

 l Whole-Earth Terrain (on page 48)

 l VBS Geo User Interface in the VBS Geo Manual

The Classic Camera applies to VBS Plan and VBS Editor and is the default camera in VBS Geo. For 
more information, see the following topics:

 l VBS Geo User Interface in the VBS Geo Manual

 l View Controls in the VBS Plan Manual

 l 3D Camera and 2D Map Views in the VBS4 Editor Manual

 l Instructor Views and Perspectives in the VBS4 Instructor Manual
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In VBS Geo switch between camera modes using the Camera Controls drop-down.

Camera State

The current position and state of the camera, including date and time, can be saved for later 
reference:

 l Press Ctrl + Alt + S

VBS4 saves the camera state to your Windows clipboard.

  TIP 
Bohemia Interactive Simulations Customer Support may request a camera state file to help 
resolve issues. Immediately after saving the camera state, you can paste it into a text 
document by pressing Ctrl + V.

To restore the saved camera state:

 l Press Ctrl + Alt + L

VBS4 restores the saved camera position.

Spectator Camera

For the Spectator Camera, click the Eye Icon to open the Controls Panel displaying the applicable  
camera controls for the Preview and Execute Modes.
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The Spectator Camera is available in the player simulation. For more information, see the following 
topics:

 l Spectator Camera in the VBS4 Instructor Manual

5.1.7 Preview
The Preview button is specific to Prepare Mode and displayed in the VBS4 Toolbar when using 
VBS Geo, VBS Plan, and VBS Editor.

Click Preview to start the current state of the Scenario as a single-player mission.

The Scenario starts as a playable mission with you controlling the first playable character placed in 
the Scenario.

 l Play the Scenario as a Trainee to preview the Scenario in action.

For information about controlling your character, see   the VBS4 Trainee Manual.

 l Modify the Scenario as an Instructor to play test various aspects of the Scenario.

Press Map (M) or Pause (Esc), and select Editor to open VBS Editor in Preview Mode.

Preview Mode provides the majority of the same VBS Editor functions as Execute Mode.

For more information, see Instructor Interface in the VBS4 Instructor Manual.

  NOTE 
Any changes made to the Scenario during the Preview only persist for the duration of 
the Preview and are not saved as part of the Battlespace.

 l Restart the Scenario as an Instructor.

Press Pause (Esc) and in the Main Menu in the VBS4 Toolbar, select Restart Battlespace.

 l Return to the Editor UI in Prepare Mode to continue editing the Scenario.

Press Pause (Esc) and in the Main Menu in the VBS4 Toolbar, select End Battlespace.

 l Open the Config Browser.

Press Pause (Esc) and in the Main Menu in the VBS4 Toolbar, select Config Browser.
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5.1.8 VBS4 Settings
Click the Settings Icon to open the VBS4 Settings panel and configure how VBS4 functions.

For more information, see VBS4 Settings in the VBS4 Administrator Manual.
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5.1.9 Documentation
Click the Help Icon to open the Documentation panel containing the VBS4 Manuals.
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5.1.10 Notifications
Click the Notifications Icon to open and close the Notifications Panel and view VBS4 status 
messages.

  NOTE 
Notifications that CBRN1, CBRN3, CAS 5-Line, and CAS 9-Line Forms were received can be 
opened by clicking View Form. For more information, see Forms in the VBS4 Trainee 
Manual.
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5.2 Whole-Earth Terrain
The Whole-Earth Terrain provides a navigable representation of the globe, displaying geolocated 
Points of Interest and Battlespaces, and the functionality to create new ones.

Navigate the Whole-Earth Terrain to view a region of interest using the Orbit Camera Controls:
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  NOTE 
The Orbit Camera in the Whole-Earth Terrain and VBS Geo and the Classic Camera in VBS 
Plan and VBS Editor operate in different ways even though they share some of the same 
controls.

 l The Classic Camera uses the camera position as the focal point. Turning or tilting 
rotates the camera itself.

 l The Orbit Camera uses the position of the cursor in the terrain as the focal point. 
Turning or tilting the camera rotates it in an orbit around the focal point, and Zoom 
moves in towards and out from the focal point.

Click the Keyboard Icon in the VBS4 Toolbar (on page 35) to view the current Camera 
Control scheme.

  NOTE 
Whole-Earth navigation is completely disabled for Trainees and disabled for Administrators 
when the Multiplayer panels or Network Lobby are open.

Click the Reset Camera to North Icon to reorient the camera in the Whole-Earth Terrain, so that 
North is at the top.

Points of Interest and Battlespaces are represented by custom-colored markers in the Whole-Earth 
Terrain:

 

Click the POI Icon in the VBS4 Toolbar to toggle between POI Markers and Battlespace Markers in 
the Whole-Earth Terrain and to open and close the Points of Interest Panel.
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 l Right-click a Marker to view its menu.

 l Right-click an empty area of terrain to create a new POI or Battlespace.

For more information, see:

 l Using POIs (on the next page)

 l Battlespace Management (on page 57)
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5.3 Using POIs
Points of Interest (POIs) are geolocated markers in the Whole-Earth Terrain that act as bookmarks 
to highlight specific locations on the globe, and provide quick navigation.

Click the POI Icon in the  Global Navigation Toolbar (on page 37) to open the Points of Interest 
Panel, and display POI Markers in the Whole-Earth Terrain (on page 48).
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  NOTE 
POI creation and edit functions are not available in Training Mode.

You can find a specific location, where you want to create a POI.

Follow these steps:

 1. In the VBS4 Toolbar, input the location in the Search Bar.

The input can be in any of the following location formats:

 l POI - Searches for the name of an existing POI.

 l Battlespace - Searches for the name of an existing Battlespace.

 l Address - Uses the VBS World Server or Google Maps Search to find the location.

 l Lat / Long - Uses comma-separated Latitude and Longitude coordinates to find for the 
location.

 l MGRS - Uses the MGRS coordinate system to find the location.

A drop-down list appears with the closest matches to the data you entered in the Search Bar.

 2. Click the location you want to use.

VBS4 finds the location, and moves to it in the Whole-Earth Terrain.

In the Points of Interest Panel:

 l Select a POI from the list to view more information, including coordinates and Tags.
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 l Locate a POI in the Whole-Earth Terrain.

Select a POI from the list and click Go to.

 l Click the icons in the POI Toolbar to do the following:

 o Click the Add Icon to create a new POI.

See Create POIs (on the next page).

 o Click Trash Icon to delete the selected POI.

See Delete POIs (on page 56).

 o Click Edit Icon to edit the selected POI.

See Edit POIs (on page 55).

In the Whole-Earth Terrain:

 l Place the cursor over a POI to view its name and highlight it in the POI list.

 l Right-click a POI to access the available options: 

 o Create Battlespaces (on page 60)

 o Edit POIs (on page 55)

 o Delete POIs (on page 56)

 l Right-click a location to Create POIs (on the next page).
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5.3.1 Create POIs
Create Points of Interest to add location bookmarks for easy navigation.

Follow these steps:

 1. Navigate the Whole-Earth Terrain (on page 48) to display the region of interest.

 2. Do any of the following:

 l In the Points of Interest Panel, click the Add Icon, and then click the location in the Whole-
Earth Terrain.

 l In the Whole-Earth Terrain, right-click the location, and select Create POI.

The Create Point of Interest dialog opens, with a default name for the location.

 3. Input a Name for the POI.

 4. Click the color box to select a custom Color for the POI Marker.

 5. Create Tags, to add labels to the POI:

 l Input a Tag name and press Comma, Enter, or Tab. Continue typing to create another one.

 l To remove a Tag, click X.
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 6. Optional. Input a Description for the POI.

 7. Click Save Changes to save the POI.

VBS4 adds the location to the POI List, and adds a POI Marker to the Whole-Earth Terrain.

5.3.2 Edit POIs
Edit POIs to modify their parameters.

Follow these steps:

 1. Do any of the following:

 l In the Points of Interest Panel, select a POI from the list, and then click the Edit Icon.

 l In the Whole-Earth Terrain (on page 48), right-click the POI, and select Edit POI.

The Edit Point of Interest Panel opens, with a default name for the location.

 2. Input a new Name for the POI.
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 3. Click the color box to select a custom Color for the POI.

 4. Add Tags, to add labels to the POI:

 l Input a Tag name and press Comma, Enter, or Tab. Continue typing to create another one.

 l To remove a Tag, click X.

 5. Input a new Description for the POI.

 6. Click Save Changes.

VBS4 updates the Point of Interest.

5.3.3 Delete POIs
Delete POIs to remove them from the Whole-Earth Terrain, and the Points of Interest List.

Follow this step:

 1. Do any of the following:

 l In the Points of Interest Panel, select a POI from the list, and then click the Trash Icon.

 l In the Whole-Earth Terrain (on page 48), right-click the POI, and select Delete POI.

The Delete Point of Interest dialog opens.

 

 2. Click Yes.

VBS4 removes the POI from the POI List, and removes the POI Marker from the Whole-Earth 
Terrain.
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6. Battlespace Management
The Battlespace is the primary organizational concept in VBS4, defining a training Scenario.

In VBS4, a Battlespace acts as a container for the following Scenario objects:

 l A set of terrain edits created with VBS Geo, known as a Geo Project.

 l A Tactical Plan created with VBS Plan.

 l A detailed set of entities defining a Mission created with VBS Editor.

  NOTE 
AAR Recordings are also stored as part of the Battlespace.

Collectively, the Geo Project, the Plan, and the Mission within a Battlespace define a Scenario that 
meets a particular set of training use cases.

  NOTE 
In this release of VBS4, a Battlespace may only contain one Scenario.

The Battlespaces List in the Battlespaces tab provides the access point to create new 
Battlespaces and to access the editing tools required to Prepare a Scenario.
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  NOTE 
The Battlespaces List displays locally saved Battlespaces and Battlespaces stored on a 
connected VBS World Server.

In case of Battlespace changes done outside of VBS4 (for example, copying or deleting 
Battlespaces), click the Refresh Battlespaces Icon to refresh the Battlespaces List.

  WARNING 
Avoid Battlespace changes outside of VBS4, so as not to impair the Battlespace 
data and folder structure (see Battlespaces Folder (on page 83)).

Use the Battlespaces List to:

 l Create Battlespaces (on page 60)

 l Locate a Battlespace. Select a Battlespace in the Battlespaces List, and click Navigate.

 l Access VBS4 Functions (on page 64):

 o Modify the terrain Geo Project with VBS Geo as described in the VBS Geo Manual.

 o Create and edit Tactical Plans with VBS Plan as described in the VBS Plan Manual.

 o Create and edit Scenarios with VBS Editor as described in the VBS4 Editor Manual.

 o Execute Scenarios using your VBS4 Client as the Host, see VBS4 Client Hosted Scenario 
Execution (on page 95).

Use the Training tab to Execute a Scenario for Multiplayer Training.

For more information, see Dedicated Server Scenario Execution (on page 89).

 o Assess Scenario Execution using VBS4 After Action Review as described in the VBS4 AAR 
Manual.

 o Delete AAR Recordings.

 l Synchronize Battlespaces (on page 68)

 l Edit Battlespace Details (on page 73)

 l Delete Battlespaces (on page 76)

 l Filter Battlespaces (on page 80)

 l Search Battlespaces (on page 82)
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  WARNING 
VBS4 is a Client-Server application, where VBS4 Clients may be connected to a VBS World 
Server that acts as a central repository for Battlespaces and also connected to a Dedicated 
Server or VBS4 Host that runs the Scenario.

Different versions of the same Battlespaces can exist on the VBS World Server, VBS4 
Clients, and Dedicated Servers.

When you Execute a Scenario, you select whether to use the version on the VBS World 
Server, the local VBS4 Admin Client, or the Dedicated Server. To ensure that all computers 
participating in the Scenario use the same version of the Battlespace, VBS4 automatically 
copies the selected version as follows:

 l If the VBS World Server version is used, it downloads to the VBS4 Admin Client and 
uploads to the Dedicated Server, overwriting any versions on those computers.

 l If the local VBS4 Admin Client version is used, it uploads to the Dedicated Server, 
overwriting the version on that computer. The VBS World Server version is not 
affected.

 l If the Dedicated Server version is used, no overwriting occurs and the VBS World 
Server and VBS4 Admin Client versions are not affected.

 l When VBS4 Trainee and Admins Clients join a running Scenario they download a 
temporary copy of the Battlespace from the Dedicated Server and any locally stored 
versions of the Battlespace are not affected.

Before any Battlespaces are overwritten, a prompt appears to notify the Administrator with 
an option to cancel.

The current implementation of this release of VBS4 creates the following limitations for 
VBS4 Client users:

 l Avoid editing the same Battlespace on two separate Clients at the same time.

Scenario Preparation takes place using a local copy of the Battlespace files. 
Synchronizing Battlespaces uploads those edits to the VBS World Server. If two 
Administrators edit a Battlespace at the same time, the first to upload is overwritten by 
the second.

 l Do not edit the terrain Geo Project for a Battlespace if there are After Action Review 
recordings for it.

Each Battlespace only supports a single Geo Project which is loaded during Scenario 
Execution and Scenario Assessment. Editing the terrain with VBS Geo after Scenario 
Execution may invalidate the AAR recording, for example by changing a flat area into a 
hill. The AAR package replays the movements and events that occurred when the 
terrain was flat, but during Playback, the hill is rendered as part of the terrain.
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6.1 Create Battlespaces
All terrain edits, plan definitions, and mission edits must be contained within a defined 
Battlespace, so before defining a scenario you must create a Battlespace.

Follow these steps:

 1. Start VBS4 as an Administrator.

VBS4 starts in Battlespaces Mode, displaying the Battlespaces List and the Whole-Earth 
Terrain.
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 2. Do one of the following:

 l Use the Camera Controls (on page 42) to navigate the globe.

Right-click a location, and select Create Battlespace from the context menu.

 l In the Battlespaces List, click + New Battlespace.

Use the Camera Controls (on page 42) to navigate the globe, and click the required 
location.

The Create Battlespace dialog opens.

 3. Input a Name for your Battlespace.

  NOTE 
Latitude and Longitude display the position clicked and define the center of your 
Battlespace, and the position of the Battlespace Marker. They cannot be changed.

 4. Optional: Click the Color box and use the Color Palette dialog to specify a color for the 
Battlespace Marker on the Whole-Earth Terrain.

 5. Optional: Create Tags to add labels for Battlespace filtering:

 l Input a Tag name and press Comma, Enter, or Tab. Continue typing to create another one.

 l To remove a Tag, click X.

 6. Optional: Input a Description for your Battlespace.
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 7. Optional: Select Available as a Singleplayer Training Mission to make the Battlespace 
available to Trainees in the Training tab.

Optional: Add an overview image to a Singleplayer Training Mission.

 a. Create an overview JPEG image called overview_image.jpg.

  WARNING 
The overview image file must be in JPEG format, and cannot have any other name.

 b. Place the overview image in:

\Documents\VBS4\Battlespaces\Battlespace_Name\Missions\Scenario_Name\

 c. Click the Refresh Battlespaces Icon.

The overview image appears in the Training Details of the Singleplayer Training Mission in the 
Training tab.

For more information, see Single Player Training in the VBS4 Trainee Manual.
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  NOTE 
Scenarios require a playable unit before they can be Executed from the Singleplayer 
Battlespace list.

 8. Click Save Changes.

VBS4 adds the new Battlespace to the Battlespaces List, and adds a Battlespace Marker to the 
Whole-Earth Terrain.

Click the Battlespace name in the Battlespaces List to view or Edit Battlespace Details (on 
page 73), Synchronize Battlespaces (on page 68) to and from the VBS World Server, and to Access 
VBS4 Functions (on the next page).
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6.2 Access VBS4 Functions
Selecting a Battlespace opens the Battlespace Functions Panel, which provides access to the 
primary functions of VBS4.

At the top of the Battlespace Functions Panel are the following icons:

 l Synchronization Status

When you are connected to VBS World Server, these icons indicate whether the local copy of 
the Battlespace is different to the copy on the VBS World Server.

See Synchronize Battlespaces (on page 68).

 l Edit

Click the Edit Icon to modify the Battlespace details.

See Edit Battlespace Details (on page 73).
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 l Delete

Click the Delete Icon to remove the Battlespace.

See Delete Battlespaces (on page 76).

Use the options under each mode to do any of the following:

 l Prepare

Create or modify the Battlespace Scenario.

An overview of the Prepare workflow is described in Scenario Preparation (on page 85).

Highlight the individual option, and click the Create button to work on a specific part of the 
Scenario:

  NOTE 
If Geo / Plan / Editor content has already been added to the Battlespace, the 
respective Geo / Plan / Editor button displays Open.

 o Geo

Modify the terrain using VBS Geo.

For details about using VBS Geo, see VBS Geo Overview in the VBS Geo Manual.

 o Plan

Create or edit a tactical plan using VBS Plan.

For details about using VBS Plan, see VBS Plan Overview in the VBS Plan Manual.

 o Editor

Create or edit a mission using VBS Editor.

For details about using VBS Editor, see VBS Editor Overview in the VBS4 Editor Manual.
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 l Execute

Run and manage a Scenario as an Instructor using your VBS4 Admin Client to Host the 
Scenario. Highlight the Battlespace Scenario, and click Host.

An overview of the Hosted workflow is described in VBS4 Client Hosted Scenario Execution 
(on page 95).

  NOTE 
Use the Training tab to Execute a Scenario on a Dedicated Server.

For more information, see Dedicated Server Scenario Execution (on page 89).

 l Assess

Click Open for an AAR Recording to start the AAR Playback and review a Scenario Execution.

  NOTE 
If the AAR is only stored locally, click Upload to upload it to the VBS World Server, to 
make the AAR distribution to other VBS4 Clients possible. If the AAR is not stored 
locally, click Download to download it from the VBS World Server.

An overview of the Assess workflow is described in Scenario Assessment (on page 101).

Click the Trash Icon to the left of an AAR Recording name to delete it.

For more information, see AAR Deletion (on page 78).

The Battlespace Marker also provides quick access to VBS4 functions.

Right-click the Battlespace Marker to view the available options: 
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 l Open in Geo

Modify the terrain using VBS Geo.

For details about using VBS Geo, see VBS Geo Overview in the VBS Geo Manual.

 l Open in Plan

Create or edit a tactical plan using VBS Plan.

For details about using VBS Plan, see VBS Plan Overview in the VBS Plan Manual.

 l Open in Editor

Create or edit the Scenario mission using VBS Editor in Prepare Mode.

For details about using VBS Editor, see VBS Editor Overview in the VBS4 Editor Manual.

 l Host

Run and manage a Scenario as an Instructor using your VBS4 Admin Client to Host the 
Scenario. Highlight the Battlespace Scenario, and click Host.

An overview of the Hosted workflow is described in VBS4 Client Hosted Scenario Execution 
(on page 95).

  NOTE 
Use the Training tab to Execute a Scenario hosted on a Dedicated Server.

For more information, see Dedicated Server Scenario Execution (on page 89).

 l Edit Battlespace

Open the dialog to Edit Battlespace Details (on page 73).

© 2023 - Bohemia Interactive Simulations - All Rights Reserved - 67 -



6. Battlespace Management VBS4 23.2.0

 l Delete Battlespace

Remove all Battlespace files. For information on which files get deleted and where, see Delete 
Battlespaces (on page 76).

6.3 Synchronize Battlespaces
You can synchronize Battlespaces and AAR Recordings between your local computer and the 
VBS World Server.

 l Battlespace Synchronization (below)

 l AAR Synchronization (on page 73)

6.3.1 Battlespace Synchronization
Use the Synchronize Icons at the top of the Battlespace Functions Panel to synchronize 
Battlespaces, and upload / download them between the VBS World Server and your computer.

Battlespaces are always created and edited locally and can be uploaded to the VBS World Server, 
which allows other VBS4 Clients connected to the VBS World Server to download the Battlespaces. 
Your computer and the VBS World Server can have different versions of a Battlespace, and 
synchronization can be used to resolve the version differences.

There are three Battlespace synchronization states and Synchronize Icons representing them:

 l There is a version of the Battlespace on your computer, which is not on the VBS World Server, 
or the version on the latter is different.

In this  case, the Upload Icon appears, which means that you can upload the Battlespace to the 
VBS World Server.

 l There is a version of the Battlespace on the VBS World Server, which is not on your computer, 
or the version on the latter is different.

In this case, the Download Icon appears, which means that you can download the Battlespace 
from the VBS World Server to your computer.
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 l The Battlespace versions on your computer and on the VBS World Server match.

In this case, the Check Mark Icon appears, which signifies that the Battlespace on your 
computer is in sync with the VBS World Server.

To synchronize Battlespaces, follow these steps:

 1. Click a Battlespace in the Battlespaces List, so that it is highlighted.

The corresponding Battlespace Functions Panel opens.
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 2. Do any of the following:

 l Download Battlespace - Click the Download Icon.

The following dialog opens:

Click Download to continue to download the selected Battlespace from the VBS World 
Server to your computer.

 l Upload Battlespace - Click the Upload Icon.

The following dialog opens:

Click Upload to continue the upload of the selected Battlespace from your computer to the 
VBS World Server.

When the download / upload completes, the Check Mark Icon appears.
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This indicates that the Battlespace version on your computer is synchronized with the Battlespace 
version on the VBS World Server.

Multiple Battlespaces can be uploaded to the VBS World Server at one time, using the Upload 
Offline Battlespaces option in the Main Menu, see VBS4 Main Menu (on page 36).

Follow these steps:

 1. Click the Main Menu, and select Upload Offline Battlespaces.

The Upload All Offline Battlespaces dialog opens.
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 2. Do one of the following:

 l Click Deselect All to deselect all Battlespaces in the list.

 l Click Select All to select all Battlespaces in the list.

 l Check one or more of the boxes in the list.

 3. Click Upload Selected.

The Battlespace Uploading dialog opens, showing the progress of the upload, followed by the 
Battlespace Upload Complete dialog.

 4. Click Close to close the dialog, or click Retry Failed to retry uploading any Battlespaces that 
failed to upload.

The Battlespaces are uploaded to the VBS World Server.

  NOTE 
Battlespaces on, or downloaded to your computer are stored in the Battlespaces Folder 
(on page 83).

© 2023 - Bohemia Interactive Simulations - All Rights Reserved - 72 -



6. Battlespace Management VBS4 23.2.0

6.3.2 AAR Synchronization
You can synchronize AAR Recordings between your local computer and the VBS World Server.

AAR Recordings are saved on the VBS4 Admin Client that performs the save action in VBS Editor, 
and can be uploaded to the VBS World Server, which allows other VBS4 Clients connected to the 
VBS World Server to download them.

Follow these steps:

 1. Click a Battlespace in the Battlespaces List, so that it is highlighted.

The corresponding Battlespace Functions Panel opens.

 2. Expand Assess, and do one of the following:

 l AAR Upload - The AAR Recording is not on the VBS World Server. Click Upload to upload it 
to the VBS World Server.

 l AAR Download - The AAR Recording is on the VBS World Server, but not available locally. 
Click Download to download it to your computer.

6.4 Edit Battlespace Details
Select a Battlespace to view and modify its details.

Follow these steps:

 1. Click a Battlespace in the Battlespaces List, so that it is highlighted.

The corresponding Battlespace Functions Panel opens.
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 2. Click the Edit icon at the top of the dialog.

The Edit Battlespace dialog opens.

  NOTE 
To modify Max Players (the number of playable characters in the Scenario), use VBS 
Editor (see Open in Editor (on page 67)) to add playable entities.

If the Scenario has no playable entities, Max Players is not listed in Battlespace 
Details.

 3. Modify the Name and Description as required.

  NOTE 
Latitude, Longitude cannot be changed.

 4. Click the Color Box to change the color of the Battlespace Marker in the Whole-Earth Terrain.

 5. Add Tags to add labels for Battlespace filtering:

 l Input a Tag name and press Comma, Enter, or Tab. Continue typing to create another one.

 l To remove a Tag, click X.
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 6. Optional: Select Available as a Singleplayer Training Mission to make the Battlespace 
available to Trainees in the Training tab.

Optional: Add an overview image to a Singleplayer Training Mission.

 a. Create an overview JPEG image called overview_image.jpg.

  WARNING 
The overview image file must be in JPEG format, and cannot have any other name.

 b. Place the overview image in:

\Documents\VBS4\Battlespaces\Battlespace_Name\Missions\Scenario_Name\

 c. Click the Refresh Battlespaces Icon.

The overview image appears in the Training Details of the Singleplayer Training Mission in the 
Training tab.

For more information, see Single Player Training in the VBS4 Trainee Manual.
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  NOTE 
Scenarios require a playable unit before they can be Executed from the Singleplayer 
Battlespace list.

 7. Click Save Changes.

VBS4 updates the Battlespace and updates the Author to display the last user to modify the 
Battlespace.

  TIP 
You can change the name of a local Battlespace by directly modifying the following:

 l The Battlespace folder name:

\Documents\VBS4\Battlespaces\name\

 l The Mission folder name:

\Documents\VBS4\Battlespaces\name\Missions\name\

 l The following elements in the battlespace.json file at:

\Documents\VBS4\Battlespaces\name\battlespace.json

 o "id" : "name"

 o "displayName" : "name"

Make sure that every instance of the Battlespace name is identical.

6.5 Delete Battlespaces
Deleting a Battlespace removes the Battlespace, and all items associated with it, from VBS4.

The following is discussed:

 l Battlespace Deletion (on the next page)

 l AAR Deletion (on page 78)
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6.5.1 Battlespace Deletion
This section describes how to delete a Battlespace, and what happens when a Battlespace is 
deleted.

  WARNING 
The following Battlespace deletion considerations apply:

 l If you delete a Battlespace, and are connected to the VBS World Server, you can 
optionally delete the Battlespace from the VBS World Server as well.

 l If you manually modify the \WS_Installation\data\Battlespaces\ folder by 
copying, deleting, or renaming Battlespaces, then you must also delete the following 
folder:

\WS_Installation\Services\VBS4\cache\

Not deleting the \cache\ folder may significantly affect VBS World Server 
performance.

 l If the Battlespace (or its copy) is stored on a Dedicated Server, it has to be deleted 
manually on the Dedicated Server computer from:

\Documents\VBS4\Battlespaces\Battlespace_Name\ 

Follow these steps:

 1. Click a Battlespace in the Battlespaces List, so that it is highlighted.

The corresponding Battlespace Functions Panel opens.
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 2. Click the Trash Icon at the top of the dialog.

The Delete Battlespace dialog opens.

 3. If connected to a VBS World Server, where a copy of the Battlespace is also present, optionally 
select Also delete this battlespace on VBS World Server to delete that copy of the 
Battlespace as well.

 4. Click Delete.

VBS4 removes the Battlespace from the Battlespaces List, and removes the Battlespace Marker 
from the Whole-Earth Terrain.

6.5.2 AAR Deletion
This section describes how to delete an AAR Recording of a Battlespace, and what happens when 
the AAR Recording is deleted.

Follow these steps:

 1. Click a Battlespace in the Battlespaces List, so that it is highlighted.

The corresponding Battlespace Functions Panel opens.

 2. Expand Assess and highlight the AAR Recording you want to delete.
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 3. Click the Trash Icon to delete the AAR Recording.

If your VBS4 Admin Client is not connected to the VBS World Server, the following is displayed:

If your VBS4 Admin Client is connected to the VBS World Server and the AAR Recording is 
present locally on your VBS4 Admin Client, the following is displayed:

If your VBS4 Admin Client is connected to the VBS World Server and the AAR Recording is only 
stored on the VBS World Server, the following is displayed:

  WARNING 
The following AAR Recording deletion considerations apply:

 l When deleting the AAR Recording from an VBS4 Admin Client  while connected to 
the VBS World Server, a prompt appears to optionally delete the AAR Recording on 
the VBS World Server as well.

 l When deleting the AAR Recording from an VBS4 Admin Client  while not connected 
to the VBS World Server, the deletion only occurs on the VBS4 Admin Client.
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6.6 Filter Battlespaces
Filter Battlespaces to narrow down the options in the Battlespaces List.

Follow these steps:

 1. Click the Filter Icon.

The filter dialog opens.
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 2. Use the following filters:

1 Search field that allows you to search for specific Battlespaces that meet the search criteria, 
based on partial name and Tag (see Create Battlespaces (on page 60)). Multiple tags can be 
separated by commas.

2 The following filters options are available:
 l A - Z - Click to sort the Battlespaces in ascending / descending alphabetical order.
 l Last modified - Click to display only the last modified Battlespaces.
 l Modified by me - Check to display the Battlespaces modified by you in ascending / 

descending modification timestamp order.
 l Singleplayer - Check to display the Battlespaces that, apart from Multiplayer, are also 

available in Singleplayer.
For more information, see Single Player Training in the VBS4 Trainee Manual.

 l VWS Battlespaces - Check to the display the Battlespaces that are available on the 
VBS World Server, when connected to it.

 l Local Battlespaces - Check to display the Battlespaces that are not available on the 
VBS World Server, when connected to it. These Battlespaces are only found on your local 
computer.

 l Out of Sync - Check to display the Battlespaces that need uploading to the VBS World 
Server, when connected to it. These Battlespaces are either missing on the VBS World 
Server or have a version of the Battlespace which is missing on the VBS World Server.
For more information, see Synchronize Battlespaces (on page 68).

3 Available Battlespaces Tags.
Click a Tag to display all the Battlespaces that have it.

  TIP 
Click multiple Tags to add them to the Search field, separated by commas.

  NOTE 
When any of the filters are used, the Filter Icon changes to orange.
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6.7 Search Battlespaces
Search for a Battlespace, using the Search Bar in the VBS4 Toolbar.

Follow these steps:

 1. Go to the Search Bar.

 2. Enter the name of the Battlespace you are looking for (partial word search is possible).

The results are displayed in a drop-down list in the following order:

 l Battlespaces

 l POIs

 l VBS World Server Data (if you are connected to the VBS World Server.)

 l Google Maps locations (if you are not connected to the VBS World Server, but are on-line.)

 3. Click a Battlespace in the list.

VBS4 finds the location, and moves to it in the Whole-Earth Terrain. In addition, the selected 
Battlespace is highlighted in the Battlespaces List.
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6.8 Battlespaces Folder
In VBS4, all files associated with a Battlespace are stored locally and, when connected, can be 
uploaded to the VBS World Server for ease of access to all connected clients.

When a Battlespace is created, VBS4 creates a local Battlespace folder in your default Windows 
\Documents\ folder:

\Documents\VBS4\Battlespaces\Battlespace_Name\

This folder contains a battlespace.json file containing the Battlespace details specified during 
Create Battlespaces (on page 60) and updates this file whenever an Administrator wants to Edit 
Battlespace Details (on page 73).

Whenever a VBS4 Admin Client saves a Battlespace during Prepare Mode, VBS4 creates the 
following folder structure:

\Battlespace_Name\

 l Geo\

Contains the terrain edits from VBS Geo as a Geo Project file, geoproject.geo.

 l Missions\

 o Scenario_Name\

Contains the Scenario edits from VBS Plan and VBS Editor, optional customization of the 
map layers (see Custom Map Layers in the VBS4 Editor Manual), and an optional Scenario 
overview JPEG image for Single Player Training (see the VBS4 Trainee Manual), in a 
specific Scenario folder.

  NOTE 
In this release, each Battlespace only contains one Scenario, and Scenario_Name 
is the same as Battlespace_Name.

 l briefings\

Contains Mission Briefings and a \data\ folder, which contains images / PDF files 
related to the Mission Briefings. For more information, see Edit the Mission Briefing in 
the VBS4 Editor Manual. 

If you are connected to VBS World Server and upload a Battlespace, it also creates a Battlespace 
folder on the VBS World Server:

\WS_Installation\data\Battlespaces\Battlespace_Name\
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  WARNING 
The following Battlespace deletion considerations apply:

 l If you delete a Battlespace, and are connected to the VBS World Server, you can 
optionally delete the Battlespace from the VBS World Server as well.

 l If you manually modify the \WS_Installation\data\Battlespaces\ folder by 
copying, deleting, or renaming Battlespaces, then you must also delete the following 
folder:

\WS_Installation\Services\VBS4\cache\

Not deleting the \cache\ folder may significantly affect VBS World Server 
performance.

 l If the Battlespace (or its copy) is stored on a Dedicated Server, it has to be deleted 
manually on the Dedicated Server computer from:

\Documents\VBS4\Battlespaces\Battlespace_Name\ 

During Scenario Execution, if an Instructor records and saves an After Action Review, VBS4 creates 
the following folder structure on the VBS World Server or Dedicated Server running the Scenario:

\Battlespace_Name\

 l AAR\

 o timestamp.AAR_Name\

This folder contains the same structure as the local folder and also stores AAR Recordings made 
while connected to a VBS World Server.

The Battlespaces and AAR recordings on a connected VBS World Server are available to all 
connected VBS4 Admin Clients for Scenario Preparation (on the next page), Scenario Execution 
(on page 89), and Scenario Assessment (on page 101).

VBS4 enables you to synchronize local and VBS World Server copies of the same Battlespace. For 
more information, see Synchronize Battlespaces (on page 68). 
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7. Scenario Preparation
The primary VBS4 use case is the creation of engaging and realistic training Scenarios.

Create a Battlespace, and use VBS Geo, VBS Plan, and VBS Editor to create your Scenario.

Follow these steps:

 1. Use VBS Launcher to start a VBS4 Client as an Administrator in either Online or Offline mode.

In the VBS4 > Client tab, select  the VBS4 Configuration to use:

 l VBS4 Online

Starts VBS4 Clients and Dedicated Servers connected to a VBS World Server hosting the 
Whole-Earth Terrain and providing access to stored Battlespaces.

Click Refresh, and select or input the IP Address of a VBS World Server.

 l VBS4 Offline

Starts VBS4 Clients without a connection to a VBS World Server.

  WARNING 
Do not select or input the Server IP Address to connect to a Dedicated Server.

 l Select admin.

 2. To enable additional options for Scenario Preparation, select the following in VBS Launcher:

Server > gateway (-gateway)

Enables the Tools > Gateway GUI options to configure VBS Gateway and Entity Mapping.

For more information, see Launching VBS Gateway in the VBS Gateway Manual.

For more information, see Starting VBS4 in the VBS4 Administrator Manual.

 3. Click Launch Modules.

VBS4 starts in Battlespaces mode.

 4. Create a Battlespace in the Whole-Earth Terrain:

 a. Select the Battlespaces tab, and in the Battlespaces List, click + New Battlespace.

 b. Use the Orbit Camera Controls to navigate the globe and click the required location.

 c. Input the Battlespace details and click Save Changes.

VBS4 adds the new Battlespace to the Battlespaces List, ready for Scenario Preparation.

For more information, see Create Battlespaces (on page 60).
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 5. Select your Battlespace in the Battlespaces List and use any of the Prepare functions in the 
Battlespace Functions Panel:

 l Highlight Geo and click Create to use VBS Geo to modify the terrain for your Scenario.

For details about editing the terrain, see VBS Geo Overview in the VBS Geo Manual.

 l Highlight Plan and click Create to use VBS Plan to quickly populate your Scenario with 
ORBATs and define Tactical Plans.

For details about creating Plans, see VBS Plan Overview in the VBS Plan Manual.

 l Highlight Editor and click Create to use VBS Editor to perform individual entity and detail 
level modifications in your Scenario.

For details about creating missions, see VBS Editor Overview in the VBS4 Editor Manual.

  NOTE 
VBS4 opens the local copy of the Battlespace. To use a Battlespace saved on 
VBS World Server, synchronize it first. For more information, see Synchronize 
Battlespaces (on page 68).

The VBS4 UI switches to Prepare Mode, opens the selected Tool, and displays the Tool 
Selection (on page 37) options in the VBS4 Toolbar.

Click Plan, Editor, or Geo in the VBS4 Toolbar to switch seamlessly between the VBS4 Tools in 
Prepare Mode.

  WARNING 
VBS4 requires a playable character in the Scenario to enable Preview and Scenario 
Execution.

Do one of the following:

 l Add a playable character in VBS Editor.

For more information, see Adding Units in the VBS4 Editor Manual.

 l Specify a playable unit in VBS Plan and click Build Mission.

For more information, see Tactical Unit Tool and Build Missions in the VBS Plan 
Manual.

 6. To setup VBS Radio as part of your Scenario:

 l Select Editor and Tools > Radio Admin to configure the Channels, Radio Types, and 
Assignments.

For more information, see Setting Up VBS Radio in the VBS Radio Manual.
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 7. To configure entity mapping for interoperable exercises with DIS / HLA compliant simulation 
products:

 l Select Editor and Tools > Show Gateway GUI to open the VBS Gateway UI.

For more information, see VBS Gateway UI in the VBS Gateway Manual.

 8. To configure IG View Objects to broadcast viewpoints to VBS Blue IG, see Add IG Viewpoints 
to Scenarios in the VBS4 Editor Manual.

 9. To preview your mission, click the Preview button in the VBS4 Toolbar of any of the Tools.

The Scenario starts as a playable mission with you controlling the first playable character 
placed in the Scenario.

 l Play the Scenario as a Trainee to preview the Scenario in action.

For information about controlling your character, see   the VBS4 Trainee Manual.

 l Modify the Scenario as an Instructor to play test various aspects of the Scenario.

Press Map (M) or Pause (Esc), and select Editor to open VBS Editor in Preview Mode.

Preview Mode provides the majority of the same VBS Editor functions as Execute Mode.

For more information, see Instructor Interface in the VBS4 Instructor Manual.

  NOTE 
Any changes made to the Scenario during the Preview only persist for the duration 
of the Preview and are not saved as part of the Battlespace.

 l Restart the Scenario as an Instructor.

Press Pause (Esc) and in the Main Menu in the VBS4 Toolbar, select Restart Battlespace.

 l Return to the Editor UI in Prepare Mode to continue editing the Scenario.

Press Pause (Esc) and in the Main Menu in the VBS4 Toolbar, select End Battlespace.

 l Open the Config Browser.

Press Pause (Esc) and in the Main Menu in the VBS4 Toolbar, select Config Browser.
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 10. To save your Scenario, click the Main Menu in the VBS4 Toolbar, and under Battlespaces 
select one of the following options:

 l Save - Saves changes into the currently open Battlespace.

 l Save As - Creates a new Battlespace, or overwrites the existing one, based on the name 
you enter in the dialog.

VBS4 saves the Battlespace locally, creating and updating the files described in Battlespaces 
Folder (on page 83).

When you are connected to VBS World Server, you are given the option to upload the Battlespace 
to the VBS World Server. For more information see Synchronize Battlespaces (on page 68).

A scenario saved to VBS World Server is available for use on all connected Clients:

 l Modify the Scenario using the same process described in this topic.

 l Execute the Scenario as described in Scenario Execution in the VBS4 Instructor Manual.

  WARNING 
Current Limitations

In this release of VBS4, the following limitations apply during Scenario Preparation:

 l Avoid editing the same Battlespace on two separate Clients at the same time.

Scenario Preparation takes place using a local copy of the Battlespace files. 
Synchronizing Battlespaces uploads those edits to the VBS World Server. If two 
Administrators edit a Battlespace at the same time, the first to upload is overwritten by 
the second.

 l Do not edit the terrain Geo Project for a Battlespace if there are After Action Review 
recordings for it.

Each Battlespace only supports a single Geo Project which is loaded during Scenario 
Execution and Scenario Assessment. Editing the terrain with VBS Geo after Scenario 
Execution may invalidate the AAR recording, for example by changing a flat area into a 
hill. The AAR package replays the movements and events that occurred when the 
terrain was flat, but during Playback, the hill is rendered as part of the terrain.

For a demonstration of a simple Scenario, see the VBS4 Instructor Series - CQB Squad Training 
and video at https://youtu.be/JcnJseLQ8zs.

  NOTE 
The videos may not be up to date with the features they demonstrate, the latest state of 
which is described in this manual.
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8. Scenario Execution
The most important VBS4 use case is the operation and administration of multiplayer training 
during Scenario Execution.

Start a scenario and use the VBS Editor to monitor the Trainees, manage the scenario, and insert 
simulation objects, hazards, and events.

VBS4 provides alternate Dedicated Server and Hosted Scenario Execution workflows:

 l Dedicated Server Scenario Execution (below)

 l VBS4 Client Hosted Scenario Execution (on page 95)

Trainees and additional Administrators join the scenario:

 l Connecting Trainee Clients (on page 98)

Once the scenario starts, Instructors manage the scenario using VBS Editor in Execute Mode:

 l Managing the Scenario (on page 99)

8.1 Dedicated Server Scenario Execution
The Dedicated Server Workflow enables VBS4 to host a scenario using a VBS4 installation running 
as a Dedicated Server. The Admin and Trainee Clients connect to the Dedicated Server that hosts 
the scenario.

Use VBS Launcher to start VBS4 on the Dedicated Server in either Online or Offline mode.

  WARNING 
All VBS4 Clients, Dedicated Servers, and Simulation Clients that participate in the Scenario 
Execution must use the same Configuration option:

 l Online: When a VBS World Server is required, all computers must use the Online option 
connected to the same VBS World Server (-worldServer=VWS_ipaddress_or_
dnsname)

 l Offline: When a VBS World Server is not required, all computers must use the Offline 
option (-worldServer not specified).

Follow this process:

 1. Start the Dedicated Server (on the next page)

 2. Optional: Start Simulation Clients (on page 91)

 3. Start an Admin Client (on page 92)
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 4. Start the Battlespace (on page 93)

 5. Connect the Trainees and Start the Scenario (on page 94)

8.1.1 Start the Dedicated Server
The Dedicated Server acts as the simulation host.

Follow these steps:

 1. In the VBS4 > Server tab, select the VBS4 Configuration to use:

 l VBS4 Online Dedicated Server

Starts VBS4 as a Dedicated Server to act as the simulation host and with a connection to 
VBS World Server that streams terrain data to all connected clients and provides access 
to stored Battlespaces.

 l VBS4 Offline Dedicated Server

Starts VBS4 as a Dedicated Server to act as the simulation host without a connection to 
VBS World Server. The Dedicated Server provides the terrain data.

  TIP 
The Dedicated Server Preset in VBS Launcher sets the following default options for a 
Server configuration: 

-server

For more information, see Launching with Presets in the VBS4 Administrator Manual.

 2. Optional: To enable or disable additional Editor options for Scenario Execution, select the 
following options in VBS Launcher:

 l Server > gateway (-gateway) 

Enables the Tools > Gateway GUI options, on connected VBS4 Admin Clients, to manage 
VBS Gateway and Entity Mapping during a Scenario.

For more information, see Launching VBS Gateway in the VBS Gateway Manual.

 l Server > vbsHostNet (-vbsHostNet)

Enables the viewpoints configured by IG View Objects to be broadcast to VBS Blue IG.

For more information, see Quick Start: VBS Blue IG with VBS4 Host in the VBS4 
Administrator Manual.
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 3. Click Launch Modules.

  NOTE 
If you require Clients to connect from outside the local network, disable multicast (-
multicast=0) on the Host computer.

VBS4 starts as a Dedicated Server to host the Scenario.

For more information, see Dedicated Server in the VBS4 Administrator Manual.

8.1.2 Start Simulation Clients
For more demanding Scenarios with larger numbers of connected Clients, use VBS Launcher to 
start additional Simulation Clients on separate computers

Follow these steps:

 1. In the VBS4 > Client tab, select  the VBS4 Configuration to use:

 l VBS4 Online

Starts VBS4 Clients and Dedicated Servers connected to a VBS World Server hosting the 
Whole-Earth Terrain and providing access to stored Battlespaces.

Click Refresh, and select or input the IP Address of a VBS World Server.

 l VBS4 Offline

Starts VBS4 Clients without a connection to a VBS World Server.

 2. Input the Server IP of the Dedicated Server that hosts the Scenario.

 3. Select the -simulationClient option and use the drop-down to select the Simulation Client 
type:

 l 0 (Simulation Client) - Handles the simulation of units, vehicles and network objects.

 l 1 (AAR Client) - Handles the simulation for AAR recording.

 l 2 (Simulation + AAR Client) - Handles both. 

 4. Click Launch Modules.

VBS4 starts as a Simulation Client to handle the simulation workload instead of the Dedicated 
Server.

For more information, see Simulation Clients in the VBS4 Administrator Manual.
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8.1.3 Start an Admin Client
Use VBS Launcher to start a VBS4 Client as an Administrator in either Online or Offline mode.

Follow these steps:

 1. In the VBS4 > Client tab, select the VBS4 Configuration to use:

 l VBS4 Online

Starts VBS4 Clients and Dedicated Servers connected to a VBS World Server hosting the 
Whole-Earth Terrain and providing access to stored Battlespaces.

Click Refresh, and select or input the IP Address of a VBS World Server.

 l VBS4 Offline

Starts VBS4 Clients without a connection to VBS World Server.

 2. Input the ServerIP using the IP address or DNS name of the computer hosting the Scenario (-
connect=host_IP_address_or_DNS_name).

VBS4 starts and opens the Multiplayer Battlespaces panel in step 3 of Start the Battlespace 
(on the next page).

  TIP 
Leave the Server IP blank to connect later.

VBS4 starts in the Main Menu. Use the Training tab Connect to Server option to start 
the Scenario as described in step 1 of of Start the Battlespace (on the next page).

 3. Select admin.

 4. Click Launch Modules.

VBS4 starts as an Admin Client to manage Scenario Execution.

The Administrator that starts the Scenario Execution on the Dedicated Server is the Server Admin 
with additional control over the scenarios.

For more information, see:

 l Server Management in the VBS4 Instructor Manual.

 l Server Administration Commands in the VBS4 Administrator Manual.

Secondary Admins that join a Scenario Execution do not have these privileges but can assume 
Server Admin control using the Server Management Become Server Admin option.
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8.1.4 Start the Battlespace
The Administrator starts the Battlespace from the Training tab of VBS4.

  WARNING 
When you Execute a Scenario, you select whether to use the version on the VBS World 
Server, the local VBS4 Admin Client, or the Dedicated Server. To ensure that all computers 
participating in the Scenario use the same version of the Battlespace, VBS4 automatically 
copies the selected version as follows:

 l If the VBS World Server version is used, it downloads to the VBS4 Admin Client and 
uploads to the Dedicated Server, overwriting any versions on those computers.

 l If the local VBS4 Admin Client version is used, it uploads to the Dedicated Server, 
overwriting the version on that computer. The VBS World Server version is not 
affected.

 l If the Dedicated Server version is used, no overwriting occurs and the VBS World 
Server and VBS4 Admin Client versions are not affected.

 l When VBS4 Trainee and Admins Clients join a running Scenario they download a 
temporary copy of the Battlespace from the Dedicated Server and any locally stored 
versions of the Battlespace are not affected.

Before any Battlespaces are overwritten, a prompt appears to notify the Administrator with 
an option to cancel.

Follow these steps:

 1. If the Server IP was not specified, on the VBS4 Admin Client, select the Training tab, and click 
Connect to Server.

The Multiplayer Servers panel opens, displaying the Dedicated Servers, which includes their 
DNS names (Server) and IP addresses (IP Address),  available on the network.

 2. Select the Dedicated Server that hosts the Scenario, and click Connect.

  NOTE 
The localhost option is available in the Dedicated Server list to host the Scenario on 
your VBS4 Client instead of a Dedicated Server.

© 2023 - Bohemia Interactive Simulations - All Rights Reserved - 93 -



8. Scenario Execution VBS4 23.2.0

  TIP 
If the computer is not listed, click Manual to input the specific IP Address, or DNS 
name, and Port of the computer hosting the Scenario.

The Multiplayer Battlespaces panel opens displaying the Battlespaces available to execute.

 3. The Multiplayer Battlespaces panel displays all the Battlespaces available to execute:

 l Battlespaces stored locally on your VBS4 Client

 l Battlespaces previously uploaded to the Dedicated Server.

 l Battlespaces stored on a connected VBS World Server.

  TIP 
Use the Stored on checkboxes to only display the Battlespaces on the selected 
computers.

Select the Battlespace to execute, and click OK.

VBS4 opens the Network Lobby.

8.1.5 Connect the Trainees and Start the Scenario
Connect the Trainees to the Battlespace and use the Network Lobby to assign roles in the 
Scenario.

Follow these steps:

 1. Start VBS4 on the Trainee Clients.

See Connecting Trainee Clients (on page 98).
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 2. In the Network Lobby, do the following:

 a. Select your own character, and allow Trainees and additional Instructors to select their 
characters, or assign characters to them.

 b. Optional: To automatically record an After Action Review as soon as the Scenario begins 
to execute, select Record AAR.

 c. Optional: To skip the Mission Briefing, select Skip Briefing.

 d. Click OK.

 3. Allow all Trainees to review the Mission Briefing, and then click OK to start the Scenario.

  NOTE 
The Mission Briefing is not shown if Skip Briefing is selected in the Network Lobby.

All connected Trainees and Instructors are taken into the Scenario with a first-person view from 
their character. For information about using your character, see VBS4 Trainee Overview in the 
VBS4 Trainee Manual.

8.2 VBS4 Client Hosted Scenario Execution
A VBS4 Admin Client can Host a Scenario for a small number of connected Trainee Clients without 
needing a separate Dedicated Server.

The Client Hosted workflow enables a VBS4 Client to prepare and execute a scenario in the same 
session without needing to restart VBS4. The Trainee Clients connect to the VBS4 Admin Client 
instead of a Dedicated Server.

  WARNING 
A Scenario Execution hosted on a VBS4 Client runs the copy of the Battlespace stored on 
local computer. If you have prepared the scenario online, ensure that it is synchronized. For 
more information, see Synchronize Battlespaces (on page 68).

Use VBS Launcher to start a VBS4 Client as an Administrator in either Online or Offline mode.

© 2023 - Bohemia Interactive Simulations - All Rights Reserved - 95 -



8. Scenario Execution VBS4 23.2.0

Follow these steps:

 1. In the VBS4 > Client tab, select  the VBS4 Configuration to use:

 l VBS4 Online

Starts VBS4 Clients and Dedicated Servers connected to a VBS World Server hosting the 
Whole-Earth Terrain and providing access to stored Battlespaces.

Click Refresh, and select or input the IP Address of a VBS World Server.

 l VBS4 Offline

Starts VBS4 Clients without a connection to a VBS World Server.

  WARNING 
Do not select or input the Server IP Address to connect to a Dedicated Server.

 2. Optional: To enable additional Editor options during Scenario Execution, select the following 
options in VBS Launcher:

 l Server > gateway (-gateway) 

Enables the Tools > Gateway GUI options, on connected VBS4 Admin Clients, to manage 
VBS Gateway and Entity Mapping during a Scenario.

For more information, see Launching VBS Gateway in the VBS Gateway Manual.

 l Server > vbsHostNet (-vbsHostNet)

Enables the viewpoints configured by IG View Objects to be broadcast to VBS Blue IG.

For more information, see Quick Start: VBS Blue IG with VBS4 Host in the VBS4 
Administrator Manual.

 3. Click Launch Modules.

  NOTE 
If you require Clients to connect from outside the local network, disable multicast (-
multicast=0) on the Host computer.

 4. On the VBS4 Admin Client, do one of the following to Execute the Scenario:

 l Select your Battlespace in the Battlespaces List, and click Host in the Execute section of 
the Battlespace Functions Panel.

 l Right-click the Battlespace icon in the Whole-Earth Terrain and select Host.

VBS4 opens the Network Lobby.

All connected Trainee Clients are also taken to the Network Lobby to join the Scenario. For 
more information, see Joining a Multi-Player Scenario in the VBS4 Trainee Manual.
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 5. Start VBS4 on the Trainee Clients.

See Connecting Trainee Clients (on the next page).

 6. In the Network Lobby, do the following:

 a. Select your own character, and allow Trainees to select their characters, or assign 
characters to them.

 b. Optional: To automatically record an After Action Review as soon as the Scenario begins 
to execute, select Record AAR.

 c. Optional: To skip the Mission Briefing, select Skip Briefing.

 d. Click OK.

 7. Allow all Trainees to review the Mission Briefing, and then click OK to start the Scenario.

  NOTE 
Mission Briefing is skipped, if Skip Briefing is selected in the Network Lobby.

All connected Trainees and Instructors are taken into the Scenario with a first-person view from 
their character. For information about using your character, see VBS4 Trainee Overview in the 
VBS4 Trainee Manual.
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8.3 Connecting Trainee Clients
On VBS4 Trainee Clients, and additional Admin Clients, use VBS Launcher to join the Scenario.

  WARNING 
All VBS4 Clients, Dedicated Servers, and Simulation Clients that participate in the Scenario 
Execution must use the same Configuration option:

 l Online: When a VBS World Server is required, all computers must use the Online option 
connected to the same VBS World Server (-worldServer=VWS_ipaddress_or_
dnsname)

 l Offline: When a VBS World Server is not required, all computers must use the Offline 
option (-worldServer not specified).

Follow these steps:

 1. Start VBS4 on the VBS4 Trainee Clients and additional Admin Clients in either Online or Offline 
mode:

In the VBS4 > Client tab, select the VBS4 Configuration to use:

 l VBS4 Online

Starts VBS4 Clients and Dedicated Servers connected to a VBS World Server hosting the 
Whole-Earth Terrain and providing access to stored Battlespaces.

Click Refresh, and select or input the IP Address of a VBS World Server.

 l VBS4 Offline

Starts VBS4 Clients without a connection to VBS World Server.

 2. Do one of the following:

 l To connect directly to the Host or Dedicated Server, input the Server IP using the IP 
address or DNS name of the computer hosting the Scenario (-connect=host_IP_
address_or_DNS_name).

VBS4 starts and Trainees wait in the VBS4 Lobby until the Scenario starts.

 l Leave the Server IP blank to connect later.

VBS4 starts in the Training Menu and Trainees use the Connect to Server option to join 
the Scenario.

 3. Click Launch Modules.

  WARNING 
Do not select admin on VBS4 Trainee Clients.
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VBS4 starts as a Trainee Client for participation in Scenarios.

For more information, see Joining a Multi-Player Scenario in the VBS4 Trainee Manual.

8.4 Managing the Scenario
As an Instructor with Administration access, use VBS Editor to manage the scenario:

 l Press Pause (Esc) to access the VBS4 Toolbar, and select Editor.

VBS Editor opens in Execute Mode providing access to Scenario Execution functions.

The VBS4 Instructor Manual splits Scenario Execution functions into the following categories:

 l Mission Scenario Administration

Perform overall Scenario Management functions, such as recording an After Action Review.

 l Mission Scenario Monitoring

Monitor and visualize specific aspects of a Scenario Execution.

 l Event Management

Use specific VBS4 functionality to insert events or to provide functions such as fire support.

 l Entity Management

Use specific context actions to micro-manage individual entities in the Scenario, such as 
Revive Unit.

  NOTE 
The VBS4 Instructor Manual focuses only on specific functionality that is only available in 
Execute Mode.

The majority of the Prepare Mode functionality of VBS Editor and VBS Plan is also available 
for use in Execute Mode. For more information, see:

 l VBS Plan Overview in the VBS Plan Manual.

 l VBS Editor Overview in the VBS4 Editor Manual.

Specific monitoring options are available for VBS Radio and interoperable simulation using VBS 
Gateway:

 l Monitoring VBS Radio

 l Monitoring with VBS Gateway

For more information, see the topics  in the VBS4 Instructor Manual.

Use the Main Menu > Server Management options to end or switch Battlespaces:
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 l Change Battlespace

The Scenario stops and  the Server Admin returns to the Multiplayer Battlespaces panel to 
select a new Scenario to execute.

 l End Battlespace

Scenario Execution ends, and all Admins and Trainees are returned to the Network Lobby.
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9. Scenario Assessment
One of the primary VBS4 use cases is the recording, playback, and review of training scenarios.

Use VBS4 to record and review your training scenarios with playback control over viewpoints, 
overlays, and event review to enable full evaluation of trainee behavior.

During Scenario Execution, the Instructor can record the Scenario as described in Recording 
Scenarios for AAR in the VBS4 Instructor Manual.

These After Action Review (AAR) recordings are saved on the VBS4 Admin Client, and can be 
uploaded to the VBS World Server to provide access on all connected Clients. For more 
information, see Synchronize Battlespaces (on page 68).

Follow these steps:

 1. Start VBS4 as an Administrator in either Online or Offline mode.

In the VBS4 > Client tab, select the VBS4 Configuration to use:

 l VBS4 Online

Starts VBS4 Clients and Dedicated Servers connected to a VBS World Server hosting the 
Whole-Earth Terrain and providing access to stored Battlespaces.

Click Refresh, and select or input the IP Address of a VBS World Server.

 l VBS4 Offline

Starts VBS4 Clients without a connection to a VBS World Server.

  WARNING 
Do not select or input the Server IP Address to connect to a Dedicated Server.

 l Select admin.

 l If you plan to use AAR Streaming, do not disable VBS Radio (-disableVBSRadio).

  NOTE 
If you require Clients to connect from outside the local network, disable multicast (-
multicast=0) on the Host computer.

For more information, see Starting VBS4 in the VBS4 Administrator Manual.
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 2. Select the Battlespace in the Battlespaces List:

 l Online - The Assess section of the Battlespace Functions Panel displays the 
AAR recordings saved on your VBS4 Client and on the VBS World Server. Click Download 
to copy an AAR recording from VBS World Server to your VBS4 Client.

 l Offline - The Assess section of the Battlespace Functions Panel displays the 
AAR recordings saved on your VBS4 Client.

 3. Highlight the recording to playback, and select Open.

The AAR UI opens.

Use the AAR UI controls to perform the following actions described in the VBS4 AAR Manual:

 l To control the scenario playback, see AAR Playback and the User Interface.

 l To access VBS Plan recordings, see VBS Plan in AAR.

 l To access statistical data, see Event Log and Advanced Statistics.

 l To review Radio recordings, see VBS Radio Playback in AAR.

 l To review VBS Call for Fire recordings, see VBS Call for Fire in AAR.

 l To stream an AAR recording to Trainee computers, see .

  NOTE 
To delete an AAR Recording, highlight it in the Assess section of the Battlespace Functions 
Panel, and click the Trash icon.  If you are connected to the VBS World Server, the 
AAR Recording is deleted from there also.
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10. VBS Components and Products
VBS4 includes additional component functionality that enhances the Prepare - Execute - Assess 
workflow.

  TIP 
The use of these components is described in the applicable parts of the VBS4 Manuals 
based on their roles in the Prepare - Execute - Assess workflow, but for convenience, 
standalone documentation for these components is also available in:

 \VBS_Installation\docs\PDF\Components\

VBS Call for Fire

Enables Forward Observer (FO) units to practice the correct procedures and event sequences 
when requesting fire power.

For more information, see VBS Call for Fire Overview (on page 107).

VBS Control AI

Provides a set of AI behaviors with Computer Generated Forces (CGF)-like capabilities.

For more information, see VBS Control AI Overview (on page 135).

VBS Gateway

Provides a DIS / HLA link between VBS4 and other simulations for distributed training exercises.

For more information, see VBS Gateway Overview (on page 137).

VBS Host

Broadcast specified viewpoints to VBS Blue IG.

For more information, see VBS Host Overview (on page 140).

VBS Radio

Simulates radio and other communication within VBS4 and as part of larger cross-product 
integrations.

For more information, see VBS Radio Overview (on page 141).

VBS Mixed Reality

The mixed reality functionality allows trainees using VBS4 to interact with real equipment inside a 
synthetic scenario.

For more information, see Mixed Reality: Overview in the VBS4 Administrator Manual.

© 2023 - Bohemia Interactive Simulations - All Rights Reserved - 103 -



10. VBS Components and Products VBS4 23.2.0

Config Patch Builder

Enables users to modify model asset parameters and values, such as the maximum speed of a 
vehicle, and deploy them to VBS as .pbo patch files. Users require no in-depth understanding of 
configuration file writing, configuration syntax, or other technical knowledge to make updates and 
generate the .pbo files.

For more information, see Config Patch Builder in the VBS4 Administrator Manual.

10.1 VBS Bundle
VBS Bundle is a collection of additional features that are not available in baseline VBS4, but are 
available with additional licensing, to enhance its functionality.

VBS Close Air Support

VBS Close Air Support provides simulated Close Air Support (CAS) using VBS Plan.

CAS simulation involves coordination between the Instructor, who prepares and executes the CAS 
scenario, and the Joint Terminal Attack Controller (JTAC) Trainee (also known as Forward Air 
Controller (FAC)), who directs the aircraft through communication with the Instructor, typically 
using VBS Radio.

For more information, see VBS Close Air Support (on page 115).

VBS Radio Pro

Adds support for unlimited radio channels and types.

Configurable radio network presets, enabling users to customize channel names, colors, icons and 
enable saving and loading of radio networks per mission.

Radio degradation that can also be influenced by weather, distance and terrain obstruction.

Includes Radio Antennas and Jammers to provide realistic radio ranges and jamming capabilities.

For more information, see VBS Radio Overview (on page 141).

Overlay Sharing in VBS Plan

Overlay sharing allows users to share VBS Plan drawings to other VBS4 users on the network. This 
allows different planning cells to draw plan layers and submit them to create collaborative 
drawings quickly.

For more information, see Share Overlays - Network Collaboration in the VBS Plan Manual.

Microsoft Bing Terrain Data Support

Bing support allows customers to use their own Microsoft Bing API* key to stream Bing data into 
VBS4. This provides high detail Bing map satellite and 3D photogrammetry data that can be 
directly used in simulation.
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  NOTE 
The API key must be acquired directly from Microsoft.

For more information, see Starting VBS4 with Microsoft Bing Maps in the VBS4 Administrator 
Manual.

Config Patch Builder

Adds support for bulk modification of model asset parameters:

Export:

 l Export Filters - select filter criteria to specify values to export as a config patch or .csv file.

 l Full Cache - process the entire configuration as the source (for filtering values and export to
 .csv).

 l Export to CSV - export all or filtered values to a .csv file.

Batch Import - process .csv files and update config cache values (new values and new classes).

10.2 VBS4 Portfolio
The following products are also available for use alongside VBS4 as separate installations.

  FEATURE NOTICE 
Use of these products requires additional licensing. For more information, contact 
sales@bisimulations.com.

VBS Blue IG

The VBS Blue Image Generator (VBS Blue IG) provides high-fidelity visualizations of data from 
VBS4 and Common Image Generator Interface (CIGI) simulations. VBS Blue IG is a whole-earth 
rendering solution, eliminating the need to limit simulations to the confines of terrain databases. 
With this software, highly detailed insets can be combined with procedurally generated terrain and 
vegetation to simulate scenarios anywhere on earth.

For more information, see VBS Blue IG (on page 153).

VBS Simulation SDK and VBS IG SDK

Enables developers to customize and extend VBS4 and VBS Blue IG by providing an API and suite 
of tools.

For more information, see VBS Simulation SDK (on page 155).

VBS Developer Suite

Enables you to create custom models and configure their simulation behavior using proprietary 
and industry-standard tools.
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For more information, see VBS Developer Suite (on page 156) and the VBS Developer Reference 
documentation in the /docs/ folder of your VBS Developer Suite installation.

  FEATURE NOTICE 
VBS Developer Suite is included with VBS4 and VBS Blue IG licenses but is a separate 
installation.

VBS Radio Standalone

VBS Radio Standalone enables non-VBS4 users to communicate with VBS4 users participating in a 
VBS Radio scenario.

For more information, see VBS Radio Standalone (on page 147).
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10.3 VBS Call for Fire Overview
VBS Call for Fire provides a simulated Fire Direction Center (FDC) for VBS4 to setup and enable 
rapid fire support for Trainees acting as Forward Observers (FO).

VBS Call for Fire enables Forward Observer (FO) units to practice the correct procedures and event 
sequences when requesting fire power. The main training goals are:

 l Spotting targets and estimating their position, using standard VBS4 tools.

 l Communication with the FDC Operator.

 l Simple FDC operation to set up gunlines and enable the FDC Operator to provide the requested 
fire support.

  FEATURE NOTICE 
VBS Call for Fire is designed for specific doctrines, using specific units and equipment, and 
may not be suitable for all customer use cases.

To discuss potential new features or enhancements for VBS Call for Fire, please contact 
sales@bisimulations.com.

VBS Call for Fire is accessed through the VBS4 Editor, and provides the following functionality for 
Mission Designers and FDC Operators:

 l Simulated artillery ballistics with real-time and AAR visual trajectory monitoring.

 l Mortar and Howitzer gunlines, and vehicle / ship mounted guns with configurable timing 
events, caliber, loadout, layout, and dispersion / inaccuracy, including:

 o High Explosive, Smoke, and Illumination ammunition.

 o Ability to place and control up to ten gunlines simultaneously.

 o Minimal-effort with integration into VBS4 - Set up a gunline within 30 seconds of opening 
the VBS4 Editor.

  WARNING 
Placing vehicle and ship mounted weaponry when you Create Gunlines also adds the 
corresponding vehicle / ship model to the scenario. Therefore, it is not necessary to 
add vehicle and ship models separately.

 l Target worksheet allows pre-planned target reference points and mission targets.

© 2023 - Bohemia Interactive Simulations - All Rights Reserved - 107 -

mailto:sales@bisimulations.com


10. VBS Components and Products VBS4 23.2.0

 l Flexible mission creation:

 o Ability to see and create gunlines and fire missions specifically for BLUFOR or OPFOR 
sides.

 o Timed, proximity, impact, and delay fuses.

 o Targeting types: Polar, Grid, Shift, Recorded.

 o Common distribution patterns: Circle, Linear, Open, Range, Lateral, Range Lateral, Parallel, 
and Convergence.

 o Fine control over gun behavior:

 l Fire When Ready / At My Command

 l Fire With and Follow By

 l Check Fire

 l High / Low Trajectory

 o Adjust Fire behavior for mission adjustment.

 o Record Trainee reported information such as Target Description for review in After-Action 
Review (AAR).

 l Detailed statistical info in both the real-time exercises and AAR.

 o Trajectory, Vertex, and Target symbology.

 o Mission Report with Time of Flight, Gun-Target Line, Angle T, Range, and other ballistic 
and mission information.

 o Automatically generated Message To Observer.

 l The Fire Scheduling Plan makes it easy to pre-plan fire missions for automatic execution (see 
Fire Scheduling Plan in the VBS Call for Fire Manual).

There are three roles for successful CFF mission execution:

 l Scenario Designer

The Administrator / Instructor who creates a scenario, configures gunlines and their 
characteristics, and places them in the scenario.

 l Fire Direction Center (FDC) Operator

The Administrator or a Trainee who uses the FDC UI to configure gunlines / target coordinates, 
and instructs the guns to fire.
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 l Forward Observer (FO)

The infantry Trainee on the ground, who communicates with the FDC Operator to request fire 
missions. The FO passes target coordinates  to the FDC Operator using VBS Radio or other 
voice / text communication methods.

  NOTE 
The FO can be any BLUFOR or OPFOR unit with a URN Marking (required) added to 
their Object Properties dialog. Specialized FO units are not required.

10.3.1 VBS Call for Fire Workflow
The VBS Call for Fire workflow primarily uses the Fire Direction Center (FDC) in the VBS4 Editor:

Follow this process:

 1. Prepare a scenario in VBS4.

For more information, see VBS Call for Fire Scenario Preparation (on page 111).

 2. Start the Networked Mission and operate the FDC in the VBS4 Editor in Execute mode.

For more information, see VBS Call for Fire Scenario Execution (on page 114).

 3. Review Trainee performance.

For more information, see VBS Call for Fire in AAR in the VBS Call for Fire Manual.

During VBS Call for Fire Scenario Preparation (on page 111) and VBS Call for Fire Scenario 
Execution (on page 114) use the Fire Direction Center to manage VBS Call for Fire operations:

Follow this process:

 1. Access the FDC UI.

For more information, see VBS Call for Fire - FDC UI in the VBS Call for Fire Manual.

 2. Place gunlines on the map.

For more information, see Gunline Management in the VBS Call for Fire Manual.

 3. Place TRPs on the map.

For more information, see Target Management in the VBS Call for Fire Manual.

 4. Use the functions in the Fire Mission panel to create and manage fire missions.

For more information, see VBS Call for Fire Mission Management in the VBS Call for Fire 
Manual.

A tutorial is available, explaining how to set up and use VBS Call for Fire at 
https://www.youtube.com/watch?v=UJ_ZpObl42A.
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  NOTE 
The videos may not be up to date with the features they demonstrate, the latest state of 
which is described in this manual.
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10.3.2 VBS Call for Fire Scenario Preparation
Use the  Fire Direction Center to add gunlines and create targets and fire missions as an additional 
step in the typical process of creating scenarios for VBS4.

Use VBS Editor to create or edit a scenario, adding the personnel, vehicles, objectives, and hazards 
required for your training requirements.

Follow these steps:

 1. Start VBS4 as an Administrator and access the main VBS4 UI in Battlespaces Mode.

 2. Create a Battlespace in the Whole-Earth Terrain. See Battlespace Management in the 
Introduction to VBS4 Guide.

 3. Select your Battlespace in the Battlespaces List, and use Editor in the Battlespace Functions 
panel. Highlight Editor and click Create to use VBS Editor to perform individual entity and 
detailed level modifications in your scenario.

  NOTE 
For information about how to use the VBS Editor, see Mission Designer Interface in the 
VBS4 Editor Manual.

 4. Use the VBS Editor to modify the terrain, set the scenario conditions, and populate the 
scenario with all the personnel, vehicles, equipment, and objects required for your scenario, 
with the specific exception of the gunlines required for the scenario. For more information, see 
Mission Designer Interface in the VBS4 Editor Manual.

  WARNING 
If you intend to use vehicle / ship mounted weaponry, it is not necessary to add the 
corresponding vehicle / ship to the scenario, as this is done automatically when you 
Create Gunlines and select a Gun Type.

  NOTE 
CFF does not support the Advanced Ballistics setting in VBS4.
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 5. Use the Gunlines Details panel to add gunlines and targets to the scenario, and configure 
scheduled fire missions:

 a. Configure gunlines, and place them on the map, see Gunline Management in the VBS Call 
for Fire Manual.

 b. Create targets, and place them on the map, see Target Management in the VBS Call for 
Fire Manual.

 c. Configure scheduled fire missions, see VBS Call for Fire Mission Management in the VBS 
Call for Fire Manual.

 6. To preview your scenario press Scenario Preview (H) or click Preview.

The scenario starts  with you controlling the first playable character placed in the scenario.

 l Play the scenario as a Trainee to preview the scenario in action.

For information about controlling your character, see Character Control in the VBS4 
Trainee Manual.

 l Edit the scenario as an Administrator to play test different scenarios. Press Map (M), or 
press Pause (Esc) and select Editor, to open VBS Editor in Execute mode. For information 
about Execute mode in Call for Fire, see VBS Call for Fire Scenario Execution (on 
page 114).

  NOTE 
Any changes made to the scenario in VBS Editor only persist for the duration of 
the preview.

 l Return to Prepare mode to continue editing the scenario. Press Pause (Esc) and select 
End Battlespace.

 7. To save your scenario click the Main Menu in the VBS4 Toolbar, and under Battlespaces 
select one of the following options:

 l Save - Saves changes into the currently open Battlespace.

 l Save As - Creates a new Battlespace, or overwrites the existing one, based on the name 
you enter in the dialog.

A saved scenario is available for use:

 l Play the scenario as a single user from the Training Tab (must be saved as Available as 
Singleplayer Training Mission).

For information about controlling your character, see Character Control in the VBS4 Trainee 
Manual.
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 l Host the scenario as  the Administrator in Execute Mode from the Battlespaces List.

For information about Execute Mode for VBS Call for Fire, see VBS Call for Fire Scenario 
Execution (on the next page).

 l Use VBS Geo / VBS Plan / VBS Editor in Prepare Mode from the Battlespaces List to edit the 
scenario.

For information about VBS Editor, see Mission Designer Interface in the VBS4 Editor Manual.
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10.3.3 VBS Call for Fire Scenario Execution
The most important VBS Call for Fire (CFF) use case is the operation and administration of a 
multiplayer scenario during run-time.

As an Administrator / Instructor, start a Networked Multiplayer mission and then:

 l Use VBS Editor in Execute mode to monitor the simulation Trainees, manage the scenario, and 
insert simulation objects, hazards, and events.

 l Use VBS Call for Fire to create and manage gunlines, targets, and fire missions.

A typical Scenario Execution use case requires a Dedicated Server to host the mission with the 
Administrator operating an Admin Client on the same network. For more information, see 
Dedicated Server Scenario Execution (on page 89).

Follow these steps:

 1. Start all VBS4 Dedicated Servers and Clients as required for your Scenario. For more 
information see Scenario Execution (on page 89).

 2. In the Network Lobby, assign Trainees to characters, or allow them to select their own. When 
the playable characters you require for the session are assigned to Trainees, click OK.

The Scenario Starts and displays the Mission Briefing view.

  NOTE 
Most use cases require a playable entity for the Administrator, typically an invisible 
spectator object. For more information, see Spectator Units in the VBS4 Editor Manual.

 3. After allowing some time for Trainees to review the briefing, press OK to start the session.

 4. Press Map (M), or press Pause (Esc) and select Editor, to open VBS Editor in Execute mode.

 5. Use the VBS Editor to  modify the scenario as it runs. For more information, see Instructor 
Interface in the VBS4 Instructor Manual.

 6. During the scenario, use  Fire Direction Center the  to create and manage targets and fire 
missions based on communications with the Trainees (FOs), typically using VBS Radio.

  NOTE 
While multiple FDC Operators (enabled by starting VBS4 with the -admin parameter) can 
be used in VBS Call for Fire, it is recommended that FDC Operators are limited to a 
maximum of three, and that they are allocated control of separate gunlines, in order to 
prevent gunlines receiving conflicting instructions.

Administrators can record scenarios to enable later performance analysis, see VBS4 After Action 
Review in the VBS4 AAR Manual for details. VBS Call for Fire has a specific UI for use with AAR, 
which is discussed in VBS Call for Fire in AAR in the VBS Call for Fire Manual.
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10.4 VBS Close Air Support
VBS Close Air Support provides simulated Close Air Support (CAS) using VBS Plan.

  FEATURE NOTICE 
VBS Close Air Support is a licensed product. For more information, contact 
sales@bisimulations.com.

  NOTE 
This use case is based on the VBS Close Air Support functionality. For legacy CAS 
functionality, see Close Air Support in the VBS4 Editor Manual.

The CAS simulation involves the following roles:

 l Instructor - The Instructor prepares and executes the CAS scenario using VBS Editor and VBS 
Plan.

 l Joint Terminal Attack Controller (JTAC) - The JTAC Trainee, also known as Forward Air 
Controller (FAC), directs the CAS aircraft against an enemy target by communicating the 
target position and clearance call (Cleared Hot or Abort) to the Instructor using VBS Radio.

For the general VBS Close Air Support simulation workflow, see VBS Close Air Support Workflow 
(on the next page).

For a walkthrough example of a VBS Close Air Support scenario, see VBS Close Air Support 
Example (on page 120).
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10.4.1 VBS Close Air Support Workflow
The general VBS Close Air Support simulation workflow is divided into the following parts:

 l VBS Close Air Support Preparation (below)

 l VBS Close Air Support Execution (on page 118)

 l VBS Close Air Support Assessment (on page 119)

10.4.1.1 VBS Close Air Support Preparation
As the Instructor, create a CAS scenario using VBS Editor.

Follow these steps:

 1. If required, customize the CAS Unit aircraft and munitions functionality using JSON 
configuration in:

 \VBS_Installation\Components\VBSChalkboard\config\cas_parameters.json

See CAS Unit Parameters in the VBS Plan Manual.

  WARNING 
The following considerations apply:

 l When modifying cas_parameters.json, make sure VBS4 is not running.

 l Use the same cas_parameters.json on all computers in your VBS4 network (see 
VBS4 Deployment Options in the VBS4 Deployment Guide). Having different 
versions of cas_parameters.json on the computers in your VBS4 network may 
lead to unexpected results.

 2. Use VBS Editor to create a new Scenario, or edit an existing one.

 3. Add BLUFOR JTAC units and enemy OPFOR personnel:

Entity Description

JTAC Unit Any FAC / JTAC unit. For example:
 l US USMC Desert > FAC/JTAC - M16A3 ACOG
 l US USMC Woodland > FAC/JTAC - M16A3 ACOG

Enemy Personnel Any land / sea enemy personnel used as a CAS target.

Add personnel to the scenario.

For more information on placing units, see Adding Units in the VBS4 Editor Manual.
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 4. Add OPFOR vehicles:

Entity Description

Enemy Vehicle Any land / sea enemy vehicle used as a CAS target.

Add vehicles to the scenario.

For more information on placing vehicles, see Adding Vehicles in the VBS4 Editor Manual.

 5. Add OPFOR structures as CAS targets.

For more information, see Placing and Editing Models in the VBS Geo Manual.

 6. In the VBS4 Toolbar, select Plan to switch to VBS Plan.

 7. In the Tools Panel, open the CAS tab, where the CAS tools are located.

 8. Add a CAS Unit aircraft, using the instructions in CAS Units Tool in the VBS Plan Manual.

 9. Add a No Fly Zone (NFZ), using the instructions in CAS No Fly Zone (NFZ) Tool in the VBS Plan 
Manual.

 10. Add a No Fire Area (NFA), using the instructions in CAS No Fire Area (NFA) Tool in the VBS 
Plan Manual.

 11. Depending on the aircraft type (fixed-wing or rotary-wing), do any of the following:

 l For fixed-wing CAS aircraft, add Control Points (CPs) and Initial Points (IPs), using the 
instructions in CAS Control Point (CP) Tool and in CAS Initial Point (IP) Tool in the VBS 
Plan Manual.

 l For rotary-wing CAS aircraft, add Holding Areas (HAs) and Battle Positions (BPs), using 
the instructions in CAS Holding Area (HA) Tool and in CAS Battle Position (BP) Tool in the 
VBS Plan Manual.

 12. Build the mission to convert the CAS Plan symbols (CAS aircraft,  CPs / IPs / HAs / BPs) to 
mission entities. See Build Missions in the VBS Plan Manual.

 13. To use realistic dispersion for CAS munitions, enable the CAS Dispersion simulation option.

  NOTE 
CAS Dispersion is enabled by default.

For more information, see Simulation Settings in the VBS4 Administrator Manual.
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The CAS scenario is prepared. As Instructor, create the CAS Mission Order that uses CAS Unit 
aircraft, CPs / IPs / HAs / BPs, during scenario execution.

10.4.1.2 VBS Close Air Support Execution
Once the CAS scenario is prepared by the Instructor, it can be executed by the JTAC player and 
Instructor.

Follow these steps:

 1. As the Instructor, run the CAS scenario in Execute Mode.

Start the Scenario and open VBS Editor.

For more information, see Scenario Execution (on page 89).

 2. As a JTAC player, use a Laser Designator to mark the targets and get their Pulse Repetition 
Frequency (PRF) codes used in the CAS attack.

For more information, see Laser Designator in the VBS4 Trainee Manual.

 3. As the Instructor, use the VBS Editor to observe the laser lines in the 2D View (not available in 
the 3D View) and laser target markers in 2D and 3D Views.

  TIP 
You can toggle the visualization of laser lines in the VBS Editor. For more information, 
see Show / Hide Laser Target Lines in the VBS4 Instructor Manual.

Image-8: Laser line, cross target marker, and PRF code in the 2D View
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 4. As a JTAC player, you have the option to:

 l Communicate the CAS target position and clearance call to the Instructor over VBS Radio.

For more information, see Using VBS Radio in the VBS Radio Manual.

 l Communicate the CAS target position to the Instructor using a CAS 5-Line or 9-Line Form.

For more information, see Forms in the VBS4 Trainee Manual.

 5. As the Instructor, add a CAS Mission Order for the specified CAS target, using the instructions 
in CAS Mission Order Tool in the VBS Plan Manual, with the CAS Unit aircraft and CPs / IPs / 
HAs / BPs created in VBS Close Air Support Preparation (on page 116).

 6. As the Instructor, set the clearance call type (Cleared Hot or Abort) in the Available Aircraft 
Panel, based on the information received from the JTAC, using the instructions in CAS 
Available Aircraft Tool in the VBS Plan Manual.

The CAS Mission Order executes on the specified target.

10.4.1.3 VBS Close Air Support Assessment
As an Instructor, if you select Record AAR in VBS Close Air Support Execution (on the previous 
page), after the CAS mission finishes executing, you can assess it in the After Action Review 
(AAR).

Follow these steps:

 1. Open the AAR recording of your CAS mission:

 a. Select the CAS Battlespace in the Battlespaces List.

 b. Under Assess, highlight the AAR recording and click Open.

The AAR recording of the CAS mission loads and the AAR UI opens.

 2. Click the CAS tab in the AAR.

The CAS AAR UI opens, containing the following elements:

 l CAS Event List Panel

 l CAS Mission List Panel

For more information, see the topics in the VBS Plan Manual.

 3. In Player Controls, click Play to start the CAS mission playback for assessment.

For more information on the CAS AAR UI, see VBS Close Air Support (CAS) in AAR in the VBS4 AAR 
Manual.
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10.4.2 VBS Close Air Support Example
The purpose of this example is to create a CAS scenario using VBS Plan and VBS Editor.

The scenario location should consist of a hill overlooking a valley or a plain.

The  scenario is divided into Preparation and Execution phases:

 l VBS Close Air Support Example Preparation (below)

 l VBS Close Air Support Example Execution (on page 128)

10.4.2.1 VBS Close Air Support Example Preparation
The Preparation phase consists of placing all the VBS Plan and VBS Editor Objects to run the CAS 
mission.

Follow these steps:

 1. Start VBS4 with VBS Radio. For more information, see Step 2 of VBS Close Air Support 
Preparation (on page 116).

 2. In the VBS4 Toolbar of the Battlespaces Mode, select the Battlespaces tab.

  NOTE 
When starting the VBS4 Admin Client, the Battlespaces tab is selected by default.

 3. In the Search Bar of the VBS4 Toolbar, input the coordinates 43°35′29″N, 110°51′11″W, and 
then press Enter.

The Whole-Earth Terrain rotates directly above the specified location in the United States.

Use the Mouse Scroll Wheel to zoom in to view the area displayed.
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 4. Click + New Battlespace and click the location of the yellow circle.

The Create Battlespace dialog opens, displaying the selected coordinates.

 5. Input the following details in the Create Battlespace dialog:

Parameter Value

Name My_CAS

Color Green #36b82c

Tags MyUseCase

Description CAS Use Case

 6. Click Save Changes.

VBS4 adds the Battlespace to the Battlespaces List.
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 7. Select the newly created My_CAS Battlespace to show a green icon added to the Whole-Earth 
Terrain in the designated location.

 8. Under Prepare > Editor, click Create.

The Battlespace opens in the VBS Editor (Prepare Mode) in the 2D View.

Use the Classic Camera Controls to move the camera:
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 9. Place a JTAC unit:

 a. In the Editor Objects List, select (F1) Unit.

 b. Click a location on the map that is on a hill with a large field of view.

The Objects Properties dialog opens.

 c. Place a player JTAC unit of the following type: US USMC Woodland > FAC/JTAC - M16A3 
ACOG

  NOTE 
Set the JTAC unit to Player, so that it can be selected in the Network Lobby (see 
Network Lobby in the VBS4 Instructor Manual).

 d. In URN Marking, enter: JTAC

 e. Click OK.

The JTAC unit is placed on the map.

 10. Repeat step 9 to place an Instructor unit, with type VBS Objects > Invisible Spectator (RTE) 
and URN Marking set to Admin, anywhere in the vicinity of the JTAC.

  NOTE 
Set the Instructor unit to Playable, so that it can be selected in the Network Lobby.
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 11. Place an OPFOR target:

 a. In the Editor Objects List, select (F4) Vehicle.

 b. Click a location on the map that is about 2 km south-east of the JTAC.

The Objects Properties dialog opens.

  TIP 
To measure the distance from the target, in the VBS4 Toolbar, select Editor and 
use the Measure Distance Tool in the VBS4 Editor Manual. After measuring the 
distance, you can delete the distance line, to avoid object cluttering.

 c. Place an OPFOR vehicle of the following type: Generic OPFOR Wheeled - Woodland > Ural 
4320 - Ammo

 d. In URN Marking, enter: OPFOR_Convoy

 e. Click OK.

The OPFOR vehicle is placed on the map.

 12. Repeat step 11 to place three more OPFOR vehicles of the same type.
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 13. In the VBS4 Toolbar, select Plan.

The Battlespace opens in VBS Plan (Prepare Mode) in the 2D View.

 14. In the Tools Panel, select the CAS tab and select the CAS Control Point (CP) Tool.

 15. Click any location on the map to place a CP.

The New Control Point dialog opens.

 16. In Name, enter CP Alpha.

 17. Click Create.

The CP is placed on the map.

 18. Repeat steps 14 - 17 to place another CP with Name set to CP Bravo.
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 19. Select the CAS Initial Point (IP) Tool.

 20. Click any location on the map to place an IP.

The New Initial Point dialog opens.

 21. In Name, enter IP Alpha.

 22. Click Create.

The IP is placed on the map.

 23. Select the CAS Units Tool.

The CAS Units table appears (you can drag the bottom-right corner to resize the table).
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 24. Set the following:

Column Value

Affiliation US

Type Air Unit

Subtype A-10A

Label 1 Aircraft

Unique Designation Alpha

 25. Click Place.

The CAS Units table disappears.

 26. Click any location on the map to place the CAS Unit.

 27. Drag the CAS Unit, CPs, and IP so that they are positioned and distanced from each other in 
the following way:

 28. Click Build Mission.

The CAS Unit symbol is converted into CAS aircraft mission entities.

The CAS scenario is prepared for execution.

To run the scenario in Preview Mode, press Scenario Preview (H).

  TIP 
It is recommended to test the scenario first in Preview Mode, acting both as the Instructor 
and JTAC Trainee.
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  NOTE 
The CAS Scenario is also available as a sample Battlespace in:

\VBS_Installation\optional\Demo_Scenarios\Battlespaces\

Compare your version of the scenario to the sample by deploying the sample Battlespace 
to VBS4.

Follow these steps:

 l For Online use cases, do the steps in Copy Battlespace (below) on the VBS World 
Server computer, and then synchronize the Battlespace on the VBS4 Client connected 
to VBS World Server.

 l For Offline use cases, copy the Battlespace from the \optional\ folder.

Copy Battlespace

 1. Open the following folder in Windows File Explorer:

\VBS_Installation\optional\Demo_Scenarios\Battlespaces\

 2. Copy the UseCase_Name folders to your local Battlespaces Folder (on page 83) at:

\Documents\VBS4\Battlespaces\

Use the Battlespaces List to Filter Battlespaces (on page 80) using UseCase as the filter.

Select the sample Battlespace and select Prepare > Editor > Open to review the Scenario 
using VBS Editor.

10.4.2.2 VBS Close Air Support Example Execution
You can now execute the CAS scenario with two player participants: the Instructor and JTAC 
Trainee.

Follow these steps:

 1. As the Instructor, execute the CAS scenario according to Step 1 of VBS Close Air Support 
Execution (on page 118).

 2. In VBS4 Toolbar, select Plan to switch to VBS Plan.

 3. Select the CAS Unit created in Step 26 of VBS Close Air Support Example Preparation (on 
page 120).
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 4. In the CAS tab, select the CAS Mission Order Tool.

The Mission Orders panel is enabled (prior to the CAS Mission Order Tool selection, it is 
grayed out).

 5. In Mission Orders > Routing, route the CAS Unit to CP Alpha:

 a. In the Route To drop-down, select CP Alpha.

 b. Click Move Now.

The CAS Unit spline (flight trajectory) appears.
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 6. As the JTAC Trainee, designate the OPFOR targets for the Instructor:

 a. Press Binoculars (B) and observe the OPFOR vehicles.

 b. As the JTAC Trainee, you have the option to:

 l Communicate the CAS target position to the Instructor over VBS Radio.

For more information, see Using VBS Radio in the VBS Radio Manual.

 l Communicate the CAS target position to the Instructor using a CAS 5-Line or 9-Line 
Form.

For more information, see Forms in the VBS4 Trainee Manual.

 7. As the Instructor, receive the target information from the JTAC Trainee over VBS Radio.

  NOTE 
JTAC Trainees can make mistakes. The purpose of this CAS example scenario is to 
allow Instructors to incorporate incorrect information provided by the JTAC Trainee. 
This allows the JTAC Trainee to see the risks and negative consequences.

Specific military doctrine affects how JTAC Trainees call for CAS. The focus of this 
example is to use the VBS Close Air Support UI, to execute a CAS Mission Order.

 8. In Select Aircraft, set the following Measures:

 l In the Observer drop-down, select JTAC.

 l In the Initial Point drop-down, select IP Alpha.
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 9. In Select Aircraft, create a Target:

 a. Click Add Target to add a CAS target, based on the target information received from the 
JTAC Trainee.

 b. Click anywhere close to the OPFOR vehicle symbols on the map.

The New Point Target dialog opens.

 c. Set Name to OPFOR_Convoy and click Create.

The CAS target is created under Target List.

You can edit existing CAS targets under Target List:

 l Change the target properties in the relevant entries.

 l Drag the target marker on the map to relocate the target.

 l Click the Trash icon to delete the target.
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 10. In Select Aircraft, specify the mission detail:

 a. In the Engage drop-down, select one of the following settings:

 l Immediate

 l Time On Target

 l Time To Target

For more information, see Select Aircraft Details Properties in the VBS Close Air Support 
Manual.

 b. Fill in the other properties based on the JTAC communication:

Property Value

Mark Type None

Friendly Location NW

Egress Location CP Bravo

Altitude 10000 ft AGL

Attack Profile Level

Munitions MK82

Quantity Any value between 1 - 4

Beaten Zone 60 m
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 c. Click Start CAS Mission.

The CAS Mission Order is created and started, with the Cleared Hot and Abort Mission 
buttons becoming enabled.

 11. As the JTAC Trainee, when ready, communicate the Cleared Hot to the Instructor over VBS 
Radio.
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 12. As the Instructor, click Cleared Hot.

The Mission List shows the On Mission status.

The Instructor and JTAC Trainee can observe the result of the munitions hitting the target.

The CAS scenario is executed.
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10.5 VBS Control AI Overview
VBS Control AI provides a set of AI behaviors with Computer Generated Forces (CGF)-like 
capabilities. It supplements the regular VBS4 AI and offers a familiar VBS Editor based user 
interface.

In VBS4 both Game AI and Control AI are available by default, while Control AI is the AI type used 
by VBS Plan.

Control AI uses Control AI Waypoints (see  the VBS4 Editor Manual), and has advantages over 
Game AI in the following capabilities:

Capabilities AI Sub-Type Additional Aspects

Convoy Training, Driver Training, 
Enemy Ambush, OPFOR Tactics, or 
any vehicle focused capabilities.
For more information on convoy 
capabilities, see Convoys (on 
page 161).

Convoy AI (see  the 
VBS4 Editor 
Manual)

The Control AI convoy has the following 
additional aspects:

 l The convoy has behavior that can be 
paused / continued.

 l The convoy has a leader, which is 
dynamically selectable and can be 
replaced.

 l The convoy dynamically determines the 
order of convoy succession, based on the 
convoy vehicle placement.

 l The convoy can drive both on and off the 
road.

 l The convoy reactions to enemy contact 
or fire can be set.

Enemy Ambush, OPFOR Tactics.
For more information on these 
capabilities, see Enemy Ambush 
(on page 173).

AI on Rails (see the 
VBS4 Editor 
Manual)

 l Fine-tune enemy placement to prepare an 
ambush.

 l Use Triggers to create dynamic 
situations.

 l Branch Control AI Waypoints to achieve 
different outcomes on each Scenario run.

Dry Support Bridge (DSB) Training.
For more information about 
DSB laying capabilities, see HX45M 
Bridge Laying (Land 155) (on 
page 257).

Bridge Laying 
Convoy AI (see the 
VBS4 Editor 
Manual)

 l Place DSBs of varying lengths at the 
required places on the terrain.
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Capabilities AI Sub-Type Additional Aspects

Large-scale battles with a primary 
focus on fighting and maneuvers.

VBS Plan (see VBS 
Plan Overview in 
the VBS Plan 
Manual) 

 l Place large amounts of military entities 
easily, using VBS Plan.

 l Have the entities maneuver and attack 
the enemy on their way.

 l Place tanks or mechanized platoons.

Military infantry and vehicle fighting 
and maneuvers.

Military AI (see the 
VBS4 Editor 
Manual)

 l Have infantry and vehicle AI perform 
general-purpose military orders.

Civilian pattern of life. Civilian AI(see the 
VBS4 Editor 
Manual)

 l Create a civilian pattern of life that 
consists of pedestrians and vehicles.

 l Create various activities for pedestrians.

Animal-herd behaviors. Animal AI(see the 
VBS4 Editor 
Manual)

 l Add animal-herd movement.

For an overview of the Control AI UI and its Editor Objects, see Control AI UI Overview in the  VBS 
Control AI Manual.

How-tos:

 l Control AI Waypoints - Describes how waypoints can be created by linking Control AI Editor 
Objects.

 l AI on Rails - Describes waypoint-based movement and movement visualization for individual 
entities.

 l Military AI - Describes the general-purpose military infantry and vehicle Control AI and its use 
cases.

 l Convoy AI - Describes the convoy Control AI and its use cases.

 l Civilian AI - Describes the civilian Control AI and its use cases.

 l Animal AI - Describes the animal-herd Control AI and its use cases.

 l Navigation Meshes - Describes how to create and update a map navigation mesh.

 l Control AI Visualization - Describes how to use debug visualization for Control AI entities.

For details, see the topics  in the  VBS Control AI Manual.

Reference:

 l Example Content - Lists the Control AI example missions, available with VBS Control AI.

 l Known Issues - Lists the current VBS Control AI issues / limitations.

For details, see the topics  in the  VBS Control AI Manual.
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10.6 VBS Gateway Overview
VBS Gateway is the premier gateway for VBS4. VBS Gateway provides a DIS / HLA link between 
VBS4 and other simulations for distributed training exercises. VBS Gateway comes as standard 
with VBS4 and automatically connects to other VBS Gateway clients out of the box with no 
configuration changes.

VBS Gateway brings live loading, user-friendly configuration capabilities, a real-time user interface, 
and significant performance enhancements as the new VBS4 gateway system.

 l Live entity editing.

 l Higher frame rates for better visualization.

 l User-friendly mapping of shared entities.

 l Smoother transitions with dead reckoning.

 l Filter and search functions with descriptive model names.

 l Access to the UI through VBS4 or directly in a web browser.

 l Actionable feedback for determining mapping errors.

Image-9: Simplified Gateway Network Diagrams for DIS and HLA Communications

 

1 Dedicated Server running VBS4 with VBS Gateway.

2 DIS / HLA-compliant simulation product.

These topics in the VBS Gateway Manual provide the information required for the following roles:
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Communications Administrator

The Communications Administrator is responsible for the setup, configuration, and monitoring of 
the communication between the linked simulation products and VBS4:

 l Configure VBS Gateway

 l Communications Monitoring

Simulation Administrator

The Simulation Administrator is responsible for the configuration, monitoring, and modification of 
the simulation object protocol models, ensuring that remote entities are represented appropriately 
in VBS4, and that VBS4 entities are communicated correctly to the other simulators:

 l Configure Simulation Modeling

 l Simulation Monitoring

The Simulation Administrator should review the Mapping Tables to understand how VBS Gateway 
maps local and remote entities.

All roles should refer to Launching VBS Gateway and VBS Gateway UI to perform their functions 
and may  need to refer to VBS Gateway Advanced Configuration to configure advanced settings 
and to troubleshoot VBS Gateway.

VBS Gateway supports the following protocols:

 l DIS v4-v7

 l HLA FOMs including RPR1 and RPR2

  NOTE 
RTIs supports multiple HLA API versions (1.3, 1516, 1516e, and 1516-dlc), Java and 
C++, and several C++ compiler versions. Simulators can pick any combination while 
still being able to connect to each other.

VBS Gateway uses 1516e (HLA Evolved API).

VBS Gateway supports the following HLA Run Time Infrastructures (RTIs):

 l MÄK RTI version 4.5

Compatible with MSVC 14.0 or 15.0

For more information, see https://www.mak.com/mak-one/tools/mak-rti.

 l Pitch pRTI Free version 5.3.2.1

Compatible with MSVC 14.0 or 15.0

For more information, see http://www.pitchtechnologies.com/products/prti/.
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10.6.1 Appendix: Supported DIS PDUs
VBS Gateway supports the following DIS PDUs. See the link below each description for detailed 
information about that packet type. 

 l EntityState - This packet contains entity information, such as spatial / orientation data and any 
articulated parts:

http://faculty.nps.edu/brutzman/vrtp/mil/navy/nps/disEnumerations/JdbeHtmlFiles/pdu/29.
htm

 l Designator - This packet contains designator information, such as power and wavelength:

http://faculty.nps.edu/brutzman/vrtp/mil/navy/nps/disEnumerations/JdbeHtmlFiles/pdu/d3.
htm

 l Fire - This packet contains the details of a weapon fire event:

http://faculty.nps.edu/brutzman/vrtp/mil/navy/nps/disEnumerations/JdbeHtmlFiles/pdu/7c.
htm

 l Detonation - This packet contains the details of a detonation event:

http://faculty.nps.edu/brutzman/vrtp/mil/navy/nps/disEnumerations/JdbeHtmlFiles/pdu/84.
htm

 l Acknowledge - This packet is used to acknowledge receipt of certain PDUs:

http://faculty.nps.edu/brutzman/vrtp/mil/navy/nps/disEnumerations/JdbeHtmlFiles/pdu/a3.
htm

 l Data - This packet contains data used by Gateway  to print out information in string format. If 
logging is turned on, this data appears in the log:

http://faculty.nps.edu/brutzman/vrtp/mil/navy/nps/disEnumerations/JdbeHtmlFiles/pdu/b2.
htm

 l SetData - This packet contains data, which VBS Gateway reads as a string and runs as a script 
command if the datum ID is the same as the datum ID set in the Gateway settings. If logging is 
turned on, this command is recorded in the log:

http://faculty.nps.edu/brutzman/v 
rtp/mil/navy/nps/disEnumerations/JdbeHtmlFiles/pdu/b0.htm

 l IFF - This packet contains data representing a transponder that produces Identification Friend 
of Foe (IFF) responses when it receives an appropriate signal.
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10.7 VBS Host Overview
VBS includes a set of capabilities to broadcast specified viewpoints to VBS Blue IG.

 l VBS includes a dedicated host component to broadcast directly  to VBS Blue IG.

 l VBS uses IG View Objects to place viewpoints into scenarios which can then be linked to a 
vehicle or unit.

 l Each IG View Object specifies a configuration that determines the perspectives for that 
viewpoint and the IG clients to broadcast them to.

Image-10: Simplified Network Diagram for Broadcast to VBS Blue IG

1 Dedicated Server running VBS

2 VBS Blue IG

These topics in the VBS Host Manual explain how to use VBS to broadcast to VBS Blue IG:

 1. Create IG View Configuration Files

 2. Add IG Viewpoints to Scenarios

 3. If VBS is hosting an interoperable simulation with other DIS compliant products, enable VBS to 
broadcast the external entities to the IG product by Enabling DIS Entities.

 4. To run VBS in broadcast mode, start VBS with the appropriate  startup parameter, according to 
the following installed  application:

 l VBS Blue IG - Use the -vbsHostNet parameter.

 l Other CIGI-compliant IG products - Use the -gateway parameter.

For more information about using VBS as a host for VBS Blue IG, see Quick Start: VBS Blue IG with 
VBS4 Host in the VBS4 Administrator Manual.
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10.8 VBS Radio Overview
VBS Radio simulates radio and other communication within VBS4 and as part of larger cross-
product integrations.

  FEATURE NOTICE 
VBS Radio supercedes the legacy Radio 18.2 product,  resulting in significant changes to 
the previous radio workflow. For more information, see VBS Radio Workflow Changes.

VBS Radio is enabled by default.

Use the -disableVBSRadio option in VBS Launcher to disable VBS Radio.

Before using VBS Radio, review VBS Radio Concepts and  to understand the terminology and 
infrastructure of VBS Radio.

VBS4 includes a free version of VBS Radio, with certain limitations. VBS Radio Pro is available with 
separate licenses and provides more features and functionality. For more information, see VBS 
Radio Licensing.

To see how VBS Radio Pro works, watch the video at https://www.youtube.com/watch?v=tPj-
oqwo3mY.

  NOTE 
The videos may not be up to date with the features they demonstrate, the latest state of 
which is described in this manual.

To setup and use VBS Radio, use the following process:

 1. Start VBS4 as an Administrator with VBS Radio enabled, and use VBS Editor to setup the 
Communication Channels and Radio Types for your mission.

See Setting Up VBS Radio in the VBS Radio Manual.

 2. If necessary, make adjustments to Direct Talk, volume, and other settings in the configuration
 .xml file.

See VBSRadioSettings Configuration File in the VBS Radio Manual.

 3. Setup any radio jamming required for the scenario.

See VBS Radio Jamming Device in the VBS Radio Manual.

 4. The Administrator and Trainees use VBS4 to start and join a networked mission with VBS 
Radio enabled by default. Optionally, use the Advanced > Radio tab in VBS Launcher to specify 
standalone Pitch Servers or Multicast.

See Starting VBS Radio in the VBS Radio Manual.
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 5. Units in the mission communicate using the assigned Radio Types and Communication 
Channels.

See Using VBS Radio in the VBS Radio Manual.

 6. Instructors running the mission can monitor and communicate on all channels using the VBS 
Radio Control panel.

See Monitoring VBS Radio in the VBS Radio Manual.

 7. Non-VBS users can communicate with users in a VBS Radio scenario using a separate client 
application.

For more information, see VBS Radio Standalone (on page 147).

 8. After a mission ends, radio usage is available for review as part of an After Action Review 
(AAR) recording.

See VBS Radio Playback in AAR in the VBS Radio Manual.

Review VBS Radio Troubleshooting in the VBS Radio Manual if you encounter issues while using 
VBS Radio.

  FEATURE NOTICE 
VBS Radio uses Pitch Talk, created by Pitch Technologies, as its communication and 
networking layer. Pitch Talk uses Pitch pRTI as its infrastructure for the networking layer 
which is an implementation of the HLA 1516-2010 communication standard. VBS Radio 
also includes the Pitch DIS Gateway implementation to enable integrated communication 
with products that use the DIS communication standard.

For more information about Pitch Talk, see http://pitchtechnologies.com/products/talk/.
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10.8.1 VBS Radio Concepts
VBS Radio enables communication using the following concepts:

 l Radio Types

Radio Types represent the capabilities of physical communication devices, defining the 
parameters of a radio system, such as the number of channels, range, and bandwidth.

 l Communication Channels

VBS Radio uses Communication Channels to provide the following types of communication:

 o VoIP Networks

Voice over IP (VoIP) networks can be used for exercise control communication.

  NOTE 
Distance degradation and Jammer effects are not available for VoIP Networks.

 o Radio Channels

Radio Channels have frequency assignments and are used to simulate radio 
communication, including distance-based degradation and Jammer effects.

 o Vehicle Intercom Mode

Vehicles can be assigned a Vehicle Intercom Mode (PTT / VOX) for communication 
between the crew, see Advanced Settings and Presets in the VBS Radio Manual.

 o Global Text Network

Players can communicate by text using the Radio Messenger dialog, see Communications 
Panel in the VBS Radio Manual.
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10.8.2 VBS Radio Architecture
VBS Radio consists of several components across several computers on the network.

No. Computers Description

1 Admin Client / 
Dedicated Server

The computer hosting the VBS4 mission, running VBS Radio in server mode, 
the Pitch Talk Admin Server, and the optional Pitch DIS Gateway.

2 Router / Switch Shared network infrastructure.

3 User Clients The trainee computers connected to the VBS4 mission, running VBS Radio in 
client mode, communicating with the host using Pitch pRTI.

4 DIS Products Optional: Other simulation products using the DIS protocol, communicating 
with the host using Pitch DIS Gateway.

VBS Radio Component

VBS Radio is a core component of VBS4, which enables mission designers to define Radio Types, 
and Communication Channels, and save them as part of a VBS4 mission. The component 
communicates with the Pitch Talk Admin Server about the communication setup.

Pitch Talk Admin Server

The Pitch Talk Admin Server runs on the computer hosting the VBS4 mission by default, or on a 
separate dedicated machine, and manages communication between VBS4 clients using Pitch 
pRTI.

Pitch DIS Gateway

Pitch DIS Gateway is an optional application that connects to Pitch pRTI and translates the HLA 
protocol communication to the DIS protocol, to enable integrated communication with DIS-
compliant products.

© 2023 - Bohemia Interactive Simulations - All Rights Reserved - 144 -



10. VBS Components and Products VBS4 23.2.0

10.8.3 VBS Radio Licensing
VBS4 includes a free version of VBS Radio as standard, which provides out-of-the-box 
communication functionality.

The free version of VBS Radio has the following limitations:

 l VBS4 is limited to five Radio Channels which are pre-defined as defaults in VBS4, and cannot 
be changed.

  NOTE 
The preset Radio Channel frequencies are restricted to VHF bandwidths only.

 l VoIP networks that are pre-configured as defaults, and cannot be changed.

VBS Radio Pro is available on an additional per-seat license basis and provides the following 
additional capabilities:

 l Creation of Radio Types with custom parameters.

 l Unlimited channels. The Administrator can create any amount of channels, and choose any 
frequency for them.

 l Radio Types can be assigned to any group of units. This means that:

 o Trainees can speak on one channel and also monitor audio on other channels.

 o Trainees can switch between radios in 1st / 3rd person view, enabling them to quickly 
communicate on multiple frequencies.

 l HF and UHF frequencies are available in addition to VHF. Radio Types can be configured to 
support any of these frequency bands.

 l Individual Communication Channel monitoring using Left and Right output channels.

 l Simulation of weather degradation.

VBS Radio Standalone (on page 147) is a separate product, available on an additional per-seat 
license basis. It enables non-VBS users to communicate with participants in a VBS Radio scenario.

  FEATURE NOTICE 
For more information about VBS Radio Pro, contact  sales@bisimulations.com.
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10.8.4 VBS Radio Workflow Changes
VBS Radio is significantly updated since VBS3 18.3.0, and completely replaces VBS Radio in VBS3 
18.2 and earlier.

In addition,  the updated VBS Radio results in the following changes:

 l VBS Radio starts by default. Options are available in VBS Launcher to disable VBS Radio or to 
provide additional debug logging information about VBS Radio.

 l Physical radios are simulated. The representation of a physical radio which can be assigned to 
characters is called a Radio Type. For more information, see Configure Radio Types in the VBS 
Radio Manual.

 o As well as being assigned Communication Channels, a Radio Type must also be assigned 
to units for them to use that Communication Channel.

 o The frequency of Radio Channels must match the Frequency Range of the Radio Type 
assigned to units for these channels to be available to them.

 o Distance degradation is now a property of the Radio Type, not the channel.

 l The Administrator assigns Radio Types to specific units.
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10.8.5 VBS Radio Standalone
Bohemia Interactive Simulations provides a separate application, VBS Radio Standalone, to enable 
non-VBS4 users to communicate with VBS4 users participating in a VBS Radio scenario.

  FEATURE NOTICE 
VBS Radio Standalone is a licensed product. For more information, contact  
sales@bisimulations.com.

This topic describes the specific process to use VBS Radio Standalone connected to VBS4 running 
a VBS Radio scenario:

 1. Deploy VBS Radio Standalone (below)

 2. Configure VBS Radio Standalone (on the next page)

 3. Using VBS Radio Standalone (on page 151)

  NOTE 
VBS Radio Standalone also supports use cases that do not require VBS4, and has 
additional configuration and usage options not described in this topic.

For more information, refer to the Pitch Talk User Guide in the VBS Radio Standalone 
installation \docs\ folder.

10.8.5.1 Deploy VBS Radio Standalone
Bohemia Interactive Simulations distributes VBS Radio Standalone as a download package 
available from VBS License Manager or delivered directly by Customer Support.

Use the download package to install VBS Radio Standalone.

Follow these steps:

 1. Navigate to the download folder and extract the download package.

 2. Run VBS_Radio_Standalone.Core.InstallerX64.version.exe.

The VBS Radio Standalone Installation Wizard opens.

 3. Click Next to continue.

 4. Review the License Agreement, and click I Agree to continue.

 5. In the Choose Install Location panel, input or Browse for the Destination Folder.

 6. Click Next to continue.
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 7. In the Choose Components panel, select the options to install:

 l Create Start Menu Shortcut

 l VBS Radio Standalone (mandatory)

 l Install Drivers

 l Firewall Exceptions

  WARNING 
Select Install Drivers and Firewall Exceptions if you are installing on a computer that 
does not already have VBS4 installed.

 8. Click Next to continue.

 9. Specify the Start Menu Folder, and click Install.

 10. Optional: Select Do not create shortcuts to skip this step.

The installer deploys VBS Radio Standalone to the selected folder and creates the selected 
shortcuts.

 11. Click Finish to close the Installation Wizard.

10.8.5.2 Configure VBS Radio Standalone
To use VBS Radio Standalone to communicate with VBS Radio users in VBS4, configure its 
settings to connect to the same Pitch Talk Servers as specified by VBS4.

  WARNING 
If VBS Radio Standalone users are to be represented as entities in the VBS mission, apply 
URNs to those entities in VBS Editor Prepare mode. This can be done for any human entity, 
including invisible spectators.

On each VBS Radio Standalone client, configure the connection settings.

Follow these steps:

 1. Start VBSRadioStandalone.exe.

 2. Click the Settings Button to open the Settings dialog.
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 3. Select the HLA Settings tab, and specify the following settings:

HLA 
Settings

Description

Federation 
Name

Specify VBS Radio.

Pitch pRTI 
specific

Select this option and specify the CRC Host and CRC Port.

CRC Host 
and Port

Specify the same IP Address and Port used as the Federation Address (-
pitchprtiserver) specified when starting VBS4.

  NOTE 
If the VBS4 Host does not specify separate Pitch Servers, use the VBS4 Host 
IP Address and Port 8992.

For more information, see Starting VBS Radio in the VBS Radio Manual.

 4. Select the User Identification tab.

Set the Client Id:

  NOTE 
This must be the same as the URN of the user / AI you want to connect to.

  TIP 
Multiple VBS Radio Standalone clients can use the same Client Id. Use this method for 
clients that use the same group of units.

For example, if two separate clients are intended to communicate with members of 
the BLUFOR and Platoon A, they can use the same Client Id.

 5. Click OK.

If you have not set URNs, enable the clients to connect on the VBS4 Host computer.

Follow these steps:

 1. Start VBS4 as the administrator with VBS Radio enabled.

 2. In the Battlespace Functions panel, go to Execute, and click Host to open the Networking 
Lobby.

 3. Open a web browser at localhost:9600 to open Pitch Talk.
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 4. Log in with Name: admin and Password: admin.

Pitch Talk displays a Project with the name of your mission (only running MP missions are 
shown).

 5. Click the mission name and select the Users tab.

 6. For each Client Id configured in VBS Radio Standalone, click New to create a new user and use 
the following settings:

Setting Description

Name Input the name used as the Client ID

Identification 
Method

Select Client Id and input the name used as the Client Id as the fingerprint.

  TIP 
Multiple VBS Radio Standalone clients can use the same Client Id. Use this 
method for clients that use the same group of units.
For example, if two separate clients are intended to communicate with 
members of the BLUFOR and Platoon A, they can use the same Client Id.

 7. Click OK.

Pitch Talk adds the new user to the Users list.

 8. Click the redeploy project icon.

VBS Radio Standalone is configured and connects to a VBS Radio scenario when the mission is 
started from a VBS4 Host using the same Federation Address and VBS Radio Standalone is turned 
on. Each user can communicate using the Networks and Channels assigned to the units assigned 
to them in Pitch Talk.
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10.8.5.3 Using VBS Radio Standalone
When VBS4 hosts a VBS Radio scenario, VBS Radio Standalone connects to the same Federation 
Address when VBS Radio Standalone is turned on.

Use VBS Radio Standalone to communicate with users in the VBS Radio scenario.

Follow these steps:

 1. Start VBSRadioStandalone.exe to open the VBS Radio Standalone UI.

 2. Turn on the radio using the dial:

 l Select PTT to use Push-to-Talk communication with the PTT button.

 l Select VOX to use Voice Activation.

VBS Radio Standalone connects to the mission and displays the first channel.
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 3. Select the channel to use by using the PRE + / - buttons to cycle through the channels set up 
for the VBS Radio scenario.

 4. To use any available Chat channels, follow these steps:

 a. Expand Chat, and select the tab name for the Chat channel to use.

 b. Type your message, and click Send.

For information about VBS Radio Chat, see Communications Panel in the VBS Radio Manual.

  TIP 
Hotkeys are available as keyboard shortcuts. Do the following:

 1. Click the Settings Button to open the Settings dialog.

 2. Select the Hotkeys tab.

 3. Click Set for the applicable option and press the key to use as the keyboard shortcut.

 4. Click OK.
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10.9 VBS Blue IG
VBS4 can now act as a host and broadcast viewpoints to VBS Blue IG.

The VBS Blue Image Generator (VBS Blue IG) provides high-fidelity visualizations of data from 
VBS3, VBS4, and Common Image Generator Interface (CIGI) simulations. VBS Blue IG is a whole-
earth rendering solution, eliminating the need to limit simulations to the confines of terrain 
databases. With this software, highly detailed insets can be combined with procedurally generated 
terrain and vegetation to simulate scenarios anywhere on earth. 

Using the CIGI protocol, a simulation host such as VBS3, VBS4, or any compliant host connects to 
and controls the IG.

Designed to support high-performance computer image generation for the full range of military 
training and special operations applications, VBS Blue IG runs on standard, unmodified COTS 
hardware or scalable graphics systems.

The figure below illustrates how the simulator and image generator work together.

Image-11: A basic overview of Simulators and Image Generators
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VBS Blue IG delivers highly realistic visual and sensor scenes, with long-view distances and large 
numbers of moving entities on a whole-world terrain, while enabling a single IG to be utilized in Air, 
Sea and Land domains.

Image-12: Several IG outputs blended to project a seamless image on to a dome

For more information, see the VBS Blue IG Manuals and Quick Start: VBS Blue IG with VBS4 Host in 
the VBS4 Administrator Manual.
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10.10 VBS Simulation SDK
Bohemia Interactive Simulations provides a software development kit to enable VBS 
customization. VBS Simulation SDK enables developers to customize and extend VBS by providing 
an API and suite of tools. VBS Simulation SDK includes core and simulation-specific APIs, and a 
copy of the VBS Control Editor, Bohemia Interactive Simulations advanced artificial intelligence 
behavior editing toolkit.

VBS Simulation SDK provides low-level and direct access to the VBS engine without any 
intermediate layers. The APIs included with VBS Simulation SDK cover everything from basic 
application control to mission management to environment settings. VBS Simulation SDK is ready 
to meet many use cases: take control of and define the path of any projectile or just create the 
projectile path as you see fit; disable the simulation for a vehicle and control its behavior by 
integrating your own solution; enhance your VBS experience with easy-to-use 3D world and screen 
drawing APIs.

  WARNING 
VBS Simulation SDK supersedes the Application Scripting Interface (ASI) as the primary 
method to customize and extend the functionality of VBS. We no longer recommend 
creating plugins using the ASI.

As VBS Simulation SDK capabilities grow, other new APIs covering different aspects of the VBS 
functionality will be added such as custom sensor optics, terrain mesh queries, and multiplayer 
control management. The VBS Simulation SDK also provides support for direct access to the VBS 
Control actors and behaviors through VBS Control-specific APIs, support for HTML-based user 
interfaces, and updated VR / XR interface listeners.

To learn more about the most recent additions and updates to the latest VBS Simulation SDK 
release, please refer to the Changelog section in the VBS Simulation SDK Manual.

  FEATURE NOTICE 
VBS Simulation SDK is a separately licensed product. For more information, contact 
sales@bisimulations.com.

For a detailed introduction to VBS Simulation SDK, visit: https://bisimulations.com/products/vbs-
simulation-sdk.
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10.11 VBS Developer Suite
Bohemia Interactive Simulations provides the VBS Developer Suite as a separate product, which 
enables you to create custom models and configure their simulation behavior using proprietary 
and industry-standard tools.

The VBS Developer Suite provides the following primary tools and utilities:

 l For model development, Model Exchanger (MEx) provides a set of utilities to convert models 
created in industry standard formats, such as FBX, GLTF, or GLB, to the proprietary P3D format 
used in VBS4.

 l Addon Packer provides a one-click method to pack and binarize content into the proprietary 
PBO format required by VBS, and also provides encryption to CBO format to protect content.

 l A set of Miscellaneous Tools enables you to create specific model types and convert various 
model files and textures for use in VBS.

Included in your VBS Developer Suite installation is the VBS Developer Suite Reference. This 
documentation contains a set of complimentary manuals which discuss the various aspects of 
model creation and configuration that are necessary for the successful import of custom content 
into VBS. The included manuals are listed in the following table.

Manual Description

VBS Developer 
Suite Overview

This manual introduces you to the various tools, files, processes, inheritance theory, 
and packing procedures employed by those wishing to add their own content to VBS.

Model 
Exchanger

This manual introduces the Model Exchanger (MEx) application, which is required for 
to import and maintain model content for Bohemia Interactive Simulations products.  It 
is the primary application in the VBS Developer Suite. It serves as a platform for various 
plugins that are dedicated to specific tasks.
In addition, the MEx UI, its capabilities, and the various LOD types available for 
successful model creation are discussed in detail.

Importing 
Assets

This manual contains full tutorials and single topics, which provide step-by-step 
instructions about how to import models from commercial modeling tools and properly 
configure them for VBS4.
In addition, how to apply detail and effects is discussed, together with the Universal 
Component System (UCS), adding vehicle systems, and creating UI elements.

Configuration 
Manual 

This manual contains all of the classes and parameters used by VBS to enable you to 
successfully create Model.cfg and Config.cpp files, which are essential for defining 
the characteristics, capabilities, and animation functionality of your models for use in 
VBS.

Miscellaneous 
Tools

This manual contains a sub-set of smaller manuals which cover various exclusive tools 
that are used for specific tasks, including: Face Editor, Model Converter, and more.
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10.12 WIBU Licensing
Bohemia Interactive Simulations use a proprietary licensing management system, VBS License 
Manager using WIBU CodeMeter licensing, to provide customers with greater flexibility, and to help 
reduce license administration overhead.

WIBU CodeMeter is a license management and code protection system. WIBU enables the secure 
and simple distribution and update of software licenses. The new license management system 
significantly reduces the management and administrative overhead that military and simulation 
industry customers have traditionally carried for license management.

 l WIBU enables Bohemia Interactive Simulations to rapidly deliver licensing with the purchase of 
software products, so that your personnel can start training faster. You no longer have to wait 
for a physical dongle to arrive in the mail.

 l The new system also provides the capability to update licensing in classified networks.

 l You can download products directly from the user-friendly VBS License Manager.

 l You can receive and update dongles and servers in both online and offline environments.

 l WIBU eliminates the need to work with a physical dongle and can be attached to specific PCs, 
avoiding the possibility of lost or missing dongles.

 l More information on licenses such as support dates is available in the new web interface.

Using VBS License Manager and WIBU for license management does not affect how Bohemia 
Interactive Simulations products run.

WIBU licensing and VBS License Manager simplifies license management in the following ways:

 l Significantly fewer physical dongles are needed under WIBU Codemeter. Customers may only 
need new dongles when they are updating licenses in an offline environment. Licenses can be 
associated with specific machines or floating licenses may be managed by a License Server. 
Licenses can be updated or added without dongles in an online environment.

 l An internet connection is typically only necessary for the initial setup of a License Server, 
although offline License Server use cases are also supported.  Individual computers can 
remain offline so long as the license is not a timed license. Offline LANs can receive Bohemia 
Interactive Simulations software products through manual license transfer to servers installed 
on their LANs. BISim Customer Support is available to assist with this delivery type.

 l When a component needs to be replaced on a computer, Bohemia Interactive Simulations can 
re-register the license, provided the customer purchased the license as perpetual or the timed 
license is still valid under terms of the agreement.
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For any queries about WIBU licensing, contact wibu.support@bisimulations.com.

For more information managing WIBU licenses for Bohemia Interactive Simulations products, see 
the VBS License Manager documentation.
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11. VBS Use Cases Documentation
VBS4 supports a wide range of specific training needs, including all VBS3 training use cases.

To better support these capabilities, this documentation includes a set of topics describing in 
more detail how to prepare and execute scenarios that use specific functionality of VBS4:

General Use Cases:

 l Convoys (on page 161)

 l Enemy Ambush (on page 173)

 l Improvised Explosive Device Ambush (on page 189)

 l Route Clearance (on page 199)

Each of these uses cases includes a step-by-step procedure to create a basic example scenario 
demonstrating the use case. Follow the instructions to create these scenarios.

  NOTE 
These use cases are also available as PDFs in your installation in the following folder:

\docs\PDF\UseCases\

The Scenarios used in these use cases are also available as sample Battlespaces, predeployed on 
VBS World Server or in the installation folder of your VBS4 Client:

\VBS_Installation\optional\Demo_Scenarios\Battlespaces\

Compare your version of the scenario to the sample by deploying the sample Battlespace to VBS4.

Follow these steps:

 l For Online use cases, do the steps in Copy Battlespace (below) on the VBS World Server 
computer, and then synchronize the Battlespace on the VBS4 Client connected to VBS World 
Server.

 l For Offline use cases, copy the Battlespace from the \optional\ folder.

Copy Battlespace

 1. Open the following folder in Windows File Explorer:

\VBS_Installation\optional\Demo_Scenarios\Battlespaces\

 2. Copy the UseCase_Name folders to your local Battlespaces Folder (on page 83) at:

\Documents\VBS4\Battlespaces\

Use the Battlespaces List to Filter Battlespaces (on page 80) using UseCase as the filter.
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Select the sample Battlespace and select Prepare > Editor > Open to review the Scenario using 
VBS Editor.

This set of documented use cases will expand over time to cover topics within the wide range of 
training needs that our customers have developed for VBS3 and VBS4. A small sample of the over 
200 use cases that have been developed include the following:

IED Training Driver Training Radio Procedures Aircraft Part-Task Trainer

Parachuting Vehicle Checkpoint Crew Served Weapons Ship Familiarization

Navigation First Response Surveillance Systems Vehicle and Object Search

Vehicle ID Crew Training Medical - First Aid Rules of Engagement

UAV Training UGV Training Cultural Awareness Enemy Mindset Training

Sensor Training Lessons Learned Intelligence Training Aircraft-Ground Simulation

CBRN Vehicle Recovery Engineer Training Medical - CASEVAC

Sniper Training Convoy Training Route Clearance Ops Room / Staff Training

Vehicle Systems Mission Rehearsal FO/JTAC Training  

VBS4 extends and improves many of these use cases through its Whole-Earth Terrain 
representation, including use cases related to fast air (for example, part-task training, close air 
support, and mission rehearsal). And with the new interfaces, VBS Geo and VBS Plan, scenarios 
can be built more quickly allowing for more varied training and agile adaptation to reflect new 
training objectives (more Bloodless Battles).

The powerful VBS simulation engine has been further extended in VBS4, including an updated 
physics simulation to increase realism across its massive number of support training use cases. 
All VBS3 features, such as soldier fatigue simulation, unmanned vehicles, and accurate and 
weapon-specific ballistics, have been ported to VBS4.

In addition, these manuals contain more specific capabilities developed for customer projects that 
are available as functionality in VBS4.

Customer Specific Capabilities:

 l Artillery Support in VBS Plan (on page 217)

 l Autonomous Vehicle Operations (on page 234)

 l Aviation Combined Arms Training System (on page 250)

 l CBRN Contamination (on page 252)

 l HX45M Bridge Laying (Land 155) (on page 257)

 l Military Road Signs (on page 260)

 l OPV River Class Trainer (on page 261)

 l Polish AFV Tank Trainer (on page 263)
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11.1 Convoys
The purpose of this guide is to simulate a convoy, which is defined as a group of vehicles traveling 
together, for mutual support and protection. Often, a convoy has an armed defensive support.

There are four types of convoy simulation:

Convoy Simulation Description

Full AI Convoy All the convoy crew members are AI-controlled.

AI and Player Convoy Part of the convoy crew members are AI-controlled, while another part is player-
controlled.

Full Player Convoy All the convoy crew members are player-controlled.

Scripted Convoy The convoy crew is controlled using SQF scripts.

AI convoys may be controlled by the VBS AI or the Control AI. 

For a walkthrough example of a simple convoy scenario, see the following:

 l Control AI Convoy Example (below)

The general workflow of a convoy scenario in VBS4 contains two parts:

 l Convoy Preparation (on page 169)

 l Convoy Execution (on page 171)

11.1.1 Control AI Convoy Example
You can create a full Control AI convoy, and give it a Convoy Order.

Follow these steps:

 1. In the VBS4 Toolbar of the Battlespaces Mode, select the Battlespaces tab.

  NOTE 
When starting the VBS4 Admin Client, the Battlespaces tab is selected by default.
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 2. Click the POI Icon.

The Points of Interest Panel opens.

 3. In the Points of Interest Panel, select Bystrzyca Klodzka, PL, and click Go to.

The Whole-Earth Terrain rotates directly above the Bystrzyca Klodzka terrain in Poland.
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 4. In the Search Bar of the VBS4 Toolbar, input the coordinates 50°20′46″N, 16°38′08″E, and then 
press Enter.

Use the Mouse Scroll Wheel to zoom in to view the area displayed in the following image:

 5. Click + New Battlespace and click the location of the yellow circle.

The Create Battlespace dialog opens, displaying the selected coordinates.
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 6. Input the following details in the Create Battlespace dialog:

Parameter Value

Name My_Convoys

Color Green #36b82c

Tags MyUseCase

Description Convoys Use Case

 7. Click Save Changes.

VBS4 adds the Battlespace to the Battlespaces List.

 8. Select the newly created My_Convoys Battlespace to show a green icon added to the Whole-
Earth Terrain in the designated location.
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 9. Under Prepare > Editor, click Create.

The Battlespace opens in VBS Editor (Prepare Mode) in the 2D View.

  TIP 
If required, toggle terrain textures in the 2D View, select View > Hide / Show Texture.

Use the Classic Camera Controls to move the camera:

 10. In the Tools Panel, select (F4) Vehicle, and click a location on the white road, where you want 
the lead convoy vehicle to be.

 11. In the Object Properties dialog, select the US Army Wheeled - Woodland > M1114 HMMWV 
vehicle.
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 12. Select Control AI as the AI type, and click OK.

 13. Place three more convoy vehicles south of the lead vehicle, along the road.

The convoy vehicles should look like this:

 14. Link each of the three bottom vehicles with the lead vehicle:

 a. Hold LShift and click any of the three bottom vehicles.

 b. Click the lead vehicle.

The convoy vehicles now form a group.

 15. Hold LShift, click the lead vehicle, and click a location on the map, northeast up the road, 
where you want your convoy to drive.

The Control AI - Waypoints Object Properties dialog opens.
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 16. In the Object Properties dialog, in the Behavior list, select Convoy (leave the other settings as 
they are) and click OK.

The Convoy Order appears on the map.

 17. Hold LShift, click the Convoy Order, and click a location on the map, north up the road, where 
you want the second Convoy Order to be.

The Control AI - Waypoints Object Properties dialog opens.

 18. In the Object Properties dialog, in the Behavior list, select Convoy (leave the other settings as 
they are) and click OK.

The second Convoy Order appears on the map.

 19. In the Tools Panel, select (F1) Unit and place a VBS Objects > Invisible spectator (walking) 
Player unit, anywhere on the map, where the Scenario takes place.
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 20. Expand the Main Menu, and under Battlespaces, select Save.

The Scenario is saved.

 21. Click Preview to preview the Scenario.

 22. Press Pause (Esc) and in the VBS4 Toolbar, select Editor and press Map (M), to switch to the 
3D View.

Observe the vehicle convoy driving to its first and second Convoy Order destination.

  NOTE 
The Convoys Scenario is also available as a sample Battlespace on VBS World Server or in:

\VBS_Installation\optional\Demo_Scenarios\Battlespaces\

Compare your version of the scenario to the sample by deploying the sample Battlespace 
to VBS4.

Follow these steps:

 l For Online use cases, do the steps in Copy Battlespace (below) on the VBS World 
Server computer, and then synchronize the Battlespace on the VBS4 Client connected 
to VBS World Server.

 l For Offline use cases, copy the Battlespace from the \optional\ folder.

Copy Battlespace

 1. Open the following folder in Windows File Explorer:

\VBS_Installation\optional\Demo_Scenarios\Battlespaces\

 2. Copy the UseCase_Name folders to your local Battlespaces Folder (on page 83) at:

\Documents\VBS4\Battlespaces\

Use the Battlespaces List to Filter Battlespaces (on page 80) using UseCase as the filter.

Select the sample Battlespace and select Prepare > Editor > Open to review the Scenario 
using VBS Editor.
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11.1.2 Convoy Preparation
As an administrator, use VBS Editor in Prepare mode to create a Convoy Scenario.

Follow these steps:

 1. Use VBS Editor to create a new Scenario, or edit an existing one.

 2. VBS4 has vehicles with specific convoy functionality, including the following:

Vehicle Description

VBS Vehicle Any vehicle that has a VBS AI or player-controlled driver (set to Player or 
Playable).

Control AI 
Vehicle

Any vehicle that has a Control AI driver.
For Control AI convoys, see Convoy AI in the VBS4 Editor Manual.

  WARNING 
Players cannot take control of Control AI vehicles.

Add vehicles to the scenario.

For more information on placing vehicles, see Adding Vehicles in the VBS4 Editor Manual.

 3. Add additional objects and equipment.

VBS4 includes a specific set of Editor Objects and equipment for Convoy scenarios:

Additional 
Object / 
Equipment

Description

Road Signs Road signs can be used to regulate convoy movement. For more information, see 
Military Road Signs - Scenario Design in the VBS4 Editor Manual.

  NOTE 
Road signs are only used for guidance by players in the simulation, and 
affect neither VBS AI nor Control AI convoys.
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 4. Full AI Convoy - In the case of a fully AI-controlled convoy, do the following:

 a. Make sure that all crew members are in the convoy vehicles (see step 2 of the procedure, 
and the difference between (F4) Vehicle and (F5) Empty Vehicle in the Editor Objects 
List).

 b. Make sure that all the vehicle crew members are AI-controlled. For more information, see 
the AI options in Edit Vehicle Options in the VBS4 Editor Manual.

 c. Link the convoy vehicles into a group. For more information, see Creating and Adding to 
Groups with Links in the VBS4 Editor Manual.

 d. Add convoy Waypoints:

 l In the case of Control AI, add Control AI Waypoints. For more information, see Control 
AI Waypoints in the VBS4 Editor Manual.

 l In the case of VBS AI, add VBS Waypoints. For more information, see Assigning 
Behavior Using Waypoints in the VBS4 Editor Manual.

 5. AI and Player Convoy - In the case of a convoy with a mix of AI and player-controlled units, do 
the following:

 a. Make sure that all crew members are in the convoy vehicles (see the previous procedure 
step, and the difference between (F4) Vehicle and (F5) Empty Vehicle in the Editor 
Objects List).

 b. Set the vehicle crews to either Game AI / Control AI or Player / Playable (see Adding Units 
in the VBS4 Editor Manual).

 c. Link the convoy vehicles into a group.

  WARNING 
It is not possible to mix Control AI and Player units in a group.

 d. Add a convoy Waypoint to Game AI / Control AI crew vehicles:

 l In the case of Control AI, add Control AI Waypoints. For more information, see Control 
AI Waypoints in the VBS4 Editor Manual.

 l In the case of VBS AI, add VBS Waypoints. For more information, see Assigning 
Behavior Using Waypoints in the VBS4 Editor Manual.
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 6. Full Player Convoy - In the case of a convoy that consists only of player-controlled units, do 
the following:

 a. Place vehicles and crews.

  NOTE 
Vehicles and crews do not need to be linked to form groups, and crews can start 
the scenario outside the vehicles.

 7. Scripted Convoy - You can use any SQF scripts to control the convoy.

For example, you can use the Initialization Statements of a unit to instantaneously place the 
unit in a vehicle as:

 l Driver - moveInDriver (https://sqf.bisimulations.com/display/SQF/moveInDriver)

 l Gunner - moveInGunner (https://sqf.bisimulations.com/display/SQF/moveInGunner)

 l Commander - moveInCommander 
(https://sqf.bisimulations.com/display/SQF/moveInCommander)

 l Cargo - moveInCargo (https://sqf.bisimulations.com/display/SQF/moveInCargo)

For more information, see Using Basic Scripts in the VBS4 Scripting Manual.

 8. Preview and save the mission.

For more information, see Scenario Preparation (on page 85).

11.1.3 Convoy Execution
Once the Convoy Scenario is prepared by the administrator, it can be executed.

Start the Scenario and open VBS Editor.

For more information, see Scenario Execution (on page 89).

Use the Editor UI to  modify the scenario as it runs.

A typical convoy scenario has the following phases:

 1. If the crew members are not in the vehicles, they enter them, occupying the required positions 
(driver / commander / gunner / cargo).

 l For AI units, Waypoints can be used to get to and enter vehicles.

For more information, see Assigning Behavior Using Waypoints (for VBS AI) and Control AI 
Waypoints (for Control AI) in the VBS4 Editor Manual.

 l For role-playing, players use movement controls and 3D World Actions (see Interact with 
Vehicles Interface (IWV) in the VBS4 Trainee Manual) to enter vehicles.
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 2. The vehicles in the convoy drive.

 l Players can do the following:

 o As drivers, drive the vehicles. For more information, see Land Vehicle Controls in the 
VBS4 Trainee Manual.

 o As group leaders / vehicle commanders, order AI drivers where to go:

As a group leader, click the map to order a vehicle to move to a position.

As a subordinate vehicle commander, use the Command Menu to order the vehicle 
driver to return to formation.

For more information, see Commanding Subordinates in the VBS4 Trainee Manual.

 o Switch vehicle positions and assume different roles to control the vehicle. For more 
information, see Interact with Vehicles Interface (IWV) in the VBS4 Trainee Manual.

 o Use radio communication. For more information, see VBS Radio Overview (on 
page 141).

 o Use road signs to regulate convoy movement. For more information, see Military Road 
Signs in the VBS4 Trainee Manual.

 l The AI can:

 o Follow Waypoints. See Assigning Behavior Using Waypoints (for VBS AI) and Control 
AI Waypoints (for Control AI) in the VBS4 Editor Manual.

 o Use traffic lights and take civilian traffic and pedestrians into account.

For more information, see Civilian AI in the VBS4 Editor Manual.
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11.2 Enemy Ambush
This use case simulates a general enemy ambush, using role play (player control) and AI.

For IED Ambush, see the Improvised Explosive Device Ambush (on page 189) use case 
documentation.

For a walkthrough example of a simple Enemy Ambush scenario, see the following:

 l AI on Rails Enemy Ambush Example (below)

The general workflow of an Enemy Ambush simulation in VBS4 contains two parts:

 l Enemy Ambush Preparation (on page 184)

 l Enemy Ambush Execution (on page 185)

For Enemy Ambush examples that have Preparation and Execution phases, see the following:

 l Enemy Ambush with Triggers and Waypoints (on page 186)

 l UPR Enemy Ambush (on page 187)

11.2.1 AI on Rails Enemy Ambush Example
You can create an Enemy Ambush scenario with AI on Rails, which is similar to Unit Path 
Recording (UPR), but works with Control AI entities and is easier to use. 

  NOTE 
To use AI on Rails, make sure that the Enemy Ambush group is set to Control AI. For more 
information, see Control AI Waypoints in the VBS4 Editor Manual.

Follow these steps:

 1. In the VBS4 Toolbar of the Battlespaces mode, select the Battlespaces tab.

  NOTE 
When starting the VBS4 Admin Client, the Battlespaces tab is selected by default.
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 2. Click the POI Icon.

The Points of Interest Panel opens.

 3. In the Points of Interest Panel, select Bystrzyca Klodzka, PL, and click Go to.

The Whole-Earth Terrain rotates directly above the Bystrzyca Klodzka terrain in Poland.
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 4. In the Search Bar of the VBS4 Toolbar, input the coordinates 50°20′34″N, 16°38′10″E, and then 
press Enter.

Use the Mouse Scroll Wheel to zoom in to view the area displayed in the following image:

 5. Click + New Battlespace and click the location of the yellow circle.

The Create Battlespace Dialog opens, displaying the selected coordinates.

 6. Input the following details in the Create Battlespace dialog:

Parameter Value

Name My_Enemy_Ambush

Color Green #36b82c

Tags MyUseCase

Description Enemy Ambush Use Case
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 7. Click Save Changes.

VBS4 adds the Battlespace to the Battlespaces List.

 8. Select the newly created My_Enemy_Ambush Battlespace to show a green icon added to the 
Whole-Earth Terrain in the designated location.

 9. Under Prepare > Editor, click Create.

The Battlespace opens in VBS Editor (Prepare mode) in the 2D View.

  TIP 
If required, toggle terrain textures in the 2D View, select View > Hide / Show Texture.
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 10. Press Map (M) to switch to the 3D View of VBS Editor, and move the camera to the south, so 
that three houses are in view to the right of the road, as indicated in the following image:

Use the Classic Camera Controls to move the camera:

 11. In the Tools Panel, select (F4) Vehicle, and click a location on the road, north of the farthest 
house, to place a BLUFOR vehicle.
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 12. In the Object Properties dialog, select the US Army Wheeled - Woodland > M1114 HMMWV 
vehicle.

 13. Select Control AI as the AI type, and click OK.

The BLUFOR vehicle is placed.

 14. Hold LShift + RMB and move the mouse left / right to rotate the vehicle, so that it aligns with 
the road, facing south. Press Map (M) to switch between 2D / 3D View.

The vehicle is positioned as indicated in the following image:

 15. Hold LShift, click the vehicle, and click a location on the map, after the southernmost house in 
view, where you want the vehicle to drive.

The Control AI - Military Object Properties dialog opens.

 16. In the Object Properties dialog Behavior drop-down, select Convoy (leave the other settings as 
they are) and click OK.

A Convoy Order appears on the map.

 17. Press Map (M) to switch to the 2D View.
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 18. In the Tools Panel, select (F7) Trigger, and double-click using LMB on a location to the south 
of the vehicle opposite the second house down the road.

The Trigger Object Properties dialog opens.

 19. In the Object Properties dialog, set the following properties:

 l Size (Left-Right): 10

 l Size (Up-Down): 10

 l Activation: BLUFOR

 l Activation Type: Present

 20. Click OK.

A Trigger appears on the map.

 21. Press Map (M) to switch to the 3D View.

 22. In the Tools Panel, select (F1) Unit, and click a location behind the southernmost house, so 
that the location is obscured from view to the vehicle.

 23. In the Object Properties dialog, select the Generic OPFOR Woodland > Soldier - AK74 unit.

 24. Select Control AI as the AI type, and click OK.

The OPFOR unit is placed.
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 25. Hold LShift + RMB and move the mouse left / right to rotate the unit, so that it faces the road.

The unit is positioned as indicated in the following image:

 26. Press Map (M) to switch to the 2D View.

 27. Hold LShift, click the unit, and click a location next to the road and opposite the southernmost 
house.

The Control AI - Waypoints Object Properties dialog opens.

 28. In the Object Properties dialog, in the Behavior list, select Individual - Fire At.

 29. Set the following properties:

 l Speed: Run

 l Stance: Crouched

 l Weapon stance: Raised

 l Weapon: Primary

 l Firing mode: Burst

 l On enemy spotted: Open Fire

 l On direct fire: Open Fire

 l Target (SQF code): blufor_target
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 30. Click OK.

The AI on Rails Individual - Fire At Order is placed.

In the 3D View, the Individual - Fire At Order visual proxy is displayed in green.
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 31. Hold LShift + RMB and move the mouse left / right to rotate the Individual - Fire At Order, so 
that it faces the road in the following way:

 32. Double-click the BLUFOR vehicle, set Name to blufor_target, and click OK.

 33. In 2D View, Hold LShift, click the Individual - Fire At Order, and click the Trigger.

The Trigger is linked to the Individual - Fire At Order.
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 34. In the Tools Panel, select (F1) Unit and place a VBS Objects > Invisible spectator (walking) 
Player unit, anywhere on the map, where the Scenario takes place.

 35. Expand the Main Menu, and under Battlespaces, select Save.

The Scenario is saved.

 36. Click Preview to preview the Scenario.

 37. Press Pause (Esc) and in the VBS4 Toolbar, select Editor and press Map (M), to switch to the 
3D View.

Observe how, once the BLUFOR vehicle enters the Trigger area, the OPFOR unit runs crouched and 
/ or crouches to attack the BLUFOR vehicle.

This example Scenario is expanded in Command-Detonated IED Ambush Example (on page 189), 
where an IED detonates first, followed by an OPFOR unit ambush.

  NOTE 
The Enemy Ambush Scenario is also available as a sample Battlespace on VBS World 
Server or in:

\VBS_Installation\optional\Demo_Scenarios\Battlespaces\

Compare your version of the scenario to the sample by deploying the sample Battlespace 
to VBS4.

Follow these steps:

 l For Online use cases, do the steps in Copy Battlespace (below) on the VBS World 
Server computer, and then synchronize the Battlespace on the VBS4 Client connected 
to VBS World Server.

 l For Offline use cases, copy the Battlespace from the \optional\ folder.

Copy Battlespace

 1. Open the following folder in Windows File Explorer:

\VBS_Installation\optional\Demo_Scenarios\Battlespaces\

 2. Copy the UseCase_Name folders to your local Battlespaces Folder (on page 83) at:

\Documents\VBS4\Battlespaces\

Use the Battlespaces List to Filter Battlespaces (on page 80) using UseCase as the filter.

Select the sample Battlespace and select Prepare > Editor > Open to review the Scenario 
using VBS Editor.
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11.2.2 Enemy Ambush Preparation
As an administrator, use VBS Editor in Prepare mode to create an Enemy Ambush Scenario.

Follow these steps:

 1. Use VBS Editor to create a new Scenario, or edit an existing one.

 2. VBS4 has units with specific functionality for Enemy Ambush, including the following:

Unit Description

OPFOR 
Unit

Any OPFOR unit that can be used to simulate Enemy Ambush.

  NOTE 
If you want to control the ambush units at the start of the scenario, they have to 
be set to Player or Playable. If you want to use AI on Rails  (see the  VBS Control AI 
Behavior Pack Manual), set the unit to Control AI.

Add personnel to the scenario.

For more information on placing units, see Adding Units in the VBS4 Editor Manual.

 3. VBS4 has vehicles with specific functionality for Enemy Ambush, including the following:

Vehicle Description

OPFOR 
Vehicle

Any OPFOR vehicle that can be used to simulate Enemy Ambush.

  NOTE 
If you want to control the ambush vehicles at the start of the scenario, they 
have to be set to Player or Playable.

Add vehicles to the scenario.

For more information on placing vehicles, see Adding Vehicles in the VBS4 Editor Manual.

 4. You can set the accuracy of your Enemy Ambush units, and control additional enemy 
engagement rules by using the AI Rules of Engagement in the VBS4 Editor Manual.

 5. Add Waypoints and Triggers to Enemy Ambush personnel and vehicles.

You can add Waypoints for the enemy forces to attack. The Waypoint execution uses Triggers.

For more information, see Assigning Behavior Using Waypoints (if using VBS AI), Control AI 
Waypoints (if using Control AI), and Triggers in the VBS4 Editor Manual.
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 6. You can use Unit Path Recording (UPR) to make ambushes from buildings or from a certain 
position, and to make ambush units perform particular actions, to initiate an ambush. For 
more information, see UPR Enemy Ambush (on page 187).

 7. If your OPFOR units are set to Control AI, you can use AI on Rails to perform the Enemy 
Ambush. For more information, see AI on Rails Enemy Ambush Example (on page 173).

 8. Besides direct fire, you can also use indirect fire functionality in an Enemy Ambush.

VBS4 has specific functionality for indirect fire, including the following:

Indirect Fire 
Functionality

Description

VBS Call For Fire VBS Call For Fire provides a simulated Fire Direction Center (FDC) to setup and 
enable rapid fire support.
For more information, see VBS Call for Fire Overview (on page 107).

Artillery Strike The Artillery Strike Editor Object allows real-time artillery support.
For more information, see Artillery Strike in the VBS4 Editor Manual.

Fire Support Some AI-controlled vehicles can provide fire support.
For more information, see Fire Support in the VBS4 Instructor Manual.

 9. Add additional BLUFOR units and / or vehicles.

 10. Preview and save the mission.

For more information, see Scenario Preparation (on page 85).

11.2.3 Enemy Ambush Execution
As an administrator, use VBS Editor in Execute mode to run an Enemy Ambush Scenario.

Start the Scenario and open VBS Editor.

For more information, see Scenario Execution (on page 89).

Use the Editor UI to  modify the scenario as it runs.

A typical Enemy Ambush scenario has the following phases:

 1. BLUFOR units and / or vehicles pass through Trigger area (see Triggers in the VBS4 Editor 
Manual) area.

 2. The Trigger activates on BLUFOR presence, and OPFOR ambush units attack.

 3. Wounded units can request medical assistance  from medics.
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11.2.4 Enemy Ambush with Triggers and Waypoints
A basic Enemy Ambush involves a Trigger and Waypoints (see Assigning Behavior Using 
Waypoints in the VBS4 Editor Manual).

Follow these steps:

 1. Create a Trigger with the following properties:

 l Activation: BLUFOR

 l Activation Type: Present

The Trigger is activated, when a BLUFOR unit or vehicle enters the Trigger area.

 2. Create a Move Waypoint (see Appendix 1 - Waypoint Types in the VBS4 Editor Manual), where 
the ambush group waits before the ambush begins. Set the following Waypoint properties:

 l Combat: Never Fire / Hold Fire

 l Behavior: Stealth / Careless

 l Formation: Column (Compact) / Any

 3. Create a Move Waypoint, where the ambush group moves to start the ambush. Set the 
following Waypoint properties:

 l Combat: Open Fire / Open Fire, Engage at Will

 l Behavior: Aware / Combat

 4. Right-click the Waypoint, where the ambush group waits before the ambush, select Sync to 
Trigger and click the Trigger.

In the scenario Execution phase, the ambush group waits at the first Waypoint, until the 
Trigger is activated. The Trigger causes the group to move to the next Waypoint and start the 
ambush.

 5. Start the scenario.

 6. You can add waypoints during the Execution phase in VBS Editor.

 7. In VBS Editor, right-click the unit and select Switch to Unit (see Interacting with Editor Objects 
in the VBS4 Editor Manual), to take control of the AI unit.
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11.2.5 UPR Enemy Ambush
You can use Unit Path Recording (UPR) to make ambushes from buildings or from a certain 
position, and to make ambush units perform particular actions, to initiate an ambush.

Follow these steps:

 1. Create a Trigger with the following properties:

 l Activation: BLUFOR

 l Activation Type: Present

 l On Activation: ambush_start = true;

The Trigger is activated, when a BLUFOR unit or vehicle enters the Trigger area.

 2. Set an OPFOR ambush unit to be the player.

 3. Preview the scenario.

 4. Open the VBS Editor, select Tools > Enable Record Path Hot Key, and close the VBS Editor.

 5. Press Player Path Recording (P) to enable path recording.

 6. As a player, perform the OPFOR unit ambush actions, such as moving to a position and firing 
different weapons.

 7. Press Player Path Recording (P) again, enter a name for the recording, and save it.

 8. Press Esc, open the VBS4 Main Menu (on page 36), then select Exit Battlespace to exit the 
Battlespace and return to Prepare mode.

 9. Create a UPR Editor Object (EO).

 10. Select the recording that you saved.

  WARNING 
To enable the recording in multiplayer, make sure to check Mission Folder, to save the 
recording in the Battlespace folder.

 11. Set Replay Condition to: !isNil {ambush_start}

  WARNING 
The recommended condition pattern is !isNil {global_variable}. The condition 
must always return a true or false result (not an undefined result) throughout the 
scenario. Otherwise, the UPR fails to activate.

 12. Link the UPR EO to the OPFOR unit.

 13. Set the player as another unit.

 14. Save the scenario.
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 15. Preview the scenario.

 16. Activate the BLUFOR Trigger you created in the Preparation phase, and observe the results of 
the ambush.
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11.3 Improvised Explosive Device Ambush
This use case simulates an IED Ambush, when IEDs / mines explode and enemy forces ambush 
the detonation location.

The IED Ambush use case is related to the Route Clearance (on page 199) use case.

For a walkthrough example of a simple IED Ambush scenario, see:

 l Command-Detonated IED Ambush Example (below)

The general workflow of an IED Ambush simulation in VBS4  contains two parts:

 l IED Ambush Preparation (on page 194)

 l IED Ambush Execution (on page 196)

For IED Ambush examples that have Preparation and Execution phases, see the following:

 l Victim-Initiated IED Ambush (on page 197)

 l Suicide Bomber IED Ambush (on page 198)

11.3.1 Command-Detonated IED Ambush Example
A command-detonated IED Ambush expands the AI on Rails Enemy Ambush Example (on 
page 173) Scenario, by adding an IED, which is detonated prior to an enemy ambush.

Follow these steps:

 1. Follow the steps 1 - 35 in the AI on Rails Enemy Ambush Example (on page 173) Scenario.

 2. Expand the Main Menu, and under Battlespaces, select Save As.

The Save As dialog opens.
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 3. In Name, type My_IED_Ambush

 4. Click Save Changes.

 5. Expand the Main Menu, and select Close Prepare and click Save and Close.

VBS4 returns to Battlespaces Mode.

 6. In the Battlespaces tab, Select the My_IED_Ambush Battlespace, and click the Edit icon.

The Edit Battlespace dialog opens.

 7. Input the following details in the Edit Battlespace dialog:

Parameter Value

Description IED Ambush Use Case

 8. Click Save Changes.
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 9. Select the My_IED_Ambush Battlespace, and under Prepare > Editor, click Open.

The Battlespace opens in the VBS Editor (Prepare Mode) in the 2D View.

  TIP 
If required, toggle terrain textures in the 2D View, select View > Hide / Show Texture.

Use the Classic Camera Controls to move the camera:
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 10. Drag the BLUFOR vehicle, and place it north up the road.

This gives the vehicle more time to reach the Trigger.

 11. In the Tools Panel, select IED, and click a location, left of the road, next to the Trigger.

The IED Object Properties dialog opens.

 12. In the Object Properties dialog, set the following properties:

 l Type: Soda Can 2

 l Explosion Size: Small

 l Explosion Type: Wound Only

 l Trigger Type: Admin and Bomb Carrier

 13. Click OK.

The IED is placed.
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 14. Hold LShift, click the IED, and click the Trigger.

The Trigger is linked to the IED, which makes the IED detonate when the BLUFOR vehicle 
enters the Trigger area. Since the IED Trigger Type setting is set to Admin and Bomb Carrier, 
you can also detonate the IED as the Scenario Administrator before the vehicle enters the 
Trigger area (see step 17).

 15. Click Preview to preview the Scenario.

 16. Press Pause (Esc) and in the VBS4 Toolbar, select Editor and press Map (M), to switch to the 
3D View.

 17. As an Administrator, you can detonate the IED before the BLUFOR vehicle enters the Trigger 
area, by right-clicking Soda Can 2 in the Scenario Objects Panel and selecting Explode IEDs.

Observe how the IED detonates either by the Administrator or by the BLUFOR vehicle entering the 
Trigger area, after which, the OPFOR unit  crouches to attack the BLUFOR vehicle.
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  NOTE 
The IED Ambush Scenario is available as a sample Battlespace on VBS World Server or in:

\VBS_Installation\optional\Demo_Scenarios\Battlespaces\

Compare your version of the scenario to the sample by deploying the sample Battlespace 
to VBS4.

Follow these steps:

 l For Online use cases, do the steps in Copy Battlespace (below) on the VBS World 
Server computer, and then synchronize the Battlespace on the VBS4 Client connected 
to VBS World Server.

 l For Offline use cases, copy the Battlespace from the \optional\ folder.

Copy Battlespace

 1. Open the following folder in Windows File Explorer:

\VBS_Installation\optional\Demo_Scenarios\Battlespaces\

 2. Copy the UseCase_Name folders to your local Battlespaces Folder (on page 83) at:

\Documents\VBS4\Battlespaces\

Use the Battlespaces List to Filter Battlespaces (on page 80) using UseCase as the filter.

Select the sample Battlespace and select Prepare > Editor > Open to review the Scenario 
using VBS Editor.

11.3.2 IED Ambush Preparation
As an administrator, use VBS Editor in Prepare mode to prepare an IED Ambush mission.

Follow these steps:

 1. Use VBS Editor to create a new Scenario, or edit an existing one.

 2. Add any of the following standalone hazards to the IED Ambush scenario:

Hazard Description

Mines Place mines in your scenario. For more information, see Placing Mines in the VBS4 Editor 
Manual.

IEDs Place IEDs in the scenario. For more information, see Placing IEDs in the VBS4 Editor 
Manual.
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 3. VBS4 has units with specific functionality for IED Ambush, including the following:

Unit Description

Suicide 
Bomber

Any OPFOR unit with "Suicide Bomber" in its name. For example:
 l AF Civilians > Female Suicide Bomber - Light Blue
 l IQ Civilians > Suicide Bomber 1 - Suicide Bomber 6

OPFOR units, such as the Taliban, have explosive belts. For example:
 l Any unit in the AF Taliban category.

Triggerman Any unit that activates the IED.

Observer Any unit that watches for targets, and signals the triggerman and / or the ambush 
unit.
You can equip the observer with binoculars. For more information, see Edit 
Equipment Loadout in the VBS4 Editor Manual.

Ambush Unit Any OPFOR unit.

For more information on how suicide bombers and / or triggermen can be attached to activate 
an IED, see Attaching IEDs to Units and Vehicles in the VBS4 Editor Manual.

Add personnel to the scenario.

For more information on placing units, see Adding Units in the VBS4 Editor Manual.

 4. VBS4 includes specific functionality for vehicles for IED Ambush, including the following:

Vehicle Description

Any 
Vehicle

Attach an IED to any vehicle to create a VBIED.
For more information, see Attaching IEDs to Units and Vehicles in the VBS4 Editor 
Manual.

Add vehicles to the scenario.

For more information on placing vehicles, see Adding Vehicles in the VBS4 Editor Manual.
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 5. Add additional objects and equipment.

VBS4 includes a specific set of Editor Objects and equipment for IED Ambush scenarios:

Additional Object / Equipment Description

IED Indicators You can use visual indicators, to designate IEDs:
 l Objects > Objects - IED

You can also use decoys and clutter objects, to hide IEDs:
 l Objects > Objects - Outdoor
 l Objects > Scenery - Misc

For more information, see the respective topics in the VBS4 Editor Manual.

 6. Add Waypoints and Triggers to IED Ambush personnel and vehicles.

You can add Waypoints for the enemy forces to attack (both for personnel, such as the 
ambush units, and vehicles, such as the VBIED vehicles). The Waypoint execution uses 
Triggers.

For more information, see Assigning Behavior Using Waypoints (if using VBS AI), Control AI 
Waypoints (if using Control AI), and Triggers in the VBS4 Editor Manual.

 7. Add additional BLUFOR units and / or vehicles.

 8. Preview and save the mission.

For more information, see Scenario Preparation (on page 85).

11.3.3 IED Ambush Execution
Once the IED Ambush scenario is prepared by the administrator, it can be executed.

Start the Scenario and open VBS Editor.

For more information, see Scenario Execution (on page 89).

Use the Editor UI to  modify the scenario as it runs.

A typical IED Ambush scenario has the following phases:
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 1. BLUFOR units and / or vehicles pass through an area.

 2. An enemy observer spots the BLUFOR units / vehicles, signals to the triggerman, and the latter 
detonates the IED.

The spotting is usually done with binoculars.  For more information, see the use of binoculars 
in Standard Equipment (infantry units) and Personal Equipment Controls (vehicle crew) in the 
VBS4 Trainee Manual.

The following detonation types are available:

IED 
Detonation 
Type

Description

Administrator 
Triggered

As an administrator, you can detonate IEDs manually. For more information, see 
Detonating an IED in the VBS4 Editor Manual.

Role-Play 
Detonation

The player, in the role of a triggerman, detonates the IED. For more information, see 
Trigger Type in the VBS4 Editor Manual.

Automatic 
Trigger

Automatic triggering (for example, by proximity, using a timer, or driving over a 
mine). For more information, see Trigger Type and Attaching IEDs to Triggers in the 
VBS4 Editor Manual.

 3. OPFOR units ambush the BLUFOR units / vehicles at the detonation site.

An IED Ambush uses either an enemy group on foot or in vehicle (VBIED).

For more information on how to simulate enemy ambush, see the Enemy Ambush (on 
page 173) use case.

 4. Wounded units can request medical assistance  from medics.

11.3.4 Victim-Initiated IED Ambush
A victim-initiated IED Ambush occurs when BLUFOR units and / or vehicles step on / drive over, or 
come within a detonation-proximity range of the mine / IED.

For AI and player-controlled units / vehicles, follow these steps:

 1. Place an IED.

 2. Set Trigger Type (see Trigger Type in the VBS4 Editor Manual) to one of the following:

 l Proximity -  Set Prox. Side to BLUFOR or Any.

 l Pressure Plate
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11.3.5 Suicide Bomber IED Ambush
A suicide bomber IED Ambush involves a suicide bomber on foot or a VBIED vehicle:

  NOTE 
This example only has a player-controlled part.

For a player-controlled suicide bomber and VBIED vehicle, follow these steps:

 1. Place an IED.

 2. Set Trigger Type to one of the following:

 l Admin and Bomb Carrier for role-play Detonate IED User Action.

 l Proximity with Prox. Side set to BLUFOR.

  NOTE 
The Detonate IED User Action is also available. 

 l Admin Only, which can be detonated from VBS Editor by right-clicking the IED in the 
Scenario Objects Panel, and selecting Detonate IED.

 3. Select one of the following suicide bomber unit types:

 l Suicide bomber on foot:

 a. Right-click the IED, select Attach to Unit, and click the suicide bomber unit.

 l VBIED:

 a. Right-click the IED, select Attach to Vehicle, and click the VBIED vehicle.

 b. Position the IED object within the vehicle, or right-click the IED and select Hide IED, to 
make it invisible.

 4. In the OME, set the unit as Player or Playable. In VBS Editor, right-click the unit and select 
Switch to Unit to take control of the AI unit.

 5. To detonate the IED, select one of the following.

 l A role-play unit on foot selects the Detonate IED User Action.

 l A role-play VBIED vehicle driver selects the Detonate VBIEDs User Action.
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11.4 Route Clearance
The purpose of Route Clearance is to secure an important route and render it safe for transport. 
VBS4 supports Route Clearance for land mines and IEDs. 

For a walkthrough example of a simple Route Clearance scenario, see:

 l Husky T-MDV Route Clearance Example (below)

A typical Route Clearance group consists of the following:

 l A sapper platoon.
 l An EOD (Explosive Ordnance Disposal) 

team.

 l At least one medic.
 l A wrecker vehicle team.

The general workflow of a Route Clearance simulation in VBS4 contains two parts:

 l Route Clearance Preparation (on page 211)

 l Route Clearance Execution (on page 214)

11.4.1 Husky T-MDV Route Clearance Example
You can create a Route Clearance Scenario, using a Husky T-MDV vehicle. The Route Clearance 
Scenario clears hazards along the same route used in the Control AI Convoy Example (on 
page 161) Scenario.

Follow these steps:

 1. In the VBS4 Toolbar of the Battlespaces Mode, select the Battlespaces tab.

  NOTE 
When starting the VBS4 Admin Client, the Battlespaces tab is selected by default.
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 2. Click the POI Icon to open the POI Panel.

 3. In the Points of Interest Panel, select Bystrzyca Klodzka, PL, and click Go to.

The Whole-Earth Terrain rotates directly above the Bystrzyca Klodzka terrain, in Poland.
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 4. In the Search Bar of the VBS4 Toolbar, input the coordinates 50°20′46″N, 16°38′08″E, and then 
press Enter.

Use the Mouse Scroll Wheel to zoom in to view the area displayed in the following image:

 5. Click + New Battlespace and click the location of the yellow circle.

The Create Battlespace Dialog opens, displaying the selected coordinates.
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 6. Input the following details in the Create Battlespace dialog:

Parameter Value

Name My_Route_Clearance

Color Green #36b82c

Tags MyUseCase

Description Route Clearance Use Case

 7. Click Save Changes.

VBS4 adds the Battlespace to the Battlespaces List, and a green icon to the Whole-Earth 
Terrain.
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 8. Select the newly created My_Route_Clearance Battlespace, and under Prepare > Editor, click 
Create.

The Battlespace opens in the VBS Editor (Prepare Mode) in the 2D View.

  TIP 
If required, toggle terrain textures in the 2D View, select View > Hide / Show Texture.

Use the Classic Camera Controls to move the camera:

 9. In the Tools Panel, select (F4) Vehicle, and click a location on the white road where you want 
the Husky T-MDV vehicle placed.
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 10. In the Object Properties dialog, select the US Army Wheeled - Woodland > Husky - T-MDV, IA 
vehicle, and click OK.

  WARNING 
Make sure the Player is selected in Has Crew? / Special, so that the vehicle is 
playable:

The Husky T-MDV vehicle is placed.

 11. Hold LShift + RMB and move the mouse left / right to rotate the vehicle, so that it aligns with 
the road, facing north. Press Map (M) to switch between 2D / 3D View.

The vehicle is positioned as indicated in the following image:

 12. In the Tools Panel, select IED, and click a location on the map next to the road where it turns 
right.

The IED Object Properties dialog opens.

 13. In the Object Properties dialog, set the following properties:

 l Type: Bag 01

 l Explosion Size: Small

 l Explosion Type: Deadly

 l Trigger Type: Admin and Bomb Carrier
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 14. Click OK to place the IED.

 15. Place another IED, east of the first IED, next to the road, and set the following properties:

 l Type: Bag 02

 l Explosion Size: Small

 l Explosion Type: Fake (No Damage)

 l Trigger Type: Admin and Bomb Carrier

 16. Click OK to place the IED.

 17. In the Tools Panel, select Mine, and click a location on the road, where it turns north.

The Mine Object Properties dialog opens.

 18. In the Object Properties dialog, set the following properties:

 l Type: AT2 Anti-Tank Mine (Hidden)

 19. Click OK to place the mine.
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 20. Click Preview to preview the Scenario.

The Scenario starts with you in position of the Husky T-MDV driver and operator.

 21. Press Quick Menu (Left Windows) (see Quick Menu Actions in the VBS4 Trainee Manual), and 
select VEHICLE > ACTIVATE MINE DETECTOR.

The Husky T-MDV mine detector is activated, and the detector flaps are lowered on each side 
of the vehicle.

 22. Press Quick Menu (Left Windows), and select OPERATE IA.

The Interrogator Arm (IA) operation menu opens at the bottom of the screen.
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 23. Drive to the first IED, using the following vehicle controls:

The following table lists the Land Vehicle Controls, defaults, and option names from the 
Vehicle controls and Infantry controls category filters in the Controls Settings in the VBS4 
Administrator Manual:

  NOTE 
For Microsoft Xbox land vehicle controls, see Microsoft Xbox Controls.

Default Control Description Control Option Name

W
 

Forward Car Forward

  NOTE 
W does not reach the maximum speed. Use Car Fast Forward.

S Brake / Reverse Car Back

A / Mouse Left Turn Left Car Left / Car More Left

D / Mouse Right Turn Right Car Right / Car More Right

Q Slow Forward Car Slow Forward

E / LShift + W Fast Forward Car Fast Forward / Vehicle Turbo + Car Forward

LMB Horn Fire

 24. Operate the IA to pick up the first IED, using the following IA controls:

IA Action Control IA Action Control

Rotate arm left User Defined 1 Secondary boom up User Defined 7

Rotate arm right User Defined 2 Secondary boom down User Defined 8

Main boom up User Defined 3 Claw open User Defined 9

Main boom down User Defined 4 Claw close User Defined 10

Extend boom User Defined 5 Stow IA User Defined 11

Retract boom User Defined 6 Drop objects User Defined 12

    Disarm IEDs User Defined 13
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 25. Use the IA camera to assist you in operating the IA.

The IA variant of the Husky T-MDV has three ways of viewing the IA camera:

 l On-screen in the upper-right corner.

 l On the screen in the Husky cabin.

 l Full-screen.

Image-13: IED on screen, ready to be picked up

Image-14: Picked-up IED, ready to disarm

The IA picks up the IED automatically, once IA claw is adjusted and is close enough to the IED.
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 26. Press Quick Menu (Left Windows), and select VEHICLE > DISARM IEDS.

The message Bomb disarmed appears on screen.

 27. Press Quick Menu (Left Windows), and select VEHICLE > DROP OBJECTS.

The IA releases the disarmed IED.

 28. Repeat steps 21 - 24 for the second IED.

  TIP 
When you finished, stow the IA by selecting VEHICLE > STOW IA in the Quick Menu.

 29. Drive up the road over the hidden mine, until you see the following messages: MINE 
DETECTED and MARKING SPRAY DEPLOYED at the bottom of the screen.

The Husky T-MDV automatically marks the detected mine location with spray.
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  NOTE 
The Route Clearance Scenario is also available as a sample Battlespace on VBS World 
Server or in:

\VBS_Installation\optional\Demo_Scenarios\Battlespaces\

Compare your version of the scenario to the sample by deploying the sample Battlespace 
to VBS4.

Follow these steps:

 l For Online use cases, do the steps in Copy Battlespace (below) on the VBS World 
Server computer, and then synchronize the Battlespace on the VBS4 Client connected 
to VBS World Server.

 l For Offline use cases, copy the Battlespace from the \optional\ folder.

Copy Battlespace

 1. Open the following folder in Windows File Explorer:

\VBS_Installation\optional\Demo_Scenarios\Battlespaces\

 2. Copy the UseCase_Name folders to your local Battlespaces Folder (on page 83) at:

\Documents\VBS4\Battlespaces\

Use the Battlespaces List to Filter Battlespaces (on page 80) using UseCase as the filter.

Select the sample Battlespace and select Prepare > Editor > Open to review the Scenario 
using VBS Editor.
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11.4.2 Route Clearance Preparation
As an administrator, use VBS Editor in Prepare mode to prepare Route Clearance mission.

Follow these steps:

 1. Use VBS Editor to create a new Scenario, or edit an existing one.

 2. Add any of the following hazards to the Route Clearance scenario:

Hazard Description

Mines Place mines in your scenario. For more information, see Placing Mines in the VBS4 Editor 
Manual.

IEDs Place IEDs in the scenario. For more information, see Placing IEDs in the VBS4 Editor 
Manual.
In addition, you can use other visual indicators, to designate IEDs, such as the following:

 l Objects > Objects - IED
 l Objects > Objects - Outdoor
 l Objects > Scenery - Misc

For information on using IEDs in an ambush, see the Improvised Explosive Device 
Ambush (on page 189) use case.
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 3. VBS4 has units with specific functionality for Route Clearance, including the following:

Unit Description

EOD 
Bombsuit 
Technician 

An EOD technician wears a special bombsuit and can disarm IEDs:
 l US USMC Desert / Woodland > EOD - Bombsuit Technician

  NOTE 
Cannot disarm mines, but can be equipped with a Mine Marker Kit to detect 
and mark mines. For more information, see Mine Marker Kit in the VBS4 
Trainee Manual.

Bomb 
Detection 
Dog

A specially trained bomb detection dog can be used to locate IEDs:
 l Animals > German Shepherd - Bomb Detection Dog (MWD) (see Using Bomb 

Detection Dog in the VBS4 Trainee Manual)

  NOTE 
Cannot detect mines.

Medics A set of medical personnel available to treat injuries incurred as a result of trying to 
defeat the hazards. Each medic model name is prefixed with Medic.

Add personnel to the scenario.

For more information on placing units, see Adding Units in the VBS4 Editor Manual.
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 4. VBS4 has vehicles with specific functionality for Route Clearance, including the following:

Vehicle Description

IED and Mine 
Clearance

Engineering vehicles can be used for defeating hazards:
 l Buffalo (only defeats IEDs)
 l Husky - T-MDV, IA (only defeats IEDs)
 l Vehicles with mine rollers (defeat both mines and IEDs):

 o AU Army Wheeled - Desert / Woodland > Bushmaster - Troop 
Carrier, Mag 58, SMR2

 o US Army Wheeled - Woodland > M1132 Stryker ESV - M2 - Rollers
 o US Army Wheeled - Woodland > M1132 Stryker ESV - Mk19 - 

Rollers

 l MICLIC Vehicles (defeat both mines and IEDs):
 o M1150 Assault Breacher Vehicle
 o M60 - AVLM

Unmanned Vehicles UGVs, such as the Talon EOD, can be used to defeat hazards:
 l Unmanned Vehicles > Talon EOD (defeats both mines and IEDs)

Towing Vehicles Towing vehicles team.
For example, a wrecker-vehicle team tows damaged equipment and other 
vehicles:

 l MC3 - Wrecker and M1089 Wrecker

Another example is towing with a winch, for which the following vehicle model 
is available:

 l M88A2 - ARV

Other vehicles can tow by Enabling Automatic Towing in the mission.

Add vehicles to the scenario.

For more information on placing vehicles, see Adding Vehicles in the VBS4 Editor Manual.
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 5. Add additional objects and equipment.

VBS4 includes a specific set of Editor Objects and equipment for Route Clearance scenarios:

Additional 
Object / 
Equipment

Description

CREW Link Counter RCIED (Radio-Controlled Improvised Explosive Device) Electronic Warfare 
(CREW) can be used to jam IED signals, to disable detonation. For more information, 
see Enabling CREW in the VBS4 Editor Manual.

Mine Marker 
Kits

Place Mine Marker Kits (Objects > Mine Marker Kit) in your scenario to mark mines.

  NOTE 
Mine Marker Kits are usually used by specialized personnel, such as EOD 
bombsuit technicians, but any other type of unit can use them too.

For information on how to use the Mine Marker Kit, see Mine Marker Kit in the VBS4 
Trainee Manual.

 6. Add additional BLUFOR units and vehicles that are protected by the Route Clearance group.

For example, a Route Clearance group often accompanies a convoy. For more information on 
convoys, see the Convoys (on page 161) use case.

 7. Preview and save the mission.

For more information, see Scenario Preparation (on page 85).

11.4.3 Route Clearance Execution
Once the Route Clearance scenario is prepared by the administrator, it can be executed.

Start the Scenario and open VBS Editor.

For more information, see Scenario Execution (on page 89).

Use the Editor UI to  modify the scenario as it runs.

A typical Route Clearance scenario has the following phases:

Hazard Detection

Players perform hazard detection along the route.

VBS4 supports the following hazard detection functionality:
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Detection 
Simulation

Description

Husky T-
MDV

The Husky T-MDV vehicle has the following detection mechanisms:
 l Metal Detector (MD)
 l Ground Penetrating Radar (GPR)

Buffalo The Buffalo vehicle has an arm camera to detect hazards.
For more information, see Using the Buffalo in the VBS4 Trainee Manual.

UGV A UGV, such as the Talon EOD, can be deployed to investigate the scene.
For more information, see Using UGVs and Static Sensors in the VBS4 Trainee Manual.

Bomb 
Detection 
Dog

A Bomb Detection Dog (see Using Bomb Detection Dog in the VBS4 Trainee Manual) can 
be sent to spot hazards.

Binoculars Infantry units and vehicle crew can use binoculars.
For more information, see the use of binoculars in Standard Equipment (infantry units) 
and Personal Equipment Controls (vehicle crew) in the VBS4 Trainee Manual.

Defeat Hazards

If hazards are detected, an EOD team moves in to defeat  the hazards.

  NOTE 
As an administrator, you can detonate IEDs manually. For more information, see 
Detonating an IED in the VBS4 Editor Manual.

VBS4 supports the following hazard-defeat functionality:

Defeat 
Simulation

Description

Husky T-MDV The Husky T-MDV vehicle has the following hazard-defeat mechanisms:
 l Interrogator Arm (IA).
 l Mine Detonation Trailer (MDT). For more information, see Trailer in the VBS4 

Trainee Manual.
 l Force Protection Electronic Counter-Measures (FPECM).

Buffalo The Buffalo vehicle (see Using the Buffalo in the VBS4 Trainee Manual) can use its arm 
to pick an IED and move it to a safe location, where it can be destroyed.

Mine Clearing 
Roller Vehicle

Any of the supported Mine Clearing Roller vehicles (see Using Mine Clearing Rollers in 
the VBS4 Trainee Manual) can roll over mines and detonate them.
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Defeat 
Simulation

Description

MICLIC 
Vehicle

Any of the supported MICLIC vehicles (see Using MICLIC in the VBS4 Trainee Manual)  
can use the MICLIC launcher to detonate hazards.

CREW Device A CREW device can be used to disable certain IEDs from being triggered.
For more information, see Using CREW in the VBS4 Trainee Manual.

UGV A UGV, such as the Talon EOD can be used to remove and destroy IEDs.
For more information, see  in the VBS4 Trainee Manual.

EOD Bombsuit 
Technician

The US USMC Desert / Woodland > EOD - Bombsuit Technician unit can use 3D World 
Actions (see the VBS4 Trainee Manual) to disarm IEDs and mark mines.
For more information, see Using Improvised Explosive Devices (IEDs) and Mine Marker 
Kit in the VBS4 Trainee Manual.

If damage is sustained in the process of defeating the hazards, any of the following functionality is 
available:

 l Damaged equipment and / or vehicles can be towed away.

For more information, see Towing Vehicles in the VBS4 Trainee Manual.

 l Wounded units can request medical assistance  from medics.
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11.5 Artillery Support in VBS Plan
VBS Plan works together with VBS Call for Fire, and supports the execution of fire missions by all 
artillery tactical units in all the available ORBATs. These fire missions can be built in VBS Plan and 
are converted to VBS Call for Fire fire missions and gunlines that can be accessed and modified 
through the Fire Direction Center (FDC) UI (see VBS Call for Fire - FDC UI in the VBS Call for Fire 
Manual).

Add fire missions in VBS Plan using the Fire Mission Order (see Fire Mission Order Tool in the VBS 
Plan Manual).

In addition, VBS Plan supports tactical defense behaviors for all tactical units, besides artillery.

Add defense behaviors in VBS Plan using the Defend Order (see Defend Order Tool in the VBS Plan 
Manual).

For a walkthrough example of an artillery and defense scenario, see:

 l Artillery Support in VBS Plan Example (below)

The general workflow of an artillery and defense simulation in VBS4  contains two parts:

 l Artillery Support Preparation (on page 233)

 l Artillery Support Execution (on page 233)

11.5.1 Artillery Support in VBS Plan Example
The purpose of this example is to create an AU Army scenario with artillery and defense behaviors 
using VBS Plan.

The scenario takes place in Australia and consists of the following Tactical Units (see Units Tool in 
the VBS Plan Manual) and ambient wildlife:

 l BLUFOR AU Army units:

 o 1 Artillery Battery (M777)

 o 1 Troop (M1A1)

 o 2 Platoon (M113A4)

 l OPFOR units:

 o 1 Platoon (BMP-2)

 o 1 Platoon (T-80)

 l Ambient wildlife:

 o Kangaroos
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Scenario Execution Workflow

  NOTE 
Times are set in relation to the Elapsed / Mission Time, whichever is used. For more 
information, see Synchronize Time in the VBS4 Editor Manual.

 1. 2 Platoon (M113A4) execute an Advance Order (see Advance Order Tool in the VBS Plan 
Manual) and Assault Order (see Assault Order Tool in the VBS Plan Manual) on 1 Platoon 
(BMP-2), while the latter execute a Defend Order (see Defend Order Tool in the VBS Plan 
Manual).

 2. 1 Troop (M1A1) execute Suppress Orders (see Suppress Order Tool in the VBS Plan Manual) 
using an Objective Control Measure (see Objective Tool in the VBS Plan Manual) on 1 Platoon 
(BMP-2), while the latter continue executing the Defend Order.

 3. 1 Artillery Battery (M777) fire at 1 Platoon (BMP-2) using the Fire Mission Order (see Fire 
Mission Order Tool in the VBS Plan Manual) and Target Control Measure (see Target Tool in 
the VBS Plan Manual).

 4. 1 Platoon (T-80) counterattacks 2 Platoon (M113A4) and 1 Troop (M1A1) using an Assault 
Order, while 1 Artillery Battery (M777) executes a fire mission using VBS Call for Fire (see 
VBS Call for Fire - FDC UI and VBS Call for Fire Mission Management in the VBS Call for Fire 
Manual) on 1 Platoon (T-80).

The scenario is divided into Preparation and Execution phases:

 l Artillery Support Example Preparation (below)

 l Artillery Support Example Execution (on page 232)

11.5.1.1 Artillery Support Example Preparation
The Preparation phase consists of creating the Battlespace located in Australia, setting up the 
Tactical Units, Orders, Control Measures, and ambient wildlife.

Follow these steps:

 1. In the VBS4 Toolbar of the Battlespaces Mode, select the Battlespaces tab.

  NOTE 
When starting the VBS4 Admin Client, the Battlespaces tab is selected by default.
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 2. In the Search Bar of the VBS4 Toolbar, input the coordinates 30°23′31″S, 138°13′38″E, and 
then press Enter.

The Whole-Earth Terrain rotates directly above the specified location in Australia.

Use the Mouse Scroll Wheel to zoom in to view the area displayed.

 3. Click + New Battlespace and click the location of the yellow circle.

The Create Battlespace dialog opens, displaying the selected coordinates.
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 4. Input the following details in the Create Battlespace dialog:

Parameter Value

Name My_Artillery_Support

Color Green #36b82c

Tags MyUseCase

Description Artillery Support Use Case

 5. Click Save Changes.

VBS4 adds the Battlespace to the Battlespaces List.

 6. Select the newly created My_Artillery_Support Battlespace to show a green icon added to the 
Whole-Earth Terrain in the designated location.
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 7. Under Prepare > Plan, click Create.

The Battlespace opens in VBS Plan (Prepare mode) in the 2D View.

Use the Classic Camera Controls to move the camera:
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 8. In the Tools Panel, select the Tactical tab and click the Units  Tool.

The Tactical Units table appears (you can drag the bottom-right corner to resize the table).

 9. Place the following Tactical Units  next to one another:

 l One AU > Ground Unit > Artillery > Artillery Battery (M777)

 l One AU > Ground Unit > Tank > Troop (M1A1)

 l Two AU > Ground Unit > Mechanised Inf. > Platoon (M113A4)

 l One Generic Opfor > Ground Unit > Mechanized Infantry > Platoon (BMP-2)

 l One Generic Opfor > Ground Unit > Armor > Platoon (T-80)

Select a unit in the Tactical Units table, click Place (the Tactical Units table disappears - repeat 
the previous step to open the table again to select the other units), then click a position on the 
map to place the unit.
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 10. Drag the Tactical Units so that the positioning is as follows:

  NOTE 
Position Artillery Battery (M777) about 4.6 km from Platoon (BMP-2).

  TIP 
To measure the distance from the target, in the VBS4 Toolbar, select Editor and use 
the Measure Distance Tool in the VBS4 Editor Manual. After measuring the distance, 
you can delete the distance line, to avoid object cluttering.

The distance is measured between the VBS Plan unit symbols, rather than the built 
units (see step 18), and serves as an approximation of how the units should be 
positioned in relation to one another.

To go back to VBS Plan, select Plan in the VBS4 Toolbar.
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 11. Add a BLUFOR artillery Target:

 a. In the Tools Panel, select the Tactical tab.

 b. Expand Control Measures (expanded by default).

 c. Click the Target Tool.

 d. Click near Platoon (BMP-2).

 e. Set the following Specific Properties for the Target:

Specific Property Value

Target Type Rectangular

Azimuth 802

Width 400

Length 300

Name Artillery Target

 f. Click Create New Target.

The artillery Target is created.

 12. Add a BLUFOR Artillery Battery (M777) Fire Mission Order:

 a. Right-click  Artillery Battery (M777) and select Add Fire Mission Order.

 b. Set the following Specific Properties for the Fire Mission Order:

Specific Property Value

Available Targets Artillery Target (should already be set if no other Targets are created)

Rounds per Minute 3

Ammo Type HE

Time on Target 00:04

End Time 00:09
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 13. Add BLUFOR Platoon (M113A4) Move and Assault Orders:

 a. Right-click a Platoon (M113A4) and select Add Advance Order.

 b. Move the mouse to a position between Platoon (M113A4) and Platoon (BMP-2), and 
double-click it.

A Advance Order is created.

 c. Right-click the Advance Order and select Add Assault Order.

 d. Move the mouse to a position next to Platoon (BMP-2) and double-click it.

 e. Repeat for the other Platoon (M113A4).

 f. Drag the Advance Orders so that the positioning is as follows:
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 14. Add a BLUFOR Objective:

 a. In the Tools Panel, select the Tactical tab.

 b. Expand Control Measures (expanded by default).

 c. Click the Objective Tool.

 d. Set the following Specific Properties:

Specific Property Value

Name OPFOR BMP

Font Arial

Font Size 50m

Render Text on Surface Selected

 e. Place the Objective:

 i. Click near the position of Platoon (BMP-2) and hold the LMB.

 ii. Drag the mouse and release the LMB to set the initial size.

 iii. Drag any of the bounding-box points to change the Objective size, so that the 
Objective name fits in the Objective shape.
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 15. Add BLUFOR Troop (M1A1) Suppress Orders:

 a. Right-click Troop (M1A1) and select Add Suppress Order.

 b. Move the mouse to a position east of Troop (M1A1) and click it.

 c. Move the mouse to rotate the Suppress Order, so that it faces in the direction of Platoon 
(BMP-2). Click to confirm.

 d. Click the Suppress Order and in Orders > Selected Order Properties set the following 
Specific Properties:

Specific Property Value

Objective OPFOR BMP (should already be set, if no other Objectives are created)

Start Time 00:09

End Time 00:11

 e. Right-click the Suppress Order and select Add Suppress Order.

 f. Move the mouse to a position east of the Suppress Order and click it.

Another Support by Order is created.

 g. Rotate the Support by Order to face Platoon (BMP-2), click to confirm, and in Orders > 
Selected Order Properties set the following Specific Properties:

Specific Property Value

Objective OPFOR BMP (should already be set, if no other Objectives are created)

Start Time 00:16

End Time 00:17

The Suppress Orders should look like this:
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 16. Add an OPFOR Platoon (BMP-2) Defend Order: 

 a. Right-click Platoon (BMP-2) and select Add Defend Order.

The Defend Order symbol is attached to the cursor.

 b. Move the mouse to a position near and southwest of Platoon (BMP-2), and click it.

 c. Move the mouse to rotate the Defend Order, so that it faces in the direction of the non-
artillery BLUFOR Tactical Units. Double-click to confirm.

The Defend Order is created and should look like this:

 d. In Orders > Selected Order Properties, set the following Specific Properties for the Defend 
Order:

Specific Property Value

Text OPFOR Defend

Start Time 00:01

End Time 00:06

© 2023 - Bohemia Interactive Simulations - All Rights Reserved - 228 -



11. VBS Use Cases Documentation VBS4 23.2.0

 17. Add an OPFOR Platoon (T-80) Assault Order for a counterattack:

 a. Right-click a Platoon (T-80) and select Add Assault Order.

 b. Set the following Specific Properties for the Assault Order:

Specific Property Value

Start Time 00:20

Lane Width 200

 c. Double-click a position in the Defend Order rectangle. 

The Assault Order should look like this:

 18. Click Build Mission.

The Plan symbols are converted into mission entities and VBS Call for Fire fire missions and 
gunlines:

For more information, see Build Missions in the VBS Plan Manual.
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 19. Add Australian ambient wildlife (kangaroos):

 a. In the VBS4 Toolbar, select Editor.

 b. In the Editor Objects List, select (F1) Unit.

 c. Click a location where you want to place a kangaroo.

 d. In the Object Properties dialog, type Kangaroo in Filters or select Animals > Kangaroo.

 e. Select Game AI as the AI type, and click OK.

 f. Right-click the kangaroo and select Orders > Assign New Waypoint.

 g. Click a location where you want the kangaroo to move.

The Waypoint Object Properties dialog opens.

 h. Expand the Type drop-down, select MOVE, and click OK.

 i. Right-click the kangaroo and select Add New Waypoint.

 j. Add more waypoints as described in the previous step, and set the final waypoint to be 
next to the first waypoint.

 k. Right-click the final waypoint, and select Edit Object.

The Waypoint Object Properties dialog opens.

 l. Expand the Type drop-down, select CYCLE, and click OK.

The kangaroo waypoints should look like this:

 

 m. Repeat for more kangaroos, as required.
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 20. Add a player unit for the scenario administrator:

 a. In the Editor Objects List, select (F1) Unit.

 b. Click a location in the vicinity of the kangaroos.

 c. In the Object Properties dialog, select VBS Objects > Invisible spectator (RTE).

 d. Click OK.

The scenario is prepared for execution.

To run the scenario in Preview mode, press Scenario Preview (H).

  NOTE 
The Artillery and Defense Scenario is also available as a sample Battlespace in:

\VBS_Installation\optional\Demo_Scenarios\Battlespaces\

Compare your version of the scenario to the sample by deploying the sample Battlespace 
to VBS4.

Follow these steps:

 l For Online use cases, do the steps in Copy Battlespace (below) on the VBS World 
Server computer, and then synchronize the Battlespace on the VBS4 Client connected 
to VBS World Server.

 l For Offline use cases, copy the Battlespace from the \optional\ folder.

Copy Battlespace

 1. Open the following folder in Windows File Explorer:

\VBS_Installation\optional\Demo_Scenarios\Battlespaces\

 2. Copy the UseCase_Name folders to your local Battlespaces Folder (on page 83) at:

\Documents\VBS4\Battlespaces\

Use the Battlespaces List to Filter Battlespaces (on page 80) using UseCase as the filter.

Select the sample Battlespace and select Prepare > Editor > Open to review the Scenario 
using VBS Editor.
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11.5.1.2 Artillery Support Example Execution
The Execution phase is related to phase 4 of the Scenario Execution Workflow (on page 218), 
where the scenario administrator switches to VBS Call for Fire from VBS Plan to assign a fire 
mission to 1 Artillery Battery (M777) on 1 Platoon (T-80) in real-time.

Follow these steps:

 1. Wait for phases 1 - 3 of the Scenario Execution Workflow (on page 218) to finish, taking 20 
minutes from the start of the scenario.

 2. Press Pause (Esc) and in the VBS4 Toolbar, select Editor.

 3. Click the Fire Direction Center (FDC) tab to open the FDC UI.

 4. In the Main FDC Panel, select the BLUFOR tab and click New Mission.

 5. Set the fire mission settings (leave the other settings with their default values):

Setting Value

Mission Type Set to Immediate Suppression.

Time on Target Set to 00:20:00.

Gunlines Check AU_Army_Artillery M777 Battery.

Location Click the locator icon, and then click anywhere near 1 Platoon (T-80).

Trajectory Set to High.

Control Type Set to Continuous Fire.

 6. Click Process, and then click Schedule Mission.

1 Artillery Battery (M777) executes a fire mission on 1 Platoon (T-80).
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11.5.2 Artillery Support Preparation
As an administrator, use VBS Plan in Prepare mode to prepare an artillery and defense scenario.

Follow these steps:

 1. Use VBS Plan to create a new Scenario, or edit an existing one.

 2. Create BLUFOR artillery Units. See Create a Tactical Unit Object in the VBS Plan Manual.

Examples of available artillery Tactical Units include:

 l AU Army > Ground Unit > Artillery > Mortar Section (M252)

 l AU Army > Ground Unit > Artillery > Mortar Platoon (M252)

 l AU Army > Ground Unit > Artillery > Artillery Battery (M777)

 l AU Army > Ground Unit > Artillery > Artillery Section (M777)

 l US Army > Infantry Brigade > Rifle Company > Mortar Section

 3. Add Fire Mission Orders to the Units. See Create a Fire Mission Order in the VBS Plan Manual.

 4. Add additional non-artillery BLUFOR and OPFOR Tactical Units.

 5. Set up the non-artillery BLUFOR Tactical Units to attack the non-artillery OPFOR Tactical Units 
(for example, using the Move, Assault, or Suppress Orders - see Create an Advance Order, 
Create an Assault Order, or Create a Suppress Order in the VBS Plan Manual). Set up the non-
artillery OPFOR Tactical Units to defend themselves from the non-artillery BLUFOR Tactical 
Units attack, as in Create a Defend Order.

 6. Build a mission to convert the Tactical Plan symbols to mission entities and VBS Call for Fire 
fire missions and gunlines. See Build Missions in the VBS Plan Manual.

 7. Preview and save the mission.

For more information, see Scenario Preparation (on page 85) and Scenario Execution (on 
page 89).

11.5.3 Artillery Support Execution
Once the artillery and defense scenario is prepared by the administrator, it can be executed.

Start the Scenario and open VBS Editor.

For more information, see Scenario Execution (on page 89).

Use the Editor UI to  modify the scenario as it runs.

In Preview or Execute mode, switch to VBS Call for Fire and modify the fire missions built in step 7 
of Artillery Support Preparation (above) in real-time.

For more information, see Active Fire Missions in the VBS Call for Fire Manual.
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11.6 Autonomous Vehicle Operations
VBS4 includes  the Battlefield Information Systems Application (BISA) UI, as an extension to the 
VBS4 C2 View to enable command of Autonomous Vehicles (AVs) in integrated operations.

All technology and capabilities of AVs and BISA are loosely based on real-world technologies. 
VBS4 allows these systems to be quickly implemented and tested in the virtual-world to train 
doctrine, and Tactics, Techniques, and Procedures (TTP).

The BISA functionality is available for all unmanned vehicles with some limitations, but is 
specifically designed to work  with a set of UK-exclusive AVs.

  NOTE 
In addition, any Land vehicle can be turned into an AV (use the autopilot mode). For more 
information, see AV Mission Preparation (on page 243).

For a full list of specific AV models, see Autonomous Vehicles List (on page 237).

Review Roles in BISA (on the next page) to understand how the ORBAT structure and permissions 
enables BISA functionality.

Follow this process:

 1. Administrators or Mission Designers create an AV scenario.

For more information, see AV Mission Preparation (on page 243).

 2. Administrators or Instructors start and operate a networked AV scenario.

For more information, see AV Mission Execution (on page 247).

 3. Users join the AV scenario and control AVs using the BISA View (C2).

For more information, see BISA Interface Overview in the VBS4 Trainee Manual.

 4. Users and Administrators interact with AVs using the following functionality described  in the 
VBS4 Trainee Manual:

 l Assigning AV Ownership

 l Commanding AVs

 l Using the Commander Machine Interface (CMI)

 l Using the Autonomous Vehicles (AV) Interface

 l Activating the AV Autopilot

 l Using the Driver Machine Interface (DMI)

 5. During the scenario, AVs provide event reports in the Reports Panel (see the VBS4 Trainee 
Manual).
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 6. After an AV scenario, Instructors or users can review it using After Action Review (AAR).

For more information, see the VBS4 After Action Review Manual.

11.6.1 Roles in BISA
Each participant in a scenario has their own view, and with information specific to them.

Image-15: Commander view

BISA displays information and access to functionality based on the following roles:

 l Administrators / Instructors

Run the scenario and have full control and visibility of BISA functionality using the Editor in 
Execute mode.

 l Commander

Commanders are defined by the ORBAT structure set up for the mission. A commander is part 
of a higher echelon with sections under them in the command structure. For more information, 
see Creating Command Structures in the VBS4 Editor Manual.

Commanders have access to the following information in the Reports Panel (see the VBS4 
Trainee Manual):

 o The locations of AVs in the scenario controlled by users in their command structure.

 o Receive reports from AVs in the scenario controlled by users in their command structure.

 o All waypoints in the scenario for AVs controlled by users in their command structure.
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 l Section Leader

Section Leaders are defined by the leadership of their group as set up for the mission. For 
more information, see Adding Groups in the VBS4 Editor Manual.

Section Leaders can assign AV Ownership to members of their group, as described in 
Assigning AV Ownership in the VBS4 Trainee Manual.

Section Leaders have access to the following information in the Reports Panel (see the VBS4 
Trainee Manual):

 o Locations of AVs assigned to members of their section.

 o They receive reports from AVs assigned to members of their section.

 o They can see all waypoints for AVs assigned to members of their section.

 l Trainee

Trainees are the remaining units and members of VBS4 groups, without leadership roles.

Trainees can assign AV Ownership of unassigned AVs to themselves, as described in 
Assigning AV Ownership in the VBS4 Trainee Manual.

Trainees have access to the following information in the Reports Panel (see the VBS4 Trainee 
Manual):

 o Locations of their own AVs.

 o They receive reports from their own AVs.

 o They only see waypoints for their own AVs.
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11.6.2 Autonomous Vehicles List
VBS4 contains the following specific Autonomous Vehicle (AV) and AV-compatible models.

  NOTE 
Vehicles with AV in their model name are driverless, while vehicles without AV can be 
controlled by either a driver or operate as AVs (they are AV-compatible).

In addition, you can make any Land vehicle AV-compatible using the Autopilot option in the 
vehicle Object Properties dialog in the Editor. For more information, see AV Mission 
Preparation (on page 243).

GB Army AV - THeMIS UGV Variants

  NOTE 
AVs in this category are equipped with the Wide Field of View (WFOV) camera. For more 
information, see Manual Control in Commanding AVs in the VBS4 Trainee Manual.

 l AV UGV - DFSup - MILREM THeMIS with .50 cal HMG.

 l AV UGV - ATGW - MILREM THeMIS with 4 x ATGMs.

 l AV UGV - C-UAS - MILREM THeMIS with Directed Energy Weapon to counter UAS.

 l AV UGV - Recce - Ground recce - MILREM THeMIS (TITAN Sentry).

 l AV UGV - IDF - Artillery - 122mm rockets.

 l AV UGV - C-Bty - Artillery / rockets locating.

 l AV UGV - Base.

 l AV UGV - Small Arms - MILREM THeMIS Resupply variant with small arms ammunition.

 l AV UGV - Heavy Arms - MILREM THeMIS Resupply variant with heavy arms ammunition.

 l AV UGV - Medevac - MILREM THeMIS Medevac variant equipped with 2 litters.

GB Army AV - Support Vehicle Variants

 l AV Support Vehicle - Supply - Rations, medical supplies, spares - MAN SV Truck-esque.

 l AV Support Vehicle - Fuel - Fuel / water - MAN SV Unit Support Tanker-esque.

 l AV Support Vehicle - Ammo.

 l Support Vehicle 6T - Flat Platform - 4 x 4 chassis, flat platform truck.

 l Support Vehicle 6T - Cargo - 4 x 4 chassis, cargo truck.

 l Support Vehicle 6T - Troop Carrier - 4 x 4 chassis, 14-seat troop carrier truck.
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 l Support Vehicle 6T - Flat Platform, Crane - 4 x 4 chassis, flat platform truck.

 l Support Vehicle 6T - Cargo, Crane - 4 x 4 chassis, cargo truck with crane.

 l Support Vehicle 6T - Troop Carrier, Crane - 4 x 4 chassis, 8-seat troop carrier truck with crane.

 l Support Vehicle 6T - Flat Platform, Up Armored - 4 x 4 chassis, flat platform truck, cab up-
armored.

 l Support Vehicle 6T - Cargo, Up Armored - 4 x 4 chassis, cargo truck, cab up-armored.

 l Support Vehicle 6T - Troop Carrier, Up Armored - 4 x 4 chassis, 14-seat troop carrier truck, 
cab up-armored.

 l Support Vehicle 6T - Flat Platform, Crane, Up Armored - 4 x 4 chassis, flat platform truck, cab 
up-armored.

 l Support Vehicle 6T - Cargo, Crane, Up Armored - 4 x 4 chassis, cargo truck with crane, cab 
up-armored.

 l Support Vehicle 6T - Troop Carrier, Crane, Up Armored - 4 x 4 chassis, 8-seat troop carrier 
truck with crane, cab up-armored.

 l Support Vehicle 6T - Flat Platform, Up Armored, L7A2 - 4 x 4 chassis, flat platform truck, cab 
up-armored, L7A2 MG turret.

 l Support Vehicle 6T - Cargo, Up Armored, L7A2 - 4 x 4 chassis, cargo truck, cab up-armored, 
L7A2 MG turret.

 l Support Vehicle 6T - Troop Carrier, Up Armored, L7A2 - 4 x 4 chassis, 14-seat troop carrier 
truck, cab up-armored, L7A2 MG turret.

 l Support Vehicle 6T - Flat Platform, Crane, Up Armored, L7A2 - 4 x 4 chassis, flat platform 
truck, cab up-armored, L7A2 MG turret.

 l Support Vehicle 6T - Cargo, Crane, Up Armored, L7A2 - 4 x 4 chassis, cargo truck with crane, 
cab up-armored, L7A2 MG turret.

 l Support Vehicle 6T - Troop Carrier, Crane, Up Armored, L7A2 - 4 x 4 chassis, 8-seat troop 
carrier truck with crane, cab up-armored, L7A2 MG turret.

 l Support Vehicle 9T - Flat Platform - 6 x 6 chassis, flat platform truck.

 l Support Vehicle 9T - Cargo - 6 x 6 chassis, cargo truck.

 l Support Vehicle 9T - Troop Carrier - 6 x 6 chassis, 14-seat troop carrier truck.

 l Support Vehicle 9T - Flat Platform, Crane - 6 x 6 chassis, flat platform truck.

 l Support Vehicle 9T - Cargo, Crane - 6 x 6 chassis, cargo truck with crane.

 l Support Vehicle 9T - Troop Carrier, Crane - 6 x 6 chassis, 8-seat troop carrier truck with crane.

 l Support Vehicle 9T - Flat Platform, Up Armored - 6 x 6 chassis, flat platform truck, cab up-
armored.
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 l Support Vehicle 9T - Cargo, Up Armored - 6 x 6 chassis, cargo truck, cab up-armored.

 l Support Vehicle 9T - Troop Carrier, Up Armored - 6 x 6 chassis, 14-seat troop carrier truck, 
cab up-armored.

 l Support Vehicle 9T - Flat Platform, Crane, Up Armored - 6 x 6 chassis, flat platform truck, cab 
up-armored.

 l Support Vehicle 9T - Cargo, Crane, Up Armored - 6 x 6 chassis, cargo truck with crane, cab 
up-armored.

 l Support Vehicle 9T - Troop Carrier, Crane, Up Armored - 6 x 6 chassis, 8-seat troop carrier 
truck with crane, cab up-armored.

 l Support Vehicle 9T - Flat Platform, Up Armored, L7A2 - 6 x 6 chassis, flat platform truck, cab 
up-armored, L7A2 MG turret.

 l Support Vehicle 9T - Cargo, Up Armored, L7A2 - 6 x 6 chassis, cargo truck, cab up-armored, 
L7A2 MG turret.

 l Support Vehicle 9T - Troop Carrier, Up Armored, L7A2 - 6 x 6 chassis, 14-seat troop carrier 
truck, cab up-armored, L7A2 MG turret.

 l Support Vehicle 9T - Flat Platform, Crane, Up Armored, L7A2 - 6 x 6 chassis, flat platform 
truck, cab up-armored, L7A2 MG turret.

 l Support Vehicle 9T - Cargo, Crane, Up Armored, L7A2 - 6 x 6 chassis, cargo truck with crane, 
cab up-armored, L7A2 MG turret.

 l Support Vehicle 9T - Troop Carrier, Crane, Up Armored, L7A2 - 6 x 6 chassis, 8-seat troop 
carrier truck with crane, cab up-armored, L7A2 MG turret.

 l Support Vehicle 9T IMM - Flat Platform - 6 x 6 chassis with improved mobility, flat platform 
truck.

 l Support Vehicle 9T IMM - Cargo - 6 x 6 chassis with improved mobility, cargo truck.

 l Support Vehicle 9T IMM - Troop Carrier - 6 x 6 chassis with improved mobility, 14-seat troop 
carrier truck.

 l Support Vehicle 9T IMM - Flat Platform, Crane - 6 x 6 chassis with improved mobility, flat 
platform truck.

 l Support Vehicle 9T IMM - Cargo, Crane - 6 x 6 chassis with improved mobility, cargo truck 
with crane.

 l Support Vehicle 9T IMM - Troop Carrier, Crane - 6 x 6 chassis with improved mobility, 8-seat 
troop carrier truck with crane.

 l Support Vehicle 9T IMM - Flat Platform, Up Armored - 6 x 6 chassis with improved mobility, 
flat platform truck, cab up-armored.
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 l Support Vehicle 9T IMM - Cargo, Up Armored - 6 x 6 chassis with improved mobility, cargo 
truck, cab up-armored.

 l Support Vehicle 9T IMM - Troop Carrier, Up Armored - 6 x 6 chassis with improved mobility, 
14-seat troop carrier truck, cab up-armored.

 l Support Vehicle 9T IMM - Flat Platform, Crane, Up Armored - 6 x 6 chassis with improved 
mobility, flat platform truck, cab up-armored.

 l Support Vehicle 9T IMM - Cargo, Crane, Up Armored - 6 x 6 chassis with improved mobility, 
cargo truck with crane, cab up-armored.

 l Support Vehicle 9T IMM - Troop Carrier, Crane, Up Armored - 6 x 6 chassis with improved 
mobility, 8-seat troop carrier truck with crane, cab up-armored.

 l Support Vehicle 9T IMM - Flat Platform, Up Armored, L7A2 - 6 x 6 chassis with improved 
mobility, flat platform truck, cab up-armored, L7A2 MG turret.

 l Support Vehicle 9T IMM - Cargo, Up Armored, L7A2 - 6 x 6 chassis with improved mobility, 
cargo truck, cab up-armored, L7A2 MG turret.

 l Support Vehicle 9T IMM - Troop Carrier, Up Armored, L7A2 - 6 x 6 chassis with improved 
mobility, 14-seat troop carrier truck, cab up-armored, L7A2 MG turret.

 l Support Vehicle 9T IMM - Flat Platform, Crane, Up Armored, L7A2 - 6 x 6 chassis with 
improved mobility, flat platform truck, cab up-armored, L7A2 MG turret.

 l Support Vehicle 9T IMM - Cargo, Crane, Up Armored, L7A2 - 6 x 6 chassis with improved 
mobility, cargo truck with crane, cab up-armored, L7A2 MG turret.

 l Support Vehicle 9T IMM - Troop Carrier, Crane, Up Armored, L7A2 - 6 x 6 chassis with 
improved mobility, 8-seat troop carrier truck with crane, cab up-armored, L7A2 MG turret.

 l Support Vehicle 9T, UST - 6 x 6 chassis, Unit Support Tanker.

 l Support Vehicle 9T, UST - Up Armored - 6 x 6 chassis, Unit Support Tanker, cab up-armored.

 l Support Vehicle 9T, UST - Up Armored, L7A2 - 6 x 6 chassis, Unit Support Tanker, cab up-
armored, L7A2 MG turret.

 l Support Vehicle 9T IMM, UST - 6 x 6 chassis with improved mobility, Unit Support Tanker.

 l Support Vehicle 9T IMM, UST - Up Armored - 6 x 6 chassis with improved mobility, Unit 
Support Tanker, cab up-armored.

 l Support Vehicle 9T IMM, UST - Up Armored, L7A2 - 6 x 6 chassis with improved mobility, Unit 
Support Tanker, cab up-armored, L7A2 MG turret.

 l Support Vehicle 15T - Flat Platform - 8 x 8 chassis, flat platform truck.

 l Support Vehicle 15T - Cargo - 8 x 8 chassis, cargo truck.

 l Support Vehicle 15T - Flat Platform, Crane - 8 x 8 chassis, flat platform truck.

 l Support Vehicle 15T - Cargo, Crane - 8 x 8 chassis, cargo truck with crane.
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 l Support Vehicle, EPLS - 8 x 8 chassis, with Enhanced Pallet Load System.

 l Support Vehicle 15T - Flat Platform, Up Armored - 8 x 8 chassis, flat platform truck, cab up-
armored.

 l Support Vehicle 15T - Cargo, Up Armored - 8 x 8 chassis, cargo truck, cab up-armored.

 l Support Vehicle 15T - Flat Platform, Crane, Up Armored - 8 x 8 chassis, flat platform truck, 
cab up-armored.

 l Support Vehicle 15T - Cargo, Crane, Up Armored - 8 x 8 chassis, cargo truck with crane, cab 
up-armored.

 l Support Vehicle, EPLS - Up Armored - 8 x 8 chassis, with Enhanced Pallet Load System, cab 
up-armored.

 l Support Vehicle 15T - Flat Platform, Up Armored, L7A2 - 8 x 8 chassis, flat platform truck, 
cab up-armored, L7A2 MG turret.

 l Support Vehicle 15T - Cargo, Up Armored, L7A2 - 8 x 8 chassis, cargo truck, cab up-armored, 
L7A2 MG turret.

 l Support Vehicle 15T - Flat Platform, Crane, Up Armored, L7A2 - 8 x 8 chassis, flat platform 
truck, cab up-armored, L7A2 MG turret.

 l Support Vehicle 15T - Cargo, Crane, Up Armored, L7A2 - 8 x 8 chassis, cargo truck with 
crane, cab up-armored, L7A2 MG turret.

 l Support Vehicle, EPLS - Up Armored, L7A2 - 8 x 8 chassis, with Enhanced Pallet Load System, 
cab up-armored, L7A2 MG turret.

 l Support Vehicle, Recovery - 8 x 8 chassis with improved mobility, vehicle recovery truck.

 l Support Vehicle, Recovery - Up Armored - 8 x 8 chassis with improved mobility, vehicle 
recovery truck, cab up-armored.

 l Support Vehicle, Recovery - Up Armored, L7A2 - 8 x 8 chassis with improved mobility, vehicle 
recovery truck, cab up-armored, L7A2 MG turret.

GB Army AV - DF Heavy Variants (Wheeled and Tracked)

 l AV DF Heavy - Armed with 120mm cannon, 7.62 x 51 coaxial machine gun, and smoke 
launcher.

GB Army AV - ASV Air Variants

 l ASV Air - Medium quadcopter UAS. Unarmed.

 l ASV Air ATGW - Large quadcopter UAS. Armed with 4 x Brimstone or Successor.

  NOTE 
These variants are only available under the GB Army AV - Woodland tab.

GB Army AV - Centaur Variants
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  NOTE 
AVs in this category are equipped with the Wide Field of View (WFOV) camera. For more 
information, see Manual Control in Commanding AVs in the VBS4 Trainee Manual.

 l AV Centaur - Base.

 l AV Centaur - Small Arms - Resupply variant with small arms ammunition.

 l AV Centaur - Heavy Arms - Resupply variant with heavy arms ammunition.

 l AV Centaur - Medevac - Medevac variant equipped with 2 litters.

GB Army AV - Malloy UAV Variants

 l T150 UAS - Base.

 l T150 UAS  Small Arms - Resupply variant with small arms ammunition.
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11.6.3 AV Mission Preparation
One of the primary VBS Editor use cases for AVs is the creation of engaging and realistic training 
scenarios that demonstrate the capabilities of BISA for integrated AV operations.

Select a terrain and use VBS Editor in Prepare mode to add the personnel, vehicles, objectives, and 
hazards required for your AV training requirements.

Follow these steps:

 1. Use VBS Editor to create a new Scenario, or edit an existing one.

 2. Go to View > Map Settings:

 a. Click the C2 tab, and check Enable Autonomous Vehicles.

 b. Click the Icons tab, and check Show Side of Empty Vehicles.

 c. In the For BLUFOR Side drop-down, select Only Those on Player's Side.

 d. Click Apply.

For more information, see Map Settings in the VBS4 Editor Manual.

 3. Use the Editor UI to add the units and groups required for your scenario, and create the ORBAT 
structure that defines the visibility and access to functionality for the different Roles in BISA 
(on page 235).

For more information, see the following topics in the VBS4 Editor Manual:

 l Adding Unit

 l Adding Groups

 l Creating Command Structures

 4. Use the Editor UI to add the autonomous vehicles required for the AV scenario.

See Adding Vehicles in the VBS4 Editor Manual to add the available AVs.

 l GB Army AV - THeMIS UGV variants

 l GB Army AV - AV Support Vehicle variants

 l GB Army AV - AV DF Heavy variants

 l GB Army AV - ASV Air variants

 l GB Army AV - Centaur Variants

 l GB Army AV - Malloy UAV Variants

For a full list of available AVs, see Autonomous Vehicles List (on page 237).
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 5. In addition, any Land vehicle can become AV-enabled and be used as an AV.

For new vehicles:

 a. In the Object Properties dialog, click Advanced to expand the advanced vehicle options.

 b. In the Autopilot drop-down, select one of the following options:

  NOTE 
The Autopilot drop-down is only available, if the following criteria is met:

 l The vehicle is a Land vehicle, and not already an AV (UGV / UAV).

 l The AI type is set to Control AI.

 l Not Available - The vehicle is not used as an AV.

 l Active - The AV autopilot is active and the vehicle can be used as an AV.

 l Inactive - The AV autopilot is inactive and the vehicle cannot be used as an AV.

  TIP 
For existing AV-enabled vehicles, you can change the autopilot state by double-
clicking the vehicle on the map or in the Scenario Objects Panel, and in the Object 
Properties dialog, changing Active / Inactive in VBS Editor (Prepare / Execute 
Mode).

 c. Click OK.

For existing vehicles, right-click a vehicle or a group of vehicles on the map or in the Scenario 
Objects Panel, and select Autonomous Vehicle > Activate Autopilot / Deactivate Autopilot to 
activate / deactivate the AV autopilot.

Alternatively, you can set the autopilot mode for any Land vehicle, using the SQF commands: 
setAutopilotState (https://sqf.bisimulations.com/display/SQF/setAutopilotState), 
getAutopilotState (https://sqf.bisimulations.com/display/SQF/getAutopilotState), 
getAutopilot (https://sqf.bisimulations.com/display/SQF/getAutopilot).

Use the Commander Machine Interface (CMI) Editor Object (see the VBS4 Editor Manual) to 
allow commanders to view the status information of each vehicle assigned to them, when the 
AV scenario runs.
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 6. Use Markers to designate specific areas in the terrain as threats.

 a. Press F6 or select (F6) Marker from the Editor Objects List.

 b. Place your cursor on the map, and do one of the following:

 l Double-click the LMB.

 l Click the RMB, and select New Object from the context menu.

The Object Properties dialog opens.

 c. Select Ellipse from the Category drop-down.

 d. Size (Left-Right) and Size (Up-Down) must be the same size to specify a circular area.

 e. Click OK.

 f. The Marker is placed on the map.

AVs avoid the defined areas if Avoid Threats is set when defining their Waypoints, as 
described in AV Assign Waypoints in the VBS4 Trainee Manual.

 7. Add Waypoints for your AVs to select from.

 a. Select Control AI - Waypoints from the Editor Objects List.

 b. Place your cursor on the map, and do one of the following:

 l Double-click the LMB.

 l Click the RMB, and select New Object from the context menu.

The Object Properties dialog opens.

 c. In the Behavior list, select one of the following Waypoint types: Convoy, UGV Control, UGV 
Control - Defend.

  NOTE 
Only these waypoint types can be used with AVs.

 d. Set the Waypoint properties, as described in step 3 of  AV Assign Waypoints (see the VBS4 
Trainee Manual).

  NOTE 
AV Assign Waypoints describes how to create and assign waypoints.

 e. Click OK.

The Waypoint is placed on the map.
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 8. Preview and save the mission.

A saved Scenario is available for use in the Battlespaces List:

 l Play the Scenario as a single user.

For information about controlling your character, see Character Control in the VBS4 
Trainee Manual.

 l Use VBS Editor in Prepare mode to edit the Scenario.

 l For information about controlling AV objects and entities, see BISA Interface Overview in 
the VBS4 Trainee Manual.

 l Run the mission as a Networked Multiplayer mission as the administrator.

For information about Execute mode, see AV Mission Execution (on the next page).

 l Use VBS Editor in Prepare mode to edit the mission.

For more information about the other objects and tools available, see the VBS4 Editor Manual.
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11.6.4 AV Mission Execution
The most important Editor use case for AVs is the operation and administration of a multiplayer 
scenario during runtime.

Start a Multiplayer mission and use the VBS Editor to monitor the simulation users, manage the 
Scenario, and insert simulation objects, hazards, and events.

  NOTE 
A typical Scenario Execution use case requires a Dedicated Server to host the mission with 
the Administrator operating an Admin Client on the same network. For more information, 
see Dedicated Server in the VBS4 Administrator Manual.

Follow these steps:

 1. Start a VBS4 instance as an Administrator, together with VBS4 instances for the other users 
(Commanders, Section Leaders, Trainees).

 2. Select your Battlespace in the Battlespaces List, and use the Execute function in the 
Battlespace Functions Panel:

 l Highlight the Scenario name and click Start.

VBS4 opens the Network Lobby.

 3. In the Network Lobby, do the following:

 a. Assign users to characters, or allow users to select their own.

 b. Optional: Select any of the following:

 l To automatically start recording an After Action Review when the Scenario begins to 
execute, select Record AAR.

 l To skip the Mission Briefing, select Skip Briefing.

 c. Click OK.

 4. The Mission Starts and displays the Mission Briefing view.

  NOTE 
The Mission Briefing is skipped if Skip Briefing is selected in the Network Lobby.

Once the Mission Briefing is completed, press OK to start the mission.

 5. Press Map (M)  or Pause (Esc), and select Editor to open VBS Editor in Execute mode.

Do any of the following when the scenario runs:
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 l Assign and reassign AVs as necessary.

For more information, see Assigning AV Ownership in the VBS4 Trainee Manual.

 l Give orders to AVs.

For more information, see Commanding AVs in the VBS4 Trainee Manual.

 l As an Administrator, reposition AVs and Waypoints as required if an AV gets stuck.

 l Add Waypoints for your AVs to select from.

 1. Select Control AI - Waypoints from the Editor Objects List.

 2. Place your cursor on the map, and do one of the following:

 o Double-click the LMB.

 o Click the RMB, and select New Object from the context menu.

The Object Properties dialog opens.

 3. In the Behavior list, select one of the following Waypoint types: Convoy, UGV Control, UGV 
Control - Defend.

  NOTE 
Only these waypoint types can be used with AVs.

 4. Set the Waypoint properties, as described in step 3 of  AV Assign Waypoints (see the VBS4 
Trainee Manual).

  NOTE 
AV Assign Waypoints describes how to create and assign waypoints.

 5. Click OK.

The Waypoint is placed on the map.

 l Change the AV autopilot on AV-enabled vehicles:

 o Right-click a single vehicle or group of vehicles on the map, in C2 ORBAT List, or in the 
Editor Scenario Objects Panel, and select Autonomous Vehicle > Activate Autopilot / 
Deactivate Autopilot to activate / deactivate the AV autopilot.

 o Use the vehicle Systems Menu.

For more information, see Activating the AV Autopilot in the VBS4 Trainee Manual.
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 l Switch to Control AI drivers (see Switch to Unit in Entity Management in the VBS4 Instructor 
Manual) in AV-enabled vehicles to take control of their characters.

  NOTE 
To switch to a Control AI driver, make sure to have the driver unit selected in the 
Scenario Objects Panel (see the Instructor Interface in the VBS4 Instructor Manual), 
rather than the vehicle itself.

 l Use the DMI / CMI / AV interface.

For more information, see the respective sections:

 o Using the Driver Machine Interface (DMI) in the VBS4 Trainee Manual.

 o Using the Commander Machine Interface (CMI) in the VBS4 Trainee Manual.

 o Using the Autonomous Vehicles (AV) Interface in the VBS4 Trainee Manual.

For more information about the other objects and tools available, see the VBS4 Editor Manual.
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11.7 Aviation Combined Arms Training System
VBS4 provides Armed Reconnaissance Helicopter (ARH) model variants and additional 
functionality to enable ARH crews to participate in a greater range of training activities as part of 
the Aviation Combined Arms Training System (ACATS).

VBS4 delivers the variants and functionality as a set of features in VBS4.

11.7.1 ACATS ARH Model Variants
VBS4 adds to the existing ARH models with the following ACATS ARH model configurations:

ACATS ARH Variant ACATS ARH Model Loadout Capacity

Reconnaissance Recon - M781, Hydra, Hellfire 2 Hellfire Missiles, 26 Rockets

Firepower Firepower - M781, Hydra, Hellfire 4 Hellfire Missiles, 33 Rockets

Anti-Tank Anti-Tank - M781, Hydra, Hellfire 8 Hellfire Missiles, 14 Rockets

The ACATS ARH variants extend the base ARH models with the following additional functions:

 l Night-Vision Compatible Aircraft Lighting

 l Steerable Landing Light

 l Improved Weapon Selection Dialogs

 l Roof-Mounted Sight (RMS)

 l Helmet-Mounted Sight Display (HMSD)

  NOTE 
The ACATS ARH variants are intended only for multi-user simulation. AI units cannot use 
ACATS ARH systems.

11.7.2 Configurable Weapon Loads
Mission Editors can customize the missile and rocket loads to create new ACATS ARH variants:

Hellfire Missile Types:

 l AGM-114K Hellfire Missiles - laser-guided with a high-explosive warhead

 l AGM-114L Hellfire Missiles - radar-guided with a high-explosive warhead

 l AGM-114M Hellfire Missiles - laser-guided with a fragmentation / incendiary warhead

By default, the ACATS ARH variants load AGM-114K Hellfire missiles.
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70mm Hydra Rocket Types:

 l HE Rockets

 l Anti-Materiel Rockets

 l Flechette Rockets

 l Smoke Rockets

 l Illumination Rockets

 l IR Illumination Rockets

By default, the ACATS ARH variants load HE Rockets.

For more information, see Customize the ARH Ammunition Load.

11.7.3 ACATS Mission Objects and Features
VBS4 includes the following features to support ACATS ARH training:

 l Add Reference Marks to Missions

 l Add Resupply Points to Missions

 l Full helicopter flight and operational control as described in ACATS ARH Control Overview in 
the VBS4 Trainee Manual.

 l Multi-weapon display in the ACATS ARH User View in the VBS4 Trainee Manual.

 l AGM114 Hellfire Missiles simulation and lock-on modes.

 l Mini-Map Navigation in the VBS4 Trainee Manual
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11.8 CBRN Contamination
The purpose of the CBRN Contamination use case is provide procedural training to Trainees to 
detect, avoid, and mitigate chemical, biological, radiological, and nuclear contamination (CBRN) 
that may be encountered in the field.

A typical CBRN scenario consists of the following:

 l Hazardous areas that produce CBRN contamination:

 o Mustard Gas

 o Chlorine Gas

 o Sarin Gas

 o Liquid Nerve Agent (LNA)

 o Radioactivity

 l Units equipped with CBRN equipment:

 o CBRN Suits

 o CBRN Detection Equipment

 o CBRN and Area Markers

 o CBRN Decontamination Equipment

The general workflow of a CBRN simulation in VBS4 contains two parts:

 l CBRN Preparation (on the next page)

 l CBRN Execution (on page 254)
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11.8.1 CBRN Preparation
As an administrator, use VBS Editor in Prepare mode to prepare a CBRN scenario.

Follow these steps:

 1. Use VBS Editor to create a new Scenario, or edit an existing one.

 2. Add any of the following hazards to the CBRN scenario:

Hazard Description

Hazardous 
Area

Place contaminated areas in your scenario. For more information, see Hazardous Area 
in the VBS4 Editor Manual.

OPFOR 
Munitions

VBS4 includes  shells that contain chlorine, mustard, sarin gas, and liquid chemical 
agents that forms clouds around the impact area that disperse over time.
These shells may be used by OPFOR units and form part of a CBRN scenario.
Add the applicable vehicles to the scenario and modify their loadouts as required.
For more information, see Adding Vehicles and Creating Vehicle Variants in the VBS4 
Editor Manual.

 3. VBS4 has units with specific equipment for CBRN, including the following:

Unit Description

US USMC Specific USMC units are equipped with MOPP suits:
 l US USMC Desert / Woodland > Rifleman - M16A4 (NBC MOPP N)

SE Army All Swedish units have CBRN suit functionality as standard.
This is not simulated as equipment that they carry.

  NOTE 
Other units may pick up and use CBRN equipment in the Scenario, or have the 
equipment added to their inventory.

For more information, see Edit Equipment Loadout in the VBS4 Editor Manual.

Add personnel to the scenario.

For more information on placing units, see Adding Units in the VBS4 Editor Manual.
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 4. Add additional objects and equipment.

VBS4 includes specific  equipment for CBRN scenarios:

 l Area Marking Kit

 l CBRN Markers

 l CBRN Suits Crate

 l Decontamination Equipment

 l Detection Devices

 l M8 and M9 Chemical Detection Paper

 l SCBA Mask

Place these objects directly in the scenario using the (F8) Objects option or equip units with 
them by adding them to their inventory.

For more information, see CBRN Equipment, Adding Objects and Edit Equipment Loadout in 
the VBS4 Editor Manual.

 5. Preview and save the mission.

For more information, see Scenario Preparation (on page 85).

11.8.2 CBRN Execution
Once the CBRN scenario is prepared by the administrator, it can be executed.

Start the Scenario and open VBS Editor.

For more information, see Scenario Execution (on page 89).

Use the Editor UI to  modify the scenario as it runs.

A typical CBRN scenario has the following functionality:
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 1. Instructors monitor and manage contamination effects using VBS Editor in Execute mode:

 l The Scenario Objects List displays an overview of contaminated units and objects:

 l Contaminated units and objects display CBRN symbology in the 3D Camera View:
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 l Hazardous Areas may be added, edited, and individual entities may be decontaminated.

For more information, see Hazardous Area in the VBS4 Editor Manual.

 2. Trainees can use CBRN Suits to protect themselves from contamination:

 l CBRN Suits and Gas Masks

 l Swedish CBRN Protection

  NOTE 
Different levels of suit offer varying levels of protection to different types of 
contamination.

 3. Trainees can use various equipment to detect CBRN contamination:

 l CBRN Detection Devices

 l M8 Chemical Detection Paper

 l M9 Chemical Detection Paper

 4. Trainees can use markers and tape to mark contaminated areas:

 l Area Marking Kit

 l CBRN Markers

 5. Trainees can use CBRN1 and CBRN3 Forms to report CBRN contamination:

 l CBRN1 and CBRN3 Forms

 6. Trainees can use equipment to decontaminate themselves and other units or objects, or to 
treat units suffering the effects of contamination:

 l CBRN Decontamination

For more information on using CBRN Equipment, see the topics in the VBS4 Trainee Manual.
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11.9 HX45M Bridge Laying (Land 155)
The HX45M vehicle simulates manual and Control AI-based (autonomous) Dry Support Bridge 
(DSB) laying capabilities.

There are two types of HX45M bridge-laying simulation:

Bridge-Laying Simulation Description

AI Bridge Laying All the bridge-laying crew members are Control AI.

Player Bridge Laying All the bridge-laying crew members are player-controlled.

The general workflow of an HX45M bridge-laying scenario in VBS4 is:

 l Bridge Laying Preparation (below)

 l Bridge Laying Execution (on the next page)

11.9.1 Bridge Laying Preparation
As an administrator, use VBS Editor in Prepare mode to create an HX45M Bridge Laying Scenario.

Follow these steps:

 1. Use VBS Editor to create a new Scenario, or edit an existing one.

 2. VBS4 has vehicles with specific HX45M bridge-laying functionality:

Vehicle Description

HX45M DSB Bridge-builder vehicle with a crane.

HX77 ILHS - Loaded Vehicle with support modules (bridge segments).

Haulmark 3axle - 
Loaded

Optional trailer, carrying support modules, that can be towed by the HX77 ILHS 
- Loaded vehicle.

For more information, see Bridge Laying Convoy AI in the VBS4 Editor Manual.

Add vehicles to the scenario.

For more information on placing vehicles, see Adding Vehicles in the VBS4 Editor Manual.

 3. For Player Bridge Laying, place the bridge-laying vehicles and crews.

  NOTE 
Bridge-laying vehicles and crews do not need to be linked to form groups, and crews 
can start the scenario outside the vehicles.
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 4. For AI Bridge Laying do the following:

 a. Make sure that all crew members are in the bridge-laying vehicles (see the previous 
procedure step, and the difference between (F4) Vehicle and (F5) Empty Vehicle in the 
Editor Objects List).

 b. Make sure that all the vehicle crew members are controlled by Control AI. For more 
information, see the AI options in Edit Vehicle Options in the VBS4 Editor Manual.

 c. Link the bridge-laying vehicles into a group. For more information, see Creating and 
Adding to Groups with Links in the VBS4 Editor Manual.

 d. Add a bridge-laying Deploy DSB Order Waypoint.

For more information, see Bridge Laying Convoy AI in the VBS4 Editor Manual.

 5. Preview and save the mission.

For more information, see Scenario Preparation (on page 85).

11.9.2 Bridge Laying Execution
Once the Bridge-Laying Scenario is prepared by the administrator, it can be executed.

Start the Scenario and open VBS Editor.

For more information, see Scenario Execution (on page 89).

A typical Bridge Laying scenario has the following phases:

 1. For Player Bridge Laying, if the crew members are not in the vehicles, they enter them, 
occupying the required driver positions.

Players use movement controls and 3D World Actions (see Interact with Vehicles Interface 
(IWV) in the VBS4 Trainee Manual) to enter the vehicles.

 2. For Player Bridge Laying:

As drivers, drive the vehicles into position and / or unload the support modules cargo, and 
operate the HX45M crane to construct and deploy the bridge.

For more information, see:

 l Land Vehicle Controls in the VBS4 Trainee Manual.

 l Bridge Laying - HX45M in the VBS4 Trainee Manual.

Use radio communication. For more information, see VBS Radio Overview (on page 141).
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 3. For AI Bridge Laying:

If the Bridge Laying Preparation (on page 257) is done correctly and no bridge-laying errors 
appear during runtime, the bridge-laying vehicles:

 a. Drive to the Deploy DSB Order Waypoint.

 b. Park at their respective positions.

 c. The HX45M vehicle prepares the crane for construction.

 d. The HX45M vehicle constructs the bridge.

 e. The HX45M vehicle deploys the constructed bridge.

If the Bridge Laying Preparation (on page 257) is done incorrectly and some bridge-laying 
errors appear during runtime, as an administrator, return back to Bridge Laying Preparation (on 
page 257) and resolve the errors accordingly.

For more information, see Bridge Laying Convoy AI in the VBS4 Editor Manual.
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11.10 Military Road Signs
VBS4 includes self-assembly road signs designed for use with convoy scenarios and route 
marking with the following features:

 l Military road sign parts with assembly functionality.

 l Modular sign posts, military road signs, and symbols.

 l Crate objects that contain a predefined set of military road signs.

 l Customize military road sign crates and vehicle cargo in the Editor.

Included with this release of VBS4 are a set of military road signs developed for French military 
use.

 1. Scenario designers assign military road signs equipment to units in the mission, can pre-
deploy placed signs, add sign crates as objects or vehicle cargo, and also create custom road 
sign crates and vehicle variants.

For more information, see Military Road Signs - Scenario Design in the VBS4 Editor Manual.

 2. Trainees use road sign parts, contained in ammo crates and carried by vehicles, to place and 
assemble road signs during a scenario.

For more information, see Military Road Signs in the VBS4 Trainee Manual.
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11.11 OPV River Class Trainer
The River Class ship in VBS4 is designed to simulate reservist usage and onboard orientation, to 
familiarize Trainees with its operation and layout.

The River Class ship structure simulation includes:

 l The decks layout.

 l The rooms layout.

The ship is manned with a default crew of the following units:

 l 1 player unit in the ship Driver position.

 l 2 AI units in the gunner positions, at the GPMG turrets.

 l 1 AI unit in the gunner positions, at the GAMBO gun.

 l 2 AI units in the gunner positions, at the Signal Lamps.

You can also watch the overview video at https://youtu.be/AELCt5J2Gp8.

  NOTE 
The videos may not be up to date with the features they demonstrate, the latest state of 
which is described in this manual.

Image-16: View of the River Class ship

The general workflow of the OPV River Class ship simulation in VBS4 is:

OPV River Class Ship Preparation

As a mission designer, create a River Class ship mission.

For more information, see Designing OPV River Class Missions in the VBS4 Editor Manual.
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OPV River Class Ship Execution

 l As a player, interact with the River Class ship.

For more information, see Using the OPV River Class in the VBS4 Trainee Manual.

 l As an administrator, monitor the River Class ship activity.

For more information, see Monitoring the OPV River Class in the VBS4 Instructor Manual.
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11.12 Polish AFV Tank Trainer
The Polish AFV TT simulates the controls and functionality of the Leopard 2 A4 / A5 and PT-91 
vehicles, using replica control joysticks connected to computers running VBS4.

The Polish AFV TT is used as a tank crew gunnery range trainer, and as a tool to provide platoon 
training for leadership.

To prepare a Polish AFV TT mission, do the following:

 1. See Polish AFV Control Setup in the VBS4 Administrator Manual, to set up the AFV 
Commander and Gunner controls.

Use VBS Editor to add the following implemented  Leopard 2 A4 / A5 and PT-91 tank models 
(found under PL Army Tracked - Woodland) to missions:

 l Leopard 2A4

 l Leopard 2A5

 l PT-91

To operate a Polish AFV TT mission, do the following:

 1. Start VBS4 on the Dedicated Server.

 2. Start VBS4 on the clients, with the appropriate controller profiles.

 3. Start the scenario from the instructor computer.

 4. Join the scenario from the clients.

 5. During the scenario, the AFV crew use the controls and panels for each role, as described in 
the VBS4 Trainee Manual:

 l Polish AFV TT Commander Control

 l Polish AFV TT Gunner Control

© 2023 - Bohemia Interactive Simulations - All Rights Reserved - 263 -


	Introduction to VBS4
	1. VBS4 - Whole-Earth Battlespace
	1.1 Train Anywhere on the Earth
	1.2 Next Generation VBS Control AI
	1.3 Everything from VBS3 and More!
	1.4 Powerful Tools to Customize VBS4

	2. The VBS4 Workflow
	2.1 VBS Geo – WYSIWYG Terrain Editing
	2.2 VBS Plan – Rapid Mission Planning and Execution
	2.3 Using the VBS4 Workflow

	3. Differences from VBS3
	3.1 VBS4 Client and VBS World Server
	3.2 Terrain Storage and Editing
	3.3 Rendering
	3.4 VBS4 User Interface
	3.5 Disabled VBS3 Functionality
	3.6 VBS3 Terrains and Missions
	3.7 Third-Party Products and Integrations

	4. Deploying VBS4
	5. VBS4 UI Overview
	5.1 VBS4 Toolbar
	5.1.1 VBS4 Main Menu
	5.1.2 Tool Selection
	5.1.3 Global Navigation Toolbar
	5.1.4 AAR Streaming Controls
	5.1.5 Connectivity
	5.1.6 Camera Controls
	5.1.7 Preview
	5.1.8 VBS4 Settings
	5.1.9 Documentation
	5.1.10 Notifications

	5.2 Whole-Earth Terrain
	5.3 Using POIs
	5.3.1 Create POIs
	5.3.2 Edit POIs
	5.3.3 Delete POIs


	6. Battlespace Management
	6.1 Create Battlespaces
	6.2 Access VBS4 Functions
	6.3 Synchronize Battlespaces
	6.3.1 Battlespace Synchronization
	6.3.2 AAR Synchronization

	6.4 Edit Battlespace Details
	6.5 Delete Battlespaces
	6.5.1 Battlespace Deletion
	6.5.2 AAR Deletion

	6.6 Filter Battlespaces
	6.7 Search Battlespaces
	6.8 Battlespaces Folder

	7. Scenario Preparation
	8. Scenario Execution
	8.1 Dedicated Server Scenario Execution
	8.1.1 Start the Dedicated Server
	8.1.2 Start Simulation Clients
	8.1.3 Start an Admin Client
	8.1.4 Start the Battlespace
	8.1.5 Connect the Trainees and Start the Scenario

	8.2 VBS4 Client Hosted Scenario Execution
	8.3 Connecting Trainee Clients
	8.4 Managing the Scenario

	9. Scenario Assessment
	10. VBS Components and Products
	10.1 VBS Bundle
	10.2 VBS4 Portfolio
	10.3 VBS Call for Fire Overview
	10.3.1 VBS Call for Fire Workflow
	10.3.2 VBS Call for Fire Scenario Preparation
	10.3.3 VBS Call for Fire Scenario Execution

	10.4 VBS Close Air Support
	10.4.1 VBS Close Air Support Workflow
	10.4.2 VBS Close Air Support Example

	10.5 VBS Control AI Overview
	10.6 VBS Gateway Overview
	10.6.1 Appendix: Supported DIS PDUs

	10.7 VBS Host Overview
	10.8 VBS Radio Overview
	10.8.1 VBS Radio Concepts
	10.8.2 VBS Radio Architecture
	10.8.3 VBS Radio Licensing
	10.8.4 VBS Radio Workflow Changes
	10.8.5 VBS Radio Standalone

	10.9 VBS Blue IG
	10.10 VBS Simulation SDK
	10.11 VBS Developer Suite
	10.12 WIBU Licensing

	11. VBS Use Cases Documentation
	11.1 Convoys
	11.1.1 Control AI Convoy Example
	11.1.2 Convoy Preparation
	11.1.3 Convoy Execution

	11.2 Enemy Ambush
	11.2.1 AI on Rails Enemy Ambush Example
	11.2.2 Enemy Ambush Preparation
	11.2.3 Enemy Ambush Execution
	11.2.4 Enemy Ambush with Triggers and Waypoints
	11.2.5 UPR Enemy Ambush

	11.3 Improvised Explosive Device Ambush
	11.3.1 Command-Detonated IED Ambush Example
	11.3.2 IED Ambush Preparation
	11.3.3 IED Ambush Execution
	11.3.4 Victim-Initiated IED Ambush
	11.3.5 Suicide Bomber IED Ambush

	11.4 Route Clearance
	11.4.1 Husky T-MDV Route Clearance Example
	11.4.2 Route Clearance Preparation
	11.4.3 Route Clearance Execution

	11.5 Artillery Support in VBS Plan
	11.5.1 Artillery Support in VBS Plan Example
	11.5.2 Artillery Support Preparation
	11.5.3 Artillery Support Execution

	11.6 Autonomous Vehicle Operations
	11.6.1 Roles in BISA
	11.6.2 Autonomous Vehicles List
	11.6.3 AV Mission Preparation
	11.6.4 AV Mission Execution

	11.7 Aviation Combined Arms Training System
	11.7.1 ACATS ARH Model Variants
	11.7.2 Configurable Weapon Loads
	11.7.3 ACATS Mission Objects and Features

	11.8 CBRN Contamination
	11.8.1 CBRN Preparation
	11.8.2 CBRN Execution

	11.9 HX45M Bridge Laying (Land 155)
	11.9.1 Bridge Laying Preparation
	11.9.2 Bridge Laying Execution

	11.10 Military Road Signs
	11.11 OPV River Class Trainer
	11.12 Polish AFV Tank Trainer


